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BAB 1
DASAR-DASAR EXCEL

Pada dasarnya, pekerjaan yang dilakukan dengan Excel adalah pekerjaan
memasukkan data yang kemudian diproses untuk mendapatkan hasil yang
diinginkan. Prinsipnya sama seperti kita memasukkan data pada sebuah
kalkulator elektronik. Hanya saja data yang dimasukkan di sini terdiri atas
berbagai tipe dan ditambah dengan fasilitas-fasilitas Excel yang ada
memungkinkan untuk menyajikan tampilan angka dan teks berikut tabel,
grafik hingga database. Hal ini yang membuat program menjadi utuh untuk
membuat teks laporan, berikut analisis perhitungannya.

Setiap versi dari Excel terus dikembangkan dengan selalu mengadakan
perubahan dan penambahan fasilitas baru, namun tetap menjaga kompabilitas
dengan versi sebelumnya. Namun perubahan-perubahan yang dilakukan tidak
mengubah fitur dasar software ini sebagai lembar kerja untuk aplikasi
perhitungan. Dalam pembahasan buku ini kita akan bekerja dengan Microsoft
Excel 2000.

1.1 Worksheet dan Workbook

Pada saat pertama kali membuka Excel, secara default Bookl adalah nama
workbook (buku kerja) yang pertama. Workbook ini terdiri atas 3 buah
worksheet (halaman kerja) dengan nama Sheetl, Sheet2, dan Sheet3.
Worksheet Excel ini juga disebut sebagai spreadsheet, yaitu lembar untuk
pengolah angka.

Gambar 1.1 memperlihatkan elemen-elemen dari sebuah workbook. Pada
bagian atas halaman terdapat title bar yang menampilkan nama workbook.
Di bawahnya terdapat menu bar dengan menu File — Edit — View dan
seterusnya yang di dalamnya terdapat menu pull-down dengan sejumlah
perintah yang spesifik nama menunya. Contoh nama perintah-perintah di
dalam menu pull-down disajikan pada Tabel 1.1. Toolbar memperlihatkan
sejumlah icon (gambar kecil) sebagai shortcut untuk perintah-perintah di
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c. Formula : ekspresi matematik yang menghitung dua atau lebih nilai

dalam menu. Formula bar memperlihatkan data dan formula dalam sel aktif.
yang menghasilkan sebuah nilai baru.

Pada bagian bawah di sebelah kiri dari workbook terdapat tab sheet yang
memperlihatkan nama worksheet. f. Fungsi : fungsi yang digunakan untuk berbagai aplikasi perhitungan,
seperti keuangan (financial), matematika dan trigonometri,

Workbook dapat dimodifikasi dengan menampilkan toolbar-toolbarnya. eril
statistik, database, logika, dan lain-lain.

Tampilan ini biasanya bergantung pada kebutuhan kita saat bekerja. Untuk
kebutuhan suatu aplikasi perhitungan, kita optimalkan saja seperti yang
tampak pada Gambar 1.1. Langkah-langkahnya sebagai berikut.

1. Klik menu View > Toolbars, lalu pilih Standard, Formatting dan Close

Titel bar Menu bar

Close Window

Visual Basic yang ditandai dengan tanda centang ¥ di sebelah kiri
pilihan ini.

2. Klik View > Formula Bar.

QvMi.cmsnﬂ Excel - Bookl

Worksheet dibagi oleh baris dan kolom. Kolom diberi nomor dari A sampai
Z, kemudian AA, AB hingga IV. Baris diberi nomor dari 1 hingga 65636.
Perpotongan kolom dan baris membentuk sel-sel sebagai tempat untuk diisi

data. Setiap sel berdiri sendiri dan mempunyai alamat yang ditunjukkan oleh | \
kolom dan baris, misalnya B4 adalah sel yang berada pada kolom B dan baris . Toolbar
ke-4. Alamat sel yang aktif dapat dilihat dalam box referensi sel di bawah Formula bar

toolbar. Kumpulan sel-sel disebut range sel, membentuk array memanjang
horizontal atau secara vertikal. Misalnya range A1:AS5 adalah kumpulan sel .
dari Al hingga A5 membentuk array 5 x 1, atau range A1:C5 membentuk Referensi sel
array 5 x 3, dan seterusnya.

" Sel aktif \ :
: Menu- pull-down

Nama worksheet dapat diganti dengan nama lain, dengan mengklik dua kali
pada tab sheet; tekan Delete untuk menghapus namanya, kemudian tulis
nama barunya. Atau dengan mengklik kanan pada tab sheet kemudian dari
menu shortcut klik Rename untuk mengganti namanya.

Scroll bar ————a»

‘ Tab sheet
1.2 Tipe Data hm/ -

Data input dalam spreadsheet dapat dibedakan menjadi beberapa tipe, yaitu:
Teks : karakter alphabet dan teks: A, B, -Z, AB, A2, Komputer, ...
b. Angka : datanumerik:1,2,3,0,-1,-2,4,5.85,...

Gambar 1.1 Workbook Excel 2000

c. Tanggal : data tanggal biasanya mengacu pad
komputer atau diformulasikan dalam perhitungan.

d. Jam : data jam biasanya mengacu pada Setting waktu komputer atau
diformulasikan dalam perhitungan.




Tabel 1.1 Perintah-Perintah Dasar Excel

Nama Shortcut Keterangan

File > Save menyimpan (save) file dengan nama workbook
yang sedang dikerjakan.

File > Save As Alt+FA menyimpan file dengan nama lain ke dalam
folder dan direktori, atau ke sebuah disket.

File > New membuka workbook baru.

File > Open membuka workbook yang ada.

File > Close menutup workbook (icon Close Window).

File > Exit menutup program dan keluar dari Excel (icon
Close).

File > Print mencetak worksheet melalui mesin printer.

Edit > Undo membatalkan pekerjaan yang terakhir.

Edit > Redo mengulangi pekerjaan yang terakhir

Edit > Copy meng-copy data pada sel atau range sel ke
lokasi lain. Untuk memilih data yang akan di-
copy atau cut, klik pada sel atau range sel
tempat data tersebut.

Edit > Cut memindahkan data ke lokasi lain. Perintah
seperti Cut, Copy, dan Paste dapat ditemukan
dalam menu pop-up dengan mengklik tombol
kanan mouse pada sel yang disorot.

Edit > Paste menempatkan data ke dalam sel atau range sel
yang baru. Perintah Paste dilakukan sctelah ada
perintah Cut atau Copy. Untuk menempatkan
data, klik lokasji runya, kemudian tekan Enter
atau klik Paste .

Insert > Cells Alt+IE menyisipkan sel baru di posisi pointer (sel yang
disorot).

Insert > | Alt+IC menyisipkan kolom baru di posisi pointer.

Column

Insert > Row Alt+IR menyisipkan baris baru di posisim/p,_int\er.

memformat isi sel, terdiri atas format angka,
teks, font yang dipakai, garis tepi, warna, dan
proteksi worksheet.

Format > Cell Ctrl+1

Format > Row | Alt+OR memformat baris, terdiri atas pengaturan tinggi
baris, menyembunyikan baris dan menam-
pilkannya kembali.

Format > Alt+OC memformat kolom, terdiri atas pengaturan lebar

Column kolom, lebar otomatis (autofit selection),

menyembunyikan dan menampilkan kolom,
dan informasi tentang lebar kolom standar.

Tabel 1.2 Operator dan Relasi Matematika

Operator Keterangan

+ Penjumlahan

- Pengurangan

* Perkalian

/ Pembagian

A Pangkat

Relasi

= Sama dengan

> Lebih besar

< Lebih kecil
< Tidak sama dengan
>= Lebih besar atau sama dengan
<= Lebih kecil atau sama dengan

1.3 Formula

Berdasarkan definisinya, sebuah formula adalah ekspresi matematika untuk
menghitung hasil dari dua atau lebih nilai. Formula dapat terdiri atas
bilangan, operator matematika, fungsi-fungsi, referensi sel atau range sel.
Sel dan range sel biasanya diberi nama, misalnya ”A” untuk B2, atau
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”B” untuk range D2:D6. Penamaan sel akan dibahas sebentar pada bagian ini.
Semua formula selalu dimulai dengan tanda sama dengan (=).

Contoh:
=B2+B3 menjumlahkan data pada sel B2 dengan sel B3
=B4*B5 mengalikan data pada sel B4 dengan sel B5

=SUM(D2:D4) menjumlahkan data bilangan sel D2, D3, dan D4

Ketika suatu formula akan kita copy, yang perlu diperhatikan adalah jenis sel
dalam formula tersebut. Sel relatif adalah sel yang apabila di-copy akan
menyesuaikan diri dengan tempat barunya. Sel C1 yang berisi formula
=A1+B1 akan menjadi =C2+D2 pada E2. Hasilnya seperti yang diperlihatkan
dalam Gambar 1.2.

Sel absolut adalah sel yang tidak mengalami perubahan alamatnya apabila di-
copy ke tempat lain. Notasinya dengan menambahkan $ di depan nama
kolom dan nomor baris, misalnya $A$4. Menambahkan $ pada nama kolom
atau nomor baris saja, hanya akan mengubah salah satu alamatnya. Kolom A
pada $A4 akan tetap apabila di-copy, namun nomor barisnya akan
menyesuaikan dengan lokasi barunya. Demikian sebaliknya dengan sel A$4.
Sel-sel demikian disebut sel semi-absolut.

Formula yang menyatakan relasi sel-sel atau range sel, misalnya =B4+C30
atau =SUM(A4:C20), lebih sulit dibaca dibanding relasi matematik dengan
nama variabel yang lebih praktis, misalnya = x + n atau SUM(B). Sel dan
range sel dibuat namanya melalui menu Insert > Name > Define > Names.
Nama ini berlaku untuk semua sheet dalam satu workbook. Apabila hanya
mewakili pada sheet tertentu, misalnya Sheetl, maka penulisannya adalah
Sheetl!x, yaitu untuk variabel x dalam Sheetl. Penggunaan dengan variabel-
variabel ini sangat direkomendasikan, karena akan sangat menyederhanakan
suatu formula. Nama-nama yang dipakai berikut lokasinya dapat dibuat ke
dalam list dan dicetak dalam worksheet dengan Insert > Name > Paste >
Paste List. Mencetak list ini akan berguna apabila kita bekerja dengan
banyak variabel dalam beberapa sheet.

A B c D E F

1 =A1+B1 .

T
2 =C2+D2
3 =$A$1+B1

=

4 =$A$1+D2
5 =$A1+B1
6 =$A2+D2
7 =A$1+B7 |~
8 =C$1+D8
9
10

Gambar 1.2 Meng-copy formula dan hasilnya dalam spreadsheet

1.4 Fungsi Built-In

Excel mempunyai fungsi-fungsi built-in untuk membangun formula yang
kompleks, beberapa di antaranya diperlihatkan dalam Tabel 1.3. Fungsi
seperti matematika dan trigonometri atau statistik misalnya, adalah fungsi
yang paling umum dipakai dalam proses pengukuran di laboratorium.
Sebelum menggunakan sebuah fungsi, sebaiknya dipahami benar fungsi dan
argumennya. Referensi mengenai ini ada pada menu Help atau tekan F1.

Tabel 1.3 Beberapa Fungsi Buil!:—in Excel

A. Fungsi Matematika dan Trigonometri

ABS(bil) nilai absolut dari bilangan

ACOS(bil) arccosinus dari bilangan (dalam radian)
ACOSH(bil) invers hiperbolic cosinus dari bilangan

ATAN(bil) arctangen dari bilangan

EXP(bil) eksponensial dari bilangan

FACT(bil) factorial hingga ke bilangan

INT(bil) pembulatan bilangan ke bawah ke integer terdekat
LOG(bil, dasar) logaritma bilangan untuk bilangan dasar ditentukan




LOG10(bil)
MDETERM(array)
MINVERS(array)
MMULT (array!,array2)
PI0)

RAND()

SIGN(bil)

SIN(bil)

SINH(bil)
SQRT(bil)

SUM (bill,bil2,...)

SUMPRODUCT
(arrayl,array?2)

TAN(bil)
TANH(bil)

logaritma bilangan untuk bilangan dasar 10
determinan matriks suatu array

invers matriks suatu array

perkalian matriks dari 2 data array

nilai pi = 3.141592654

bilangan random antafa Odan1

tanda dari bilangan, 1 jika bilangan positif, 0 jika
bilangan 0, -1 jika bilangan negatif

sinus dari bilangan

hiperbolic sinus dari bilangan
mencari akar pangkat 2 dari bilangan
penjumlahan dari bilangan

jumlah produk dari komponen array yang sama

tangen dari bilangan

hiperbolik tangen dari bilangan

SLOPE(data y,data x) slope (kemiringan) garis regresi linear
INTERCEPT(data y,data x) perpotongan garis regresi linear terhadap aksis-Y

TREND(data y,data x, x’,const) menentukan nilai regresi sepanjang garis linear

D. Fungsi Lookup and Reference

COLUMNS(array) menentukan nomor kolom suatu array
INDEX (array,baris,kolom) memilih komponen suatu array
ROWS(array)

TRANSPOSE(array)

menentukan nomor baris suatu array

menentukan transpose suatu array

E. Fungsi Logika

AND(logikal,logika2,..) TRUE jika semua argumen logika adalah TRUE
IF(logikal, nilai jika benar, nilai jika salah)

NOT(logika) pembalikan logika dalam argumen: NOT(TRUE) =
FALSE
OR(logikal, logika2) TRUE jika salah satu argumennya TRUE

B. Fungsi Informasi

F. Fungsi Teks

ISBLANK(nilai) TRUE jika nilai adalah kosong
ISLOGICAL(nilai) TRUE jika nilai adalah sebuah logika
ISNUMBER(nilai) TRUE jika nilai adalah sebuah bilangan
ISTEXT(nilai) TRUE jika nilai adalah teks

C. Fungsi Statistik

AVERAGE(bil1,bil2,...)
COUNT(nilail,nilai2,...)

COUNTA(nilail,nilai2,...)
LINEST(data y,data x..,c,stat)

MAX(bill,bil2,...)
MIN(bil1,bil2,...)

nilai rata-rata dari argumen bilangan

menghitung jumlah data bilangan dalam list
argumen

menghitung jumlah sel yang tidak kosong

mencari parameter garis linear, di mana ¢ =
konstanta

nilai maksimum dalam list argumen

nilai minimum dalam list argumen

CHAR(bil) karakter berdasarkan kode bilangan

EXACT (teks1,teks2) fungsi untuk memeriksa apakah teksl identik

dengan teks2

FIND(teks1,teks2,start)

mencari nomor teksl dalam teks2 dengan nomor
start

LEFT(teks, jumlah karakter) pengambilan teks mulai dari kiri
LEN(teks) menentukan jumlah karakter dalam teks
RIGHT (teks, jumlah karakter) pengambilan teks mulai dari kanan

TRIM(teks) menghilangkan spasi dalam teks, kecuali satu spasi

antarkata

UPPER(teks) membuat semua huruf teks menjadi huruf kapital




1.5 Formula Array

Formula array adalah formula yang dapat mengerjakan beberapa perhitungan
kemudian menghasilkan satu atau beberapa hasil. Formula ini bekerja atas
dua atau lebih set data dalam argumen array. Setiap array masing-masing
harus mempunyai jumlah kolom dan baris yang sama. Sebagai contoh, fungsi
built-in LINEST. Fungsi ini mencari parameter garis regresi linear dari data x
dan y, seperti yang diperlihatkan dalam Gambar 1.3.

A B A B
1 X y 1 X
2 -1.0 -5.0 2
3 -0.5 0.0 3 Data Data
4 1.0 5.0 4
5 2.0 4.0 5
6 3.0 0.5 6
7 4.0 -5.0 7
8 5.0 -12.0 8
9 Slope |Y-intercept 9 Slope Y-intercept
10 | -1.204 0.537 10 _=INDEX(LINEST(B2:B8,A2:A8),1)
=INDEX(LINEST(B2:B8,A2:A8),2)

Gambar 1.3 Contoh formula array untuk regresi linear dan hasilnya

1.6 Format Data dan Sel

Format data dan sel dapat dilakukan dari menu Format > Cells. Pada kotak
dialog Format Cells terdapat beberapa lembar tab, yaitu Number,
Alignment, Font, Border, Patterns dan Protection. Format bilangan dalam
tab Number dibagi dalam beberapa kategori seperti general, number, date
dan sebagainya. Misalnya untuk kategori custom atau pilihan pemakai
diperlihatkan dalam Tabel 1.4. Alignment adalah pengaturan untuk letak teks
dalam sel seperti alignment vertikal dan horizontal, kontrol teks dan
orientasinya dalam sel. Font adalah pengaturan yang berhubungan dengan
karakter, seperti jenis huruf yang digunakan (Arial, Times New Roman,
Tahoma, ...), style (italic, bold, ...), ukuran (8, 9, ...), warna dan sebagainya.
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Border untuk membuat garis tepi, tipe garis (lurus, putus-putus, tipis, tebal),
dan warnanya. Patterns untuk membuat tampilan sel dengan arsiran
(horizontal, diagonal, titik, ...), warna arsiran dan warna background sel.
Protection digunakan untuk memilih kondisi (locked atau tidak) data dan
formula (hidden atau tidak) dalam sel apabila proteksi worksheet diaktifkan.
Untuk memproteksi worksheet, pilihlah menu Tools > Protection > Protect
Sheet.

Tabel 1.4 Contoh kategori custom format untuk bilangan

Format Tampilan
0.00 2343.00
0.00E+00 2.34E+03
##0.0+0 2.3E+3
#,##0.00 2,343.00
#,##0.00% 234,300.00%
0.0 ’m” 2343.0 m

Lebar kolom dan tinggi baris dapat disesuaikan besarnya dengan men-drag
mouse (menahan tombol kiri mouse sambil menyeret) saat posisi pointer
berada di batas-batas judul kolom dan baris (ada tanda *+”). Cara lain dengan
mengklik kanan mouse pada judul kolom atau baris, dan dari menu shortcut
klik Row > Height atau Colomn > Width, kemudian masukkan nilai yang
diinginkan pada kotak teks yang disediakan. Atau melalui menu Format >
Row > Height atau Format > Column > Width.

1.7 Pesan Error

Pesan error akan disampaikan apabila suatu formula tidak bekerja
sebagaimana mestinya, misalnya argumen dalam formula tidak lengkap, tipe

~data tidak sesuai, atau salah dalam mengembangkan logika. Hal lain

misalnya pembagian dengan 0 (nol) atau lebar kolom tidak cukup lebar untuk
tampilan suatu hasil. Pesan dimulai dengan tanda # kemudian diikuti jenis
kesalahannya. Tabel 1.5 memperlihatkan beberapa pesan error yang mungkin
muncul.
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Tabel 1.5 Pesan Error

Pesan Keterangan
HHHHH Sel berisi data bilangan, tanggal atau waktu yang lebih lebar dari
selnya, atau hasil minus dalam format tanggal dan waktu.
#N/A (Not Available) Referensi data tidak cocok dan tidak dapat
digunakan oleh fungsi atau formula.
#DIV/0! Pembagian dengan nol.
#NAME? Excel tidak mengenali teks dalam formula.
#REF! Referensi sel yang digunakan tidak berlaku.

#VALUE! | Tipe argumen yang digunakan dalam fungsi adalah salah. Argumen
di sini dapat berupa nilai numerik, teks, nama, label, referensi sel,
range sel, dan fungsi.

1.8 Mencetak Worksheet

Sebelum mencetak worksheet pada kertas, terlebih dulu kita menentukan
dengan memblok area yang akan dicetak (dengan Shift + =" atau men-
drag mouse). Setelah itu ditetapkan dengan File > Print Area > Set Print
Area. Hasil pencetakannya dapat dilihat dengan File > Print Preview atau

% pada toolbar. Pencetakan kemudian dilakukan

mengklik Print Preview
dengan File > Print atau dengan mengklik Print ikon a.

Batas-batas pencetakan halaman yang juga dapat ditentukan dengan View >
Page Break Preview. Tampilan ini memperlihatkan setiap data yang akan
dicetak berikut nomor halamannya. Anda juga dapat menentukan batas-batas
pencetakan halaman men-drag mouse pada garis batas yang berwarna biru.
Konfigurasi tampilan halaman kemudian diatur dengan File > Page SetUp.
Pada kotak dialog Page SetUp terdapat beberapa lembar tab, yaitu Page,
Margins, Header/Footer dan Sheet. Tab Page untuk memilih orientasi dan

ukuran kertas, serta skala worksheet dalam kertas; Margins untuk mengatur-

batas-batas teks dalam kertas; Header/Footer untuk membuat catatan-catatan
pinggir; dan Sheet untuk mengatur tampilan sheet seperti mengeluarkan grid,
nama baris, kolom, serta urutan pencetakan.
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1.9 Membuat Grafik

Sckumpulan data dapat disampaikan secara baik melalui gambar grafik untuk
memperlihatkan korelasi antardatanya. Dalam Excel terdapat banyak tipe
untuk penggambaran grafik, seperti Pie, Bar, Column, Area, Line, dan
scbagainya, ditambah dengan tampilan 3 dimensi. Langkah-langkah untuk
membuat grafik adalah dengan Insert > Chart atau dengan mengklik Chart

Wizard pada toolbar sehingga keluar kotak dialog Chart Wizard seperti
diperlihatkan pada Gambar 1.4. Pada langkah awal kita menentukan tipe
grafik pada Standard Types atau tipe lainnya pada Custom Types. Sebagai
contoh, di sini kita akan mengambil data dari Gambar 1.3 untuk membuat
grafik dengan Standard Types. Selanjutnya dipilih tipe XY (Scatters) dengan
sub-tipe connected by smoothed lines. Klik Next > Data Range > pilih data
pada A2:B8 (pilihan Series untuk satu atau lebih series data) > Series In
Column > Next > keluar kotak Chart Option. Pada langkah ini terdapat
lembar tab, yaitu Titels, Axes, Gridlines, Legend, Data Label yang di
dalamnya terdapat textbox dan pilihan-pilihan yang dapat diisi. Kemudian
klik Next > keluar kotak Chart Location dengan pilihan As object in:
Sheetl atau As new sheet: Chartl > Finish. Jika grafik ingin ditempatkan di
dalam worksheet, pilih As object in. Hasil penggambaran grafik
diperlihatkan pada Gambar 1.5.

art Wizard - Step 1 o

Gambar 1.4 Kotak dialog Chart Wizard
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Gambar grafik dibagi menjadi tiga bidang gambar, yaitu Chart Area, Plot
Area dan Legend Area, seperti yang diperlihatkan dalam Gambar 1.5. Anda
dapar melakukan pengaturan sendiri pada gambar grafik yang sudah dibuat
dengan dua cara. Cara pertama dengan mengklik dua kali pada grafik, dan
pengaturan selanjutnya menggunakan kotak dialog Format. Sedangkan cara
kedua adalah dengan mengklik kanan bidang gambar, dan pengaturan
selanjutnya menggunakan perintah-perintah dalam kotak menu. Sebagai
contoh, dengan mengklik dua kali pada salah satu aksis maka akan keluar
kotak dialog Format Axis dengan tab Pattern, Scale, Font, Number dan
Alignment. )

Chart Area

Legend
—e— Series1

Gambar 1.5 Contoh grafik tipe XY dengan sub-tipe smoothed lines

Gambar grafik dapat di-copy, dipindahkan maupun diubah ukurannya. Untuk
mengubah ukuran grafik, dapat dilakukan dengan men-drag mouse pada
bidang gambar. Pilih dengan mengklik bidang yang akan diubah ukurannya,
kemudian arahkan pointer pada kotak hitam kecil (di sudut atau tengah-
tengah) hingga keluar tanda ”$©”. Drag mouse ke arah dalam untuk
memperkecil dan ke arah luar untuk memperbesar bidang gambar.

Untuk memindahkan grafik ke tempat lain dalam sheet, dapat dilakukan
dengan men-drag pada Chart Area. Sedangkan untuk mengopi, memindahkan
grafik dan menempatkannya di sheet lain (Cut-Copy—Paste), dapat dilakukan
dengan perintah dalam menu pop-up.
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FUNGSI

Sebuah fungsi bekerja berdasarkan argumen yang diberikan. Argumen ditulis
sesudah nama fungsi, diberi tanda kurung, dan merupakan nilai yang
digunakan oleh fungsi untuk mengerjakan operasinya. Argumen yang
digunakan dapat merupakan nilai numerik, teks, referensi atau range sel,
nama, label maupun fungsi.

Fungsi-fungsi dalam Excel dikelompokkan ke dalam kategori fungsi untuk
berbagai aplikasi perhitungan seperti matematika dan trigonometri, statistik,
finance, logika, dan sebagainya. Selain itu, Excel juga menyediakan
macrosheet dan aplikasi Visual Basic untuk membuat fungsi yang
didefinisikan sendiri oleh pemakainya.

2.1 Fungsi Numerik
ABS
Menghasilkan nilai absolut dari suatu bilangan.

Penulisan:

ABS(bilangan)

ABS(4) =4
ABS(-4) = 4
SQRT(ABS(-81) =9

INT

Pembulatan bilangan ke bawah ke integer terdekat.
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Penulisan:
INT(bilangan)
Contoh:
INT(8.9)=8
INT(-8.9) =-9

TRUNC

Membuat bilangan menjadi sebuah integer dengan menghilangkan bagian
desimalnya. Apabila hanya ingin menghilangkan beberapa bagian dari
desimalnya, masukkan jumlah desimal yang dinginkan sesudah bilangan.

Penulisan:

TRUNC (bilangan, jumlah desimal)
Contoh:

TRUNC(8.9) =8

TRUNC(-8.9) = -8

TRUNC(PI()) =3

TRUNC(PI(),3) = 3.141

ROUND

Pembulatan bilangan dengan jumlah desimal yang diinginkan.
Penulisan:

ROUND((bilangan, desimal)

Contoh:

ROUND(3.25,1)=3.3

ROUND(3.247,1) =3.2

ROUND(3.247,0) =3

ROUND(32.47,-1) = 30

ROUNDDOWN
Pembulatan bilangan ke bawah dengan jumlah desimal yang diinginkan.
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PPenulisan:

ROUNDDOWN(bilangan, jumlah desimal)
Contoh:

ROUNDDOWN(3.3,0) =3
ROUNDDOWN(66.8,0) = 66
ROUNDDOWN(3.14159,3) = 3.141
ROUNDDOWN(-5.24621,2) = -5.24
ROUNDDOWN(1550.24621,-2) = 1500

ROUNDUP

Pembulatan bilangan ke atas dengan jumlah desimal yang diinginkan.
Penulisan:

ROUNDUP(bilangan, jumlah desimal)

Contoh:

ROUNDUP(3.3,0) = 4

ROUNDUP(66.8,0) = 67

ROUNDUP(3.14159,3) = 3.142

ROUNDUP(-5.24621,2) = -5.25

ROUNDUP(1550.24621,-2) = 1600

2.2 Fungsi Logika

Fungsi_ini mempunyai dua hasil nilai, yaitu TRUE (benar) dan FALSE
te ika apabila terpenuhi, akan dikerjakan dari nilai yang
pertama. Apabila hasil logikanya adalah sebuah teks, maka sebelum dan
sesudah teks harus diberi tanda petik ("’ teks”).

Penulisan:

IF(tes logika, nilai jika benar, nilai jika salah)
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Contoh 1:

Apabila nilai ujian siswa <=55 maka dinyatakan gagal dan di atas nilai itu
lulus.

A B C
1 Nama Nilai Keterangan
2 |Magda Denawati 51 GAGAL  [C2:=IF(B2<=55,"GAGAL","LULUS")
3 |Jeni Amnis 93 LULUS '
4 1Joe Manik 90 LULUS Hasil copy sel C2
5 |Malik Hasan 70 LULUS ke C3 s.d. C6
6 |Anto Sirat 37 GAGAL
7

Contoh 2: Tes logika bertingkat

Siswa dengan kriteria gagal namun nilainya >45 masih dapat mengambil
tugas perbaikan.

A B C
1 Nama Nilai | Keterangan :
. C2:=IF(B2<=45,"GAGAL",IF(B2<=55,
2 | Magda Denawati | 51 PERBAIKAN “PERBAIKAN","LULUS"))
3 |Jeni Arnis 93 LULUS
4 |Joe Manik 90 LULUS Hasil copy sel C2
5 [Malik Hasan 70 LULUS ke C3 s.d. C6
6 |Anto Sirat 37 GAGAL
7
AND

Hasilnya adalah TRUE jika semua argumennya TRUE, dan menjadi FALSE
jika satu atau lebih argumennya FALSE. Biasanya dipakai bersama fungsi IF.

Penulisan:

AND(logikal, logika2, ...)

Contoh:

AND(2*2=4,2+2=4) hasilnya TRUE
AND(2<100,4<100,102<100) hasilnya FALSE
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(‘ontoh:

Masih dengan siswa yang sama seperti contoh di atas, namun untuk mata
kuliah yang berbeda, di mana sekarang diberikan tugas. Nilai tugas hanya
berpengaruh untuk memperbaiki nilai ujian siswa antara > 40 dan <=55.
Rumusan yang dipakai, 2 x Nilai Ujian + 1 x Nilai Tugas dibagi 3, dengan
pembulatan.

A B Cc D
Nilai | Nilai | Nilai
1 Nama Ujian | Tugas | Akhir
2 |Magda Denawati | 60 56 60 [D2:=IF(AND(B2>40,B2<=55),
3 |Jeni Amis 55 72 61 ROUND((2*B2+C2/3,0),B2)
4 |Joe Manik 60 65 60 Hasil copy sel D2
5 [Malik Hasan 40 60 40 Ke sel D3 s.d. D6
6 _|Anto Sirat . 46 64 52
7
COUNTIF

Menghitung jumlah sel dalam range sel yang sesuai dengan kriteria yang
diberikan.

Penulisan:
COUNTIF(range sel, kriteria)
Contoh:

Mencari jumlah sjswa dengan kriteria nilai tertentu dari data tabel.
COUNTIF(D2:D6,60) =2
COUNTIF(D2:D6,”:60”) =1

OR

Hasilnya TRUE jika salah satu argumennya TRUE, dan menjadi FALSE jika
semua argumennya FALSE. Biasanya dipakai bersama fungsi IF.

Penulisan:

OR(logikal, logika2, ...)
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Contoh:
OR(2*2=4,2+2 =4)
OR(2<100,4<100,102<100)

hasilnya TRUE
hasilnya TRUE

2.3 Fungsi Pembacaan Tabel

VLOOKUP

Mencari nilai yang sesuai nilai acuan berdasarkan nomor indeks kolom dalam
data tabel yang disusun secara vertikal.

Penulisan:
VLOOKUP(nilai acuan, range tabel, nomor indeks kolom, logika)
Contoh:

Hasil perhitungan suatu pengujian dipengaruhi oleh ukuran dan berat alat-alat
(tools) yang dipakai dalam pengujian tersebut. Berikut contoh fungsi yang
digunakan untuk membaca data ukuran dan berat ring berdasarkan kalibrasi
terakhir yang dilakukan.

Alel c | o | e | F
1 KALIBRASI RING
2

No. | Tinggi |Diameter| Berat Luas | Volume
3 |Ring| (cm) | (cm) | (gram) | (em®) | (cm®
4 1 1.950 | 5.000 | 32.850 | 19.635 | 38.288
5 2 |2.000| 5.000 | 32.000 | 19.635 | 39.270
6 3 |2.000| 5.000 | 33.440 | 19.635 | 39.270
7 4 12.000]| 5000 | 34.980 | 19.635 | 39.270
8 5 |1.950| 5.000 | 33.700 | 19.635 | 38.288
9 6 | 1925 4985 | 32.000 | 19.517 | 37.571
10 | 7 |2.000| 5.000 | 33.000 | 19.635 | 39.270
11 8 |1.975| 5.125 | 34.000 | 20.629 | 39.711
12
13
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No. [Diameter| Berat
14 | Ring (cm) (gram)
15 | 3 5.000 | 33.440
16 7 5.000 | 33.000
12| A , B ‘ C D
13
No Diameter Berat
14 Ring (cm) (gram)
15 3 |=VLOOKUP(B15,$A%$4:3F$11,3) |=VLOOKUP(B15,$A%4:$F$11,4)
16 7 |=VLOOKUP(B16,$A%$4:$F$11,3) |=VLOOKUP(B16,3A%$4.$F$11,4)

Logika mempunyai nilai TRUE atau FALSE. Jika TRUE (atau dikosongkan),
data pada kolom pertama harus diurut semakin membesar (..,-2,-1,0,1,2,..)
karena VLOOKUP dapat memberikan hasil yang salah. Jika FALSE, data
dalam tabel tidak perlu diurut. Untuk kondisi TRUE, apabila nilai acuan tidak
benar-benar sama dengan data tabel, VLOOKUP akan mencari nilai yang
terdekat. Sebaliknya, FALSE akan mencari nilai yang benar-benar sama,
kalau tidak ditemukan, hasilnya adalah #N/A.

HLOOKUP

Mencari nilai yang sesuai nilai acuan berdasarkan nomor indeks baris dalam

data tabel yang disusun secara horizontal. Penerapan fungsi ini sama seperti
VLOOKUP.

Penulisan:
HLOOKUP(nilai acuan, range tabel, n@ baris, logika)

2.4 Fungsi Teks

LEFT, RIGHT, MID

Mengubah suatu karakter dengan jumlah karakter yang diinginkan.
=LEFT(teks, jumlah karakter)

Pengambilan karakter mulai dari kiri.
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=RIGHT(teks, jumlah karakter)

Pengambilan karakter mulai dari kanan.

=MID(teks, posisi awal karakter, jumlah karakter)

Pengambilan karakter dari bagian tengah.

Contoh:
A B C
1 ENGINEERING ENG B1:=LEFT(A1,3)
2 745.56 RING B2:=RIGHT(A1,4)
3 ENGINEER B3:=MID(A1,1,8)
4 745.5 B4:=LEFT(A2,5)
CONCATENATE

Menggabungkan data dari dua atau lebih sel ke dalam satu sel yang baru.
Contoh:

A B C D
1
2 | Civil |Engineer Civil Engineer |D2:=CONCATENATE(A2," ",B2)
3
4 Titik Koordinat
5 y
6 4 0 (2,4,0) =CONCATENATE("(",A8,",",B6,",",C6,")")
7 4 -1.5 (2.4.-1.5) Hasil copy sel D6
8 |2m| 4m [|-15m| (24,-15) ke sel D7 dan D8
9

2.5 Fungsi Pemakai
Selain fungsi-fungsi yang sudah ada di Excel, adakalanya kita memerlukan

suatu fungsi untuk mengerjakan perhitungan yang kita tentukan sendiri.
Fungsi seperti ini disebut fungsi pemakai atau user-defined function.
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l'ungsi ini akan ditambahkan oleh Excel ke dalam koleksi fungsinya dan
dapat digunakan seperti halnya sebuah fungsi built-in.

Scbagian besar fungsi pemakai dibuat dengan mengombinasikan antara
formula dan fungsi built-in. Fungsi pemakai dalam Excel dapat dikerjakan
dengan menggunakan macrosheet dan aplikasi Visual Basic. Macrosheet
terlihat seperti spreadsheet, namun di dalamnya berisi fungsi-fungsi dan
perintah sebagai ganti data input. Bahasa yang digunakan di sini merupakan
bahasa program yang orisinil dari spreadsheet. Sedangkan Visual Basic
adalah bahasa program dalam lingkup Microsoft Windows yang mirip
dengan bahasa Basic atau bahasa komputer lainnya, namun banyak
dilengkapi perintah-perintah visual. Gambar 2.1 memperlihatkan fungsi
COSD untuk fungsi cosinus sudut dalam derajat yang dibuat dengan
Macrosheet dan Visual Basic.

CcosD Const Pi = 3.141592654
=RESULT(1) Function Cosd (x)
=ARGUMENT("X",1) Cosd = Cos(Pi * x / 180)
=RETURN(COS(PI()*X/180))

BN |

End Function

Gambar 2.1 Fungsi dalam Macrosheet (kiri) dan Visual Basic (kanan)

2.5.1 Membuat Fungsi dengan Macrosheet

Sebelum menuliskan fungsi, terlebih dahulu kita menyisipkan sebuah
macrosheet ke dalam workbook. Klik kanan mouse pada tab sheet, dan dari
kotak menu klik Insert > Excel 4.0 Macro > OK schingga tampil
macrosheet dengan nama Macrol. Sheet ini sepintas mirip dengan
spreadsheet namun kolom-kolom yang terdapat di sini cukup lebar sebagai
tempat menuliskan fungsi. Penulisan bahasa macro di sini mempunyai
, yaitu pada baris pertama ditempatkan nama fungsi
(contoh COSD daldm Gambar 2.1). Kemudian pada baris kedua adalah
definisi tipe outputnya, bisa bilangan, teks, fungsi logika, referensi, pesan
error, sebuah array atau kombinasinya dengan memakai statement RESULT,
diikuti tipe data. Beberapa jenis tipe data dapat dilihat dalam Tabel 2.1. Jika
result menghasilkap sebuah bilangan atau teks, tipe datanya = 3. Jika data
tipe dikosongkan, secara default diasumsikan = 7 (untuk bilangan, teks dan
logika). RESULT dikexjakan sebelum mengisi formula.
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Seperti fungsi built-in, fungsi pemakai mempunyai variabel input, yang
secara individu didefinisikan oleh statement ARGUMENT pada kolom di
bawah RESULT. ARGUMENT menentukan nama dan tipe data setiap input
variabelnya. Nama sebagai teks ditulis di antara 2 tanda petik diikuti koma
kemudian tipenya (contoh: ”Data”, 1). Sama seperti RESULT, definisi input
dalam ARGUMENT bisa bilangan, teks, fungsi logika, referensi, pesan error,
sebuah array atau kombinasinya.

Setelah ARGUMENT, pada langkah berikut pemakai (user) menentukan
formula-formula yang digunakan dalam operasi utama sebagai fungsi
variabel inputnya. Formula-formula ini memakai variabel input yang
didefinisikan ARGUMENT, merujuk nama atau lokasi sel dalam worksheet.
Misalnya ”x” di dalam suatu kolom pada worksheet untuk sejumlah data
sudut COSD. Langkah fungsi ini diakhiri dengan statement RETURN, untuk
mengakhiri perhitungan dan kembali ke worksheet. Selanjutnya menamakan
macro dengan Insert > Name > Define atau Create, agar dapat dijalankan.

Tabel 2.1 Tipe Data untuk Fungsi Dalam RESULT dan ARGUMENT

Nilai Tipe Data
1 Bilangan
2 Teks
4 Logika
8 Referensi
16 Error
64 Array

2.5.2 Membuat Fungsi dengan Aplikasi Visual Basic

Fungsi pemakai dalam Visual Basic (VB) dikerjakan dengan terlebih dulu
menyisipkan sebuah module dengan Tools > Macro > Visual Basic Editor >
Insert > Module. Jendela Visual Basic Editor akan memperlihatkan sebuah
module di mana macro dikerjakan dengan nama Modulel. Penulisan fungsi
dimulai dengan kata Function yang diikuti namanya dan diakhiri dengan End
Function. Tipe fungsi dapat merupakan Single/Double atau Variant
bergantung pada tipe data yang dihasilkan, apakah sebuah bilangan atau
sebuah array. Tipe data dalam VB dapat dibedakan menjadi beberapa macam,
seperti disajikan pada Tabel 2.2. Pemilihan tipe data ini selain untuk
mendefinisikan sebuah fungsi dan argumennya, juga berhubungan dengan
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pemakaian memori komputer oleh VB yang besarnya bergantung pada
jangkauan nilai dari tipe data tersebut.

Scsudah fungsi dan namanya, kemudian kita mendefinisikan sejumlah
argumen. Jika argumen ini tidak didefinisikan, akan digolongkan sebagai
Variant. VB sendiri mempunyai banyak fungsi built-in yang mempunyai kata
vang mirip dengan fungsi built-in dalam macrosheet. Beberapa fungsi built-in
macrosheet dapat digunakan dengan memakai awalan Application, seperti
diperlihatkan pada Gambar 2.2. Jadi dengan VB, kapabilitas dari macrosheet
dapat lebih ditingkatkan dan lebih diperluas. Fungsi dalam VB akan secara
otomatis terhubung dengan workbook tanpa perlu mendefinisikan namanya.

Perhatikan fungsi pemakai Garis pada Gambar 2.2, kemudian buatlah fungsi
itu dan jalankan di dalam worksheet. Bandingkan hasilnya dengan fungsi
Linest pada Gambar 1.3. Hasil keduanya ternyata sama. Linest adalah sebuah
fungsi built-in Excel, sedangkan fungsi Garis dibuat dalam Visual Basic
memakai fungsi built-in macrosheet.

Tabel 2.2 Tipe Data Dalam Visual Basic

Tipe Data Jangkauan Nilai

-32,768 s.d. 32,767

-2,147,483,648 s.d. 2,147,483,547

-3.402823E38 s.d. -1.401298E-45 (nilai -)

1.401298E-45 s.d. 3.402823E38 (nilai +)

Double (bilangan desimal) -1.79769313486232E308 s.d. -4.94065645841247E-324 (-)
4.94065645841247E-324 s.d. 1.79769313486232E308 (+)

Integer (bilangan bulat)
Long (bilangan bulat)
Single (bilangan desimal)

Currency (nilai mata uang) -922,337,203,685,477.5808 s.d. 922,337,203,685,477.5807
String (teks) 0 s.d. 2 miliar karakter

Byte (bilangan bulat) 0s.d. 255

Boolean (logika) TRUE atau FALSE

Date (tanggal dan waktu)
Object (referensi objek)

Variant
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Function GARIS (Y,X) As Variant
Slope = Application. SLOPE (Y,X)
Intercept = Application. INTERCEPT (Y,X)

Garis = Array (Slope, Intercept)

End Function

Gambar 2.2 Fungsi built-in macrosheet dalam Visual Basic

2.5.3 Alur Program

Sebuah program dibuat untuk dapat menangani setiap perubahan kondisi,
baik dari data input yang diberikan maupun perubahan yang terjadi selama
proses program. Oleh karena itu, diperlukan kontrol agar prosesnya berada
pada statement yang ditetapkan. Berikut ini beberapa pemilihan alur dalam
program yang dapat dipakai dengan memperhatikan kondisi yang ada. Semua
perintah-perintah di bawah ini dikerjakan dalam Visual Basic, dan beberapa
di antaranya juga mirip dengan yang dipakai dalam macrosheet.

Pengulangan
Do Whiile ... Loop

Mengulang suatu perintah selama kondisinya masih bemilai True. Apabila
sudah bernilai False, program akan keluar dari pengulangan dan pindah ke
kode program berikutnya. Bentuk yang lain adalah Do ... Loop While.

Penulisan:

Do While condition
[Statements]
[Exit Do]
[Statements]
Loop

Contoh:

Sub Command ()
IT =1
Do While II <= 5
Cells(l + II, 1) = 11
IT = I + 1
Loop

End Sub
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Do Until ... Loop

Mengulang suatu perintah hingga kondisi menjadi True. Apabila sudah
bernilai True, pengulangan akan dihentikan. Bentuk yang lain adalah Do ...

Loop Until.
Penulisan:
Do Until condition
[Statements]
[Exit Do]
[Statements]

Loop

Contoh:

Sub Command ()
IT =1
Do Until II > 10
Cells(1 + II, 1) = II
IT = IT + 1
Loop

End Sub

For ... Next
Mengulang suatu perintah dengan nilai yang ditetapkan.
Penulisan:
For counter = start To end [Step step]
[Statements]
[Exit For]
[Statemens]

Next [counter]

Contoh:

Sub Command ()
IJ = 1
For II = 1 To 5
Cells(1l + II, 1) = IJ
1J = IJ + 1
Next II
End Sub



While ... Wend

Men_jalankan suatu statement dalam pengulangan selama kondisinya masih
bernilai True. Dalam macrosheet dikerjakan dengan While...Next.

Penulisan:

While condition

[Statements]
Wend
Contoh:
Sub Command ()
IT =1
While II <= 5
Cells (1l + II, 1) = II
IT = IT + 1
Wend
End Sub

For Each ... Next

Mengulang suatu perintah sebanyak anggota dalam data array, dengan jumlah
yang tidak diketahui.

Penulisan:

For Each element In array
[Statements]
[Exit For]
[Statements]

Next [element]

Contoh:

Funct;on Command{Yarray, Xarray) As Variant
Dim N As Integer, x As Single, y As Single

N =0

x =0

y =0

For Each c In Xarray
N =N+ 1
X = X + Xarray(N)
Y =y + Yarray(N)

Next

a = x * x
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b=y *x
Command = Array(a, b)
1'nd Function

Pencabangan
If ... Then ... Else

Penggunaannya sama seperti fungsi built-in logika dalam spreadsheet, tetapi
di sini cara penulisan yang dipakai dalam pemrograman.

If condition (1) Then
Statement (1)
Elself condition (2) Then
Statement (2)
Else
Statement (3)
End If

Pencabangan ini biasanya juga dipakai dalam suatu pengulangan. Apabila
kondisinya bernilai True, program kemudian keluar dengan perintah Exit.
Bentuk If ... juga dapat disertai dengan And, Or, atau Not untuk
menyatakan ekspresi dan relasi antara dua ekspresi.

For ... or Do Until ...
Statement (1)
If expression (1) And or Or expression (2) Then
Statement (2)
Exit For or Exit Do or Exit Function or Exit Sub
End If
Next ... or Loop

GoSub ... GoTo ... Return

Digunakan pada alur program yang terdiri atas satu atau lebih sub-program.
Sub-program adalah perintah yang dibuat untuk melakukan tugas-tugas yang
spesifik. Manfaatnya agar penulisan program secara keseluruhan menjadi
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lebih terfokus: Prosedpr sub diberi nomor sebagai alamat dari baris sub ini
dan pada baglal? akhir diberi perintah Return untuk kembali ke statemen;
sebelumnya. Perintah GoTo dipakai untuk melengkapi alur program ini.

Contoh:

GoTo 40

20 e = KM
C = e * a:Return
40
a = NM
GoSub 20
F=h* ¢
a = NP
GoSub 20
G =3 * ¢
Hasil = F + G
End Sub

Call ... Sub

(I;e‘:brin.tah ini rgirip dengan GoSub, GoTo, dan Return. Namun di sini sub
1bert nama dan digunakan kata Call untuk i
Drosed memanggil dan memproses

Contoh 1: Prosedur Sub — Function
Sub Luas(x, y, L)

L =x*vy
End Sub

Function Volume(a, b, t) As Variant
If a <= 0 Or b <= 0 Then

Volume = "#VALUE!"
Exit Function
Else
Call Luas(a, b, L)
Volume = L * t

End If
End Function

Contoh 2: Prosedur Sub — Sub
Sub Luas(x, vy, L)

L =x *vy
End Sub

Sgb Vol{()
Dim a, b, t As Single
a = Cells(12, 6)
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b = Cells (12, 7)

t = Cells(l2, 8)

If a <= 0 Or b <= 0 Then
Cells(12, 9) = "#VALUE!"
Exit Sub

Else
Ccall Luas(a, b, L)
Volume = L * t
Cells (12, 9) = Volume
End If
End Sub

2.5.4 Contoh-Contoh Fungsi Pemakai

Berikut ini beberapa contoh fungsi pemakai beserta penggunaannya dalam
spreadsheet. Contoh 2, 3, dan 4 mungkin sudah tidak begitu asing apabila
kita sering membuat formula dengan fungsi built-in. Namun fungsi yang
didefinisikan sendiri akan menjadi sangat spesifik dengan argumen dan
formula yang dibuat oleh pemakainya.

Contoh 1
Menghitung luas persegi panjang di mana Luas = Panjang x Lebar.

Dalam macro hal ini diekspresikan sebagai fungsi (a,b) =axb.

Ini contoh pertama di mana kita akan membuat sebuah fungsi pemakai.
Langkah pertama, menyisipkan macrosheet dengan Insert > MS. Excel 4.0
Macro > OK. Kemudian tulis macro-nya sebagai berikut.

LUAS
=RESULT(1)
=ARGUMENT("a",1)
=ARGUMENT("b",1)
=RETURN(a*b)

(6,000 F - (O |\ I e

Setelah itu kita harus mendefinisikan nama fungsi ini agar dikenal oleh
Excel. Langkah-langkahnya sebagai berikut.

1. Tempatkan pointer pada nama fungsi, yaitu LUAS pada sel Al.

2. Kemudian klik Insert > Define > Name > OK. Nama fungsi secara
otomatis akan mengacu ke sel Al, yaitu LUAS.
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i

3. Apabila Anda ingin menambahkan fungsi ini ke dalam menu Function,
pada option button klik Function atau Command, kemudian pilih

kategori untuk fungsi Anda atau sebuah shortcut key untuk itu.

Sekarang kembali ke spreadsheet. Anda dapat langsung menggunakan fungsi
LUAS dengan merujuk pada alamat sel atau nama sel. Pemakaian fungsi
LUAS dalam worksheet dikerjakan seperti berikut ini.

Luas
2 3.

6 C2=LUAS(ab)

Contoh 2

Menghitung luas bidang yang dibatasi garis linear y = mx + ¢, aksis-X, x = a
danx = b, untuk ¢ > 0. Hal ini akan dilakukan dengan penyelesaian integral.

b
L= j (mx + ¢)dx
Dalam macro, L diekspresikan sebagai:

fungsi (m,c,a,b) = (%o.m. b* + c.b) - (Yom. & + c.a).

Diminta mencari luas yang dibatasi garisy =x + 2, aksis X, a=-1 dan b = 3,
dan juga pesan error-nya.
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Macro

BIDANG
=RESULT(1)
=ARGUMENT("m",1)

=ARGUMENT("c_",1)

=ARGUMENT("a",1)

=ARGUMENT("b",1)

=-c_/m

=IF(m<0,IF(OR(a>A7,b>A7),RETURN(#VALUE!)))

=IF(m>0,IF(OR(a<A7 b<A7),RETURN(#VALUE!)))

=(1/2)'m*a*2+(c_*a)

=(1/2)*m*b*2+(c_*b)
=RETURN(A11-A10)

- W (N |-
213 o o |~ o |0 |» l‘

-
N

Contoh soal dalam grafik

Luas bidang yang dibatasi garis y=x+2,
aksis X, a=-1,b=3
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Pemakaian fungsi dalam worksheet

3 12 E2=BIDANG(m,c_ |
.3 ®ALUEl E3=BIDANG(m,c_atb)
5 #/ALUE! E4=BIDANG(m.c_a,b)

Contoh 3

Seorang dosen meneta i ilai

‘ pkan tingkatan nilai untuk i i
ll;erlkut, A. untuk nilai 80 — 100, B = 65 — 79, C =s‘3}11a til 6123“]3) liufllgh Sggiigal
: untuk nilai di bawah 40. Juga akan dipakai tanda + d, - iap
ingkatanngs. an — untuk setiap

Macro
A

1 _[NILAI
2 |=RESULT(2)
3 =ARGUMENT("G",1)
4 =ARGUMENT("Ax",1)
5 =ARGUMENT("Bx",1)
6 =ARGUMENT("CX",1)
7 =ARGUMENT("Dx",1)
8_|=IF(G>=(2*100/3+Ax/3),RETURN("A+"))
9 |=IF(G>=(100/3+2*Ax/3),RETURN("A"))
10 =IF(G>=Ax,RETURN("A-"))

11 |=IF(G>=(2*Ax/3+Bx/3), RETURN("B+"))
12 |=IF(G>=(Ax/3+2*Bx/3),RETURN("B"))
13 |=IF(G>=Bx,RETURN("B-"))

14 _|=IF(G>=(2"Bx/3+Cx/3),RETURN("C+"))
15 |=IF(G>=(Cx/3+2*Bx/3),RETURN("C"))
16 [=IF(G>=Cx,RETURN("C-"))

17 =IF(G>=(2*Cx/3+Dx/3),RETURN("D+"))
18 [=IF(G>=(Cx/3+2*Dx/3),RETURN("D"))
19 =IF(G>=Dx,RETURN(“D-"))

20 |=RETURN("F")
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Pemakaian fungsi dalam worksheet

A B C
1 |Nama Mahasiswa| Nilai | Huruf
2 |Magda Denawati 51 C- |C2:=NILAI(B2,80,65,51,40)
3 | Jeni Arnis 93 A+
4 |Joe Manik 90 A hasil copy sel C2 ke sel C3 s.d. C6
5 [Malik Hasan 70
6 | Anto Sirat 37 F

Apabila seorang dosen kemudian menetapkan standar lain untuk mata kuliah
yang lain, maka cukup dengan mengganti argumen nilai dari fungsi NILAI

dalam worksheet.

Contoh 4

Mencari distribusi tegangan di bawah pusat pondasi pelat b x I. Diketahui
beban awal Q = 90 ton bekerja pada pusat pondasi ukuran 3.0 x 3.0 meter.
Distribusi tegangan diminta digambarkan pada grafik dalam setiap interval

kedalaman 0.5 meter.

Contoh soal ini akan diselesaikan dengan persamaan elastis dari Boussinesq —
Newmark (1935). Persamaan untuk mendapatkan tegangan di bawah sudut

pelat persegi pada kedalaman y adalah:

=0, .
T A VA, ¥ V-V,

o, = —1—\:———2MNW u+tan"[——zmﬁ]i|

di mana
M=bly
N=Vy
V=M?*+N*+1
V, = (MN)?

Apabila V| > V maka arctan dalam persamaan perlu ditambah dengan =.
Macro akan dibuat dengan aplikasi Visual Basic dan diberi nama Bouss.
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| A l B l C ! D E .
H py | unit ton-meter
! o 2,$C$2,D2
i 2| 10 15 15 0.00* | 10.00 | E2=4"BOUSS($AS2,$B$2,$C52,02)
i 3 050 | 9.76
“‘ 4 1.00 | 8.63
‘““ 5 150 | 7.01
o p 2.00 | 5.49
i “‘ 7 250 | 4.28
I 8 3.00 | 3.36 > Hasil copy sel E2
‘ 9 350 | 2.68 ke sel E3 s.d. E14
H 10 4.00 | 217
| L ] 1 450 | 1.79
i 12 5.00 | 1.49
1
! Macro 13 550 | 1.26 |
| 14 6.00 | 1.08
W Function Bouss(p, b, 1, y) As Variant hitungan, oleh
i rﬁonskta Sly: Joraisszess Catatan, *: pembagian dengan 0 tidak diperkenankan dalgrln perhitungan,
“‘\‘ = 2 * - 1 .
E n-1y/ y - karena itu gunakan pendekatan = 0 (ambil misalnya 0.0001)
o Vo= m A +n A +
i‘ Vs = (m * n) » 2
“‘ rad = (2 *m * n * gqr(v)) / (v - vs)
[ If vs > v Then at = atn(rad) + Pi Else at = atn(rad)
f Bouss = p / (4 * Pi) * (((2 *m * n * Sqar(v) / (v + vs)) * ((v + ]
o 1) / v)) + at) Grafik Tegangan versus
‘ End Function Kedalaman
: \

Tegangan (ton/n?)
Macro ini merupakan sebuah fungsi untuk mencari besarnya tegangan o,

pada setiap kedalaman di bawah sudut pelat persegi panjang. Langkah 0 5 10 15
pertama adalah menjadikan beban terpusat O menjadi beban merata, dengan
membagi Q dengan luas pelat. Kemudian pelat dibagi menjadi beberapa buah
bidang dan untuk beban yang terpusat, diperoleh 4 bidang yang sama besar.
Jadi untuk empat sudut yang ikut berkontribusi diperoleh tegangan = 4 o,

Pemakaian fungsi BOUSS dalam worksheet dikerjakan seperti berikut.

Kedalaman (meter)
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Slr:;lllfasi kedglaman tal?al‘l da}am grafik dibuat bertambah besar ke bawah
ol 11(nen1§er_.]akan hal ini, klik dua kali pada salah satu nilai aksis-Y hin z;
r kotak dialog Format Axis. Klik tab Scale > Values in reverse ordegf

Contoh 5

M .
encari akar x pada persamaan: ax* + bx’ + cx?*+ dy+ e = 0.

Hal ini akan diselesaikan secar: i
_ a numerik dengan
5 umeri gan metode Newton-Raph
p;?lzzsk ;;:rhm.llngan pada metode ini dikerjakan dalam suatu iteras?pysaci)?li
= danndirl:lia;; lylc(a;ecara btertahal;z. Fungsi persamaan digambarkan ’dalam
memotong aksis-X pada titik p d =
Pada tahap awal diambil nilai : R e s (2 )
d ¥; untuk mendapatkan garis singeun
gen ({; ggtal)l'a:fm{(nemotong aksis-X di titik (x,, 0), di mana x, %figlfh Ir)x?l(:;
nee p. Proses pendekatan berikutnya dilakukan dengan nilai
untuk mendapatkan x; dan seterusnya hingga x, — p. B

]

/ Y-f(xn) =f'(Xn) (X-Xn)

Jadi secara induksi di -
Lo peroleh garis singgung: y — _ f
Garis ini memotong aksis-X di titik (x,, f 0), ﬁi 1)1)1 ana:f () = fG)x — x).

_SG)
n f’(xn) .

xn+1 =X,
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Proses perhitungan dengan metode Newton-Raphson ini kemudian dibuat ke
Jalam macro dan diberi nama TRIAL. Dalam contoh berikut macro akan

dipakai untuk mencari nilai x pada persamaan:
2.79%° — 12.11x% + 24.51x + 36.68 = 0.

Bentuk persamaan ini dapat ditemukan dalam mencari kedalaman tancapan
dinding turap dengan metode tumpuan tanah bebas (Free Earth Method).
Penyelesaiannya dalam worksheet dikerjakan seperti berikut.

Bhath , . o dx L, e =0 :
a b ¢ d_ . e x=__ ] .
T 279 1211 2451 3068 22347 FISTRIAL@be de)

Macro

Function TRIAL(a, b, c, 4,
n 1000

I 1

X 100

Do
funct (a * x n4) + (b*x~3)+ (c*xn2)+(d*Xx

deriv (4*a*x’\3)+(3*b*xA2)+(2*c*x)
xn = x - (funct / deriv)
If funct = 0 Or (Abs(xn - Xx)
TRIAL = Xn
Exit Function

e) As Variant

oo

) + e
+ d

< 0.00001) Then

End If

I =1+ 1

X = XN
Loop Until I = n
TRIAL = 'Divergen!'

Exit Function
End Function

Contoh 6

Tabel X adalah data bilangan random dari 0 — 100. Anda diminta menghitung
banyaknya data dalam Tabel X dengan kriteria nilai dari Y hingga Z.

A B c I D E F G
Tabel X
77.58 73.27 22.21 70.40 81.40 52.57 98.34
68.58 21.86 62.37 37.61 51.24 12.41 18.55
63.34 32.81 83.16

60.92 22.26 35.01 23.76
98.27 63.85 30.97 34.98 64.44 70.49 17.96

71.23 79.63 74.21 100.00 | 37.95 3.94 95.27
10.62 20.69 5.82 74.81 95.09 37.48 0.74

~N (o |0 |& W N =
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Macro

anction DIST (Xarray, Y, Z) As Variant
Dim N, Num As Integer

N =0
For Each ¢ In Xarray
N=N+1

If Xarray(N) >= Y =
Nort y And Xarray(N) <= Z Then Num = Num + 1
DIST = Num
End Function

Pemakaian fungsi dalam worksheet

| J K
0.0 50.0 19 K2:=DIST(X,J2,K2)
50.0 100.0 23 K3:=DIST(X,J3,K3)
0.0 100.0 42 K4:=DIST(X,J4,K4)

Argqmgn (X) di sini adalah argumen array, sehingga penulisannya juga dapat
llzlenjadl (A2:G7) atau range .tertentu: (B2:C7), (A7:G7) dan sebagainya. Satu
Of;;ludahinhmi;nbuat fungsi dengan spreadsheet karena memang ditunjang
worksheetnya untuk pembuatan nama variab 1 i
mencmpation b riabel, penulisan fungsi dan

Catatan:

1. Karakter ”c” dan “r” tidak dapat digunakan untuk nama variabel dalam
macrosheet, karena C dan R mewakili kata perintah untuk penentuan
kolom (Columns) dan baris (Rows). Apabila Anda mendefinisikannya
galaf’n \Xorkbook, secara default Excel akan mengubahnya menjadi ”cy”

an’r >, -

2. Apabila sebuah fungsi mempunyai lebih dari satu hasil jawaban (hasil
array), maka digunakan fungsi Index untuk menurunkan hasilnya
Contohnya seperti yang diperlihatkan formula array GARIé
(Ga'mbar 2.2) atau LINEST (Gambar 1.3) yang mempunyai dua indeks
hasil secara berurutan untuk SLOPE dan INTERCEPT Contoh
sederhana misalnya, sebuah fungsi AKAR untuk mencari akar.-akar real
x1 da.n x2 pz}da_ persamaan ax2 + bx + ¢ = 0. Penulisan macro hasil
fungsi menjadi: AKAR = Array(xl, x2) dalam VB atau
RETURN(x1_:x2 ) dalam macrosheet.
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2.6 Circular Reference

Ketika formula terhubung dengan selnya sendiri baik secara langsung atau
tidak langsung, maka kondisi ini disebut circular reference. Excel secara
default tidak dapat memproses formula yang berisi circular reference sampai
kita mengaktifkan Iteration pada Tools > Options > Calculation. Iterasi
adalah pengulangan perhitungan sampai kondisi numeriknya terpenuhi.

Proses perhitungannya akan dijalankan berdasarkan jumlah iterasi yang
dimasukkan pada textbox Maximum iterations dan batasan (maksimum)
untuk hasil dua iterasi terakhir pada Maximum change. Excel akan berhenti
menghitung bila salah satu kondisi sudah terpenuhi atau mana yang dicapai
lebih dulu.

Dalam aplikasinya, circular reference dapat digunakan misalnya untuk
penyelesaian stabilitas lereng cara Bishop dimana faktor keamanan berada
pada kedua ruas persamaan. Atau penyelesaian untuk rembesan (seepage) di
bawah bendungan dengan metode finite difference. Sel dengan circular
reference diperlihatkan dalam spreadsheet seperti berikut:

Contoh 1
A B Hasil = 1 x iterasi A B
1] 4 4
2 =B2 |=(A1+A2)/3 2 0 1.33333
5 x iterasi A B
4

2 11.97531| 1.99177

100 x iterasi A B
4
2 2 2

Secara singkat, dapat dijelaskan di sini mengenai metode iterasi Excel untuk
menghitung contoh 1. Formula pada sel A2:B2 saling terkait dan mempunyai
bentuk: x = f{x). Dalam iterasinya, dihitung melalui persamaan: x,,; = Sfxn),
di mana: x,, = perkiraan nilai x pada iterasi ke n

Xpn+1 = perkiraan nilai x yang baru pada iterasi ke n+1

n = jumlah iterasi
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Formula pada sel A2:B2 ditulis: x,,, = (4 +x,)/3.

Pada iterasi pertama (n=1), x, di _
- , X1 diambil = 0 —» x, = (4 + 0)/3 =

Pada n =2, x, diambil = 1.33333 — x, =1.77778 (4 +0)/3=1.33333

Padan=5,x5=197531 — x= 1.99177

Dan seterusnya.

Excel akan mengerjakan proses ini berdasarkan jumlah iterasi (n) dan batasan
( lx,,ﬂ —xnl) yang Anda tetapkan, dan akan berhenti bila hingga salah satu

terpenuhi. Analogi ini sama seperti pad :
metode yang dipakai berbeda. pertl pada proses fungsi TRIAL, namun

Contoh 2
B C 1 x iterasi A B C
110 10 10 1 0 10 10
2110 =(B1+B3+A2+C2)/4 | =B2 2 [ 10 5 5
310 =(B2+B4+A3+C3)/4 | =B3 3110 3.75 3.75
410 0 0 4 0 0 0
5 x iterasi A B C
1 0 10 10
2 | 10 |8.64128 | 8.64128
3 | 10 |6.18032 | 6.18032
4 0 0 0
100 x iterasi A B C
1 0 10 10
2110 8.75 8.75
3110 6.25 6.25
4 0 0 0

sDzll:lg'l fgrmul.a; sp}lg 2BZ, kr;ilai awal yang diambil untuk B3 dan C2 adalah = 0
utnya nilai akan dipakai sebagai nilai awal dalam f B3,
. ! 32 akan ' ormula sel B3,
dfm.ana C3=0. Nlla}-mlal yang didapat kemudian dipakai sebagai perkir

nilai yang baru pada iterasi berikutnya. P -
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BAB 3
FUNGSI UNTUK ANALISIS DATA

Excel mempunyai banyak fungsi built-in yang digunakan untuk menganalisis
sekumpulan data dari hasil suatu pengujian. Metode yang dipakai juga cukup
bervariasi. Dalam bab ini akan diterangkan pemakaian fungsi-fungsi ini,
namun dibatasi hanya pada beberapa fungsi yang umum dipakai. Kumpulan
data yang ditinjau adalah data model dan data statistik.

3.1 Pemodelan Data

Pemodelan data merupakan hal yang umum dilakukan dalam bidang sains
dan teknik. Cara ini digunakan untuk mencari parameter-parameter teoritis
yang memberikan hubungan paling tepat antara teori dan hasil pengujian.
Tiga cara yang akan dibahas di sini adalah regresi linear, regresi polinomial,

dan interpolasi.

3.1.1 Regresi Linear

Regresi linear adalah menentukan garis lurus yang fit atau paling mendekati
dengan sejumlah data titik, dengan memberikan hubungan linear antara dua
variabel. Metode yang digunakan untuk mendapatkan garis tersebut adalah
dengan metode kuadrat terkecil (least suare method). Jadi regresi linear
terdiri atas titik-titik yang fit dengan sejumlah (n) data titik (x;y;) yang
dituliskan ke dalam persamaan garis lurus:

y=Ax+B G.D
di mana:
A = slope (kemiringan) garis
B = perpotongan garis lurus dengan aksis-Y
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Akurasi dari kesesuaian antara i

- ! garis lurus dengan sejumlah iti

dieval - 1gan sejumlah data titik dapat " d n

aluasi dengan deviasi total E, yang adalah jumlah dari pangkat dua, jafi A Z X!+ BZ X, = in yi
-1

antara data titik dan titik-titik yang fit.

3.5)

i=1 i=1

xlix,. +Bn=§:yi
il

E Z 2 z
= ei = (Ax i + B —-Yy. 2
=1 Py ye) 32) i=1
Nilai 4 dan B adalah:
Y
nzxiyi —inzyi
=t =l =l
Ax;+B A= N i 2
Yi "Z x} - [Z x,)
i=1 i=1
n n 2 n n
Zyz‘ in _inzxiyi
B = i=1 i=1 i=1 i:l2 (36)
”2 x} - (z X, )
i=1 i=1
E akan minimum i .
apabila turunan pertamanya terhadap 4 dan B = 0: Dalam worksheet, regresi linear dikerjakan dengan fungsi built in SLOPE,
INTERCEPT atau LINEST. Macronya dapat dibuat seperti berikut.

OE

- = 0 dan -ai = 0 . H o

04 OB (3.3) REGRESIL : Nama fungsi untuk regresi linear

=RESULT(64) : Hasil fungsi sebuah array
Dari Persamaan 3.2 dan 3.3: =ARGUMENT("Y",64) : Data y dalam array
=ARGUMENT("X",64) : Data x dalam array
OE " n =COUNT(X) - Jumlah data dalam array x dan y
e = ZZ x,(Ax;+B-y,)=0 Sx =SUM(X) D XT4X2+...4XN
i Sy =SUM(Y) s yl4y2+..+yn

dan, Sxx | -SUMPRODUCT(X.X) X1 XAX2 K2+ AXOXN

5 Sxy  |=SUMPRODUCT(X.Y) L x1Hy14x24y 2+ 4xnfyn

£ = ZZ (Ax,+B-y,)=0 D =n*Sxx-Sx"2

04 i=1 ! (3.4) =lF(D=0.RETURN(“#DIVIO!")) : Pesan error
Per 34 ad Slope | =(n*Sxy-Sx*Sy)/D : Nilai A

samaan 3.4 adalah sistem d i Intercept | =(gy* > : Nitai
tidak diketahus: ua persamaan linear dengan 4 dan B yang =(Sy"Sxx-Sx"Sxy)/D : Nilai B
=RETURN(Slope:intercept) : Mengeluarkan hasil fungsi
44
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3.1.2 Regresi Polinomial

Fungsi polinom (suku banyak) mempunyai bentuk:
f®=ax"+a,x"" + .. + ax + ag (3.7)

di mana m = bilangan bulat iti i
positif dan d i i
orde m. Persamaan 3.7 dapat ditulis: fsebut fungsi polinom dengan

9= ax
]zo 7* (3.8)

F?l%resi polinorr;ial. terdiri atas titik-titik yang fit dengan sejumlah (n) data

c;t : (x; yi) mepjadl ‘bentuk polinomial. Regresi linear adalah bentuk khusus
ari regresi pOllI.‘loml&'ll dengan m = 1, A = g, dan B = a,. Akurasi kesesuaian

zntzg:) ag;:'ls pol.morln;iil dengan data titiknya dievaluasi dengan deviasi total
; 1 penjum j iti

et penjumlahan pangkat dua, jarak antara data titik dan titik-titik

E= n N '2
;[f(%) ] (3.9)

E akan minimum jika turunan pertamanya terhadap aj=0:

3 _
0a, B
untukj =0, 1, ... m (3.10)
ini berarti, |
N F(x;)
[f(x,')_ == =
; y ] o 0 untukj=0,1, ... m 3.11)

J

‘I;/ilteel:i:li(abel;(eratga. manipulasi aljabar, dari persamaan 3.11 kemudian dapat
‘ n koefisien ay a;, a; ... hingga ord i ilai R? j
digunakan sebagai ukuran kesesuaian tit;glfz . Selain £, nilai & juga

ib)i - f(x.-)]z

R*=1——il
(3.12)

iy? —%(Z":y,-)z

i=1 i=]
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Nilui R? bervariasi dari 0 s.d. 1, dan tingkat kesesuaian yang maksimum
adalah R = 1. Makin tinggi orde polinom, nilai R? makin mendekati hingga =

| (K° = 1 jika garis regresi berimpit dengan datanya).

3.1.3 Contoh Regresi dalam Grafik

Regresi Linear

(jambar 3.1 menunjukkan pemakaian regresi linear yang diterapkan pada
duta yang dihasilkan dari pengujian kuat geser. Cara grafis ini dipakai untuk
mencari parameter kuat geser, yaitu kohesi (c) dan sudut geser dalam () dari
massa tanah. Pada umumnya, penggambaran data yang dihasilkan dari
pengujian jarang merupakan garis lurus untuk menyatakan selubung
keruntuhannya. Oleh karena itu, diperlukan garis yang fit untuk mewakili
data tersebut. Keadaan tegangan dari massa tanah tersebut tidak akan berada
di atas selubung keruntuhannya. Dalam uji direct shear, selubung keruntuhan
adalah suatu garis linear yang dinyatakan dalam persamaan: »

1=c+o,tan ¢

di mana:
1 tegangan geser pada saat runtuh
¢ kohesi

6, tegangan normal
¢  sudut tahanan geser

Kekuatan geser (1) di sini adalah fungsi linear terhadap tegangan normal, di

mana c¢ dan tan ¢ masing-masing menyatakan perpotongan garis dengan

aksis-Y dan slope dari garis.

Hasil yang yang diperoleh dari uji direct shear adalah sejumlah data (x;y;)
untuk setiap tegangan normal. Garis

dari tegangan geser pada saat runtuh
regresi kemudian digambar ke dalam grafik dengan Trendline. Langkah-
langkahnya dengan mengklik kanan mouse pada saat pointer berada pada
salah satu data titik hingga keluar sebuah kotak menu. Dari kotak menu, klik
Add Trendline > Linear > Options > Forecast > isi Forward dan
Backward untuk memperpanjang trendline > OK. Hasilnya seperti tampak

pada Gambar 3.1. Trendline adalah persamaan garis yang dikerjakan melalui

Persamaan 3.1 sampai 3.12.
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Direct Shear Test
£ 30
2 |
2 | 3 |
5 20 selubung keruntuhan
8 ‘ A\
(O]
& 1.0 -
j=)]
c
©
5
2 00 : ‘ 7
0.0 1.0 2.0 3.0 4.0 5.0
Tegangan Normal (kg/cn?)
Triaxial Test

2.0
T:;: 15 ‘ modif(kasi selubung keruntuhan
o 10 AN ;
X 05 ! :

0.0 i : 5 “

0.0 1.0 2.0 3.0 4.0 5.0
Ya(oy + 03)

Gambar 3.1 Regresi dalam grafik

Perpotongan garis pada aksis-Y ilai
-Y adalah nilai ¢ dal ji ihi
: alam pengujian, d
=§1;jg(a;;E( ‘f(o;n)méa; =INTERCEPT(Y,X). Slope garigs ! samjlln dtlil:;ugrgl
i X). Slope dan intercept adalah nilai A dan B pada Persamaan ?% 6
geser ¢ kemudian dapat dihitung menjadi (dalam derajat): -

=ATAN(SLOPE(Y,X))*180/PI()

Beberapa fungsi dapat dipakai untuk maksud yang sama:
=INDEX(LINEST(Y,X),1) untuk Slope,

=INDEX(LINEST(Y,X),2) untuk Y-intercept,

=TREND(Y,X,0,TRUE) adalah nilai Y yang koresponding dengan x = 0.
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hockuatan geser juga dapat dinyatakan dalam tegangan utama besar oy dan
kevil oy dalam uji triaxial. Dengan memplot Y%(c1 — 03) terhadap Y4(oy + 03)
mtuk setiap kondisi tegangan, akan diperoleh sejumlah data titik (xiyi)-
kondisi tegangan yang fit dengan sejumlah data titik di sini disebut sebagai
modifikasi  selubung keruntuhan, yang merupakan garis linear yang

dinyatakan dalam persamaan:

Yo — 0'3)=a+ 1/2(O'1+ 0"3) tan o

P'arameter a dan tan a masing-masing adalah Y-intercept dan slope dari garis
ini. Parameter ¢ dan ¢ kemudian diperoleh melalui hubungan:

¢ sin'(tan @)

a
cos ¢

=

Regresi dalam Grafik Log

Pada contoh kedua, kita akan mencari relasi data dalam satu series di mana
aksis-X-nya dalam skala log seperti pada Gambar 3.3. Di sini Persamaan 3.1

dikerjakan menjadi:

y=Aln(x)+B,

di mana:

A dan B adalah konstanta

Sebagai contoh, data yang diambil uji tanah di laboratorium untuk mencari

batas cair (liquid limit), yaitu kadar air tanah pada 235 pukulan. Berikut
beberapa keterangan yang diperlukan.

Kadar air (W) =
[(berat tanah asli — berat tanah kering)/(berat tanah kering)] x 100%.

Kadar air’ (W’) = data W yang fit dalam hubungan semi-log.

Formula yang digunakan untuk mencari data titik yang fit antara serie data
kadar air dan N (pukulan) dapat dilihat pada Gambar 3.2. Garis regresi dibuat
ke dalam grafik dengan Add Trendline > Logarithmic > OK, atau dengan
menggunakan Chart Wizard dari serie data N — W’. Pada N = 25 pukulan,

titik yang fit diperoleh = 70.93%. Cara lain dengan memasukkan nilai x ke

dalam persamaan Trendline y = -10.887 * In(x) + 105.97. Untuk
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“‘ i . . .
w/: menampilkan persamaan ini, klik Options > Display Equation pada kotak
Liquid Limit Sheet

' ‘ dialog Add Trendline.
;
i 85.00
(‘“ Al B [ © D e [ F [ & e Data
1 LIQUID LIMIT TEST 80.00 - i
‘ ) < ——Log. Trendline
} 3 | No. Berat Can + Can + Pukulan| Kadar | Kadar £
4 | Set| Can*(gr) | Tanah (gr)| Tanah Kering (gr) Air (%) | Air' (%) ;
5 We Ww wd N w W 3
6 | 1 8.3 52.46 33.29 14 | 7671 | 77.24 =
: 7| 2 2.8 55.61 32.96 19 | 7510 | 73.92
: 8 | 3 2.8 57.14 35.12 29 | 68.13 | 69.31 60.00 :
yj;‘; 9| 4 7.8 52.72 34.62 36 | 67.49 | 66.96 10 » 100
j Liquid Limit (%)= 70.93 N (Pukulan)

Slope of flow line = 0.151
Gambar 3.3 Contoh regresi dalam grafik semi-log

Kadar Kadar
‘ Air (%) Air' (%) ‘
“‘ w W Pada contoh ketiga, kita akan bekerja dengan grafik dalam skala log-log.

Untuk itu regresi yang digunakan adalah Power Trendline, di mana
persamaan umumnya adalah:

=100*(Ww-Wd)/(Wd-Wc) | =TREND(W,LOG10(N),LOG10(ES))
““ =100*(Ww-Wd)/(Wd-Wc) =TREND(W,LOG10(N),LOG10(E7))
“ Liquid Limit (%) = =TREND(W,LOG10(N),LOG10({25}))

;“\“_‘ Slope of flow line = =-SLOPE(LOG(W),LOG(N)) Seperti juga pada contoh sebelumnya, fungsi built-in TREND, SLOPE,
! INTERCEPT dan LINEST akan digunakan bersama Trendline. Untuk

. * Can: wadah untuk diisi tanah.
i menggambarkan regresi ke dalam grafik adalah dengan Add Trendline >

“ !
Power.

‘i Gambar 3.2 Contoh data uji Liquid Limit dan SJormula yang digunakan
| Dari data nomor saringan (US sieve) dan ukuran saringan (mm), kemudian

| dicari ukuran yang fit dengan menggunakan formula seperti yang
diperlihatkan pada Gambar 3.4. Hasilnya kemudian dibuat ke dalam grafik
seperti tampak pada Gambar 3.5. Formula slope dan intercept untuk serie ini
adalah =SLOPE(LOG(d),LOG(N)) dan =INTERCEPT(LOG(d),LOG(N)).
Slope dan intercept adalah konstanta ¢ dan a dalam persamaan relasi Power.
Persamaan Trendline dalam grafik Gambar 3.6 akan sama dengan persamaan
yang dibuat fungsi SLOPE dan INTERCEPT dalam worksheet.

~N O o[ W

Y=10°X", c dan a = konstanta
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I
\’ A B c D A B ¢ | 0
\\‘\“ 1 Nomor | Ukuran | Ukuran 34 | Slope = +1.08461 =SLOPE(LOG(0)LOG(N)
H 2| Saringan |Saringan |Saringan ‘ 35 Intercept = 136039  =INTERCEPT(LOG(d),LOG(N))
“‘:1{5 3 US (mm)| yang Fit 36
| “\‘\ 4 N d (mm) |Formula : Sumber: Bardet, JP, Experimental Soil Mechanics, 1997.
“ 5 4 4750 | 5.098 =10°TREND(LOG10(d),LOG10(N),LOG10(AS5)) Gambar 3.4 Data nomor savingan, ukuran saringan dan ukuran yang fit
\‘h‘ 6 5 4.000 | 4.002 F10ATREND(LOG10(d),LOG10(N),LOG10(A6)) il I;ubungan log-log, berikut formula-formula yang digunakan.
! 7 6 3.350 | 3.284 [=10"TREND(LOG10(d),LOG10(N),LOG10(A7))
‘ “ 8 7 2.800 | 2.778 ldst.
9 8 2.360 | 2.404
10 10 2.000 | 1.887
11 12 1.700 | 1.548 10.0
12 14 1400 | 1.310
13 16 1.180 | 1.133 E
14 18 1.000 | 0.997 ‘E’ 1.0 -
15 20 0.850 | 0.890 >
16 25 0.710 | 0.699 %
17 30 0.600 | 0.573 g 01
18 | 35 0.500 | 0.485 3
19 | 40 0425 | 0.420 >
20 45 0.355 | 0.369 0.0 ' ,
21 50 0.300 | 0.329 1 10 100 1000
2] 70 | omm | oms Norror Sargen (L)
2; 12:)00 g: : zg g::zz Gambar 3.5 Grafik serie data dari GamI{ar 3.4 di mana {ungsi TREND
26 120 0125 | 0127 digunakan untuk mencari ukuran yang fi
27 | 140 0.106 | 0.108
28 | 170 0.090 | 0.087
\ 29 | 200 0.075 | 0.073
| 30 | 230 | 0.063 | 0.063
3“ 31| 270 | 0.053 | 0053
32| 325 0.045 | 0.043
33 | 400 0.038 | 0.035
|
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10.0
A Data
g ——— Pow er (Data)
~ 1.0 3
c
©
(o))
£
&
(7))
£ 0.1 : S
3 y =22.920x-1.0846
2 R?=0.9988
0.0 T T
1 10 100 1000
Nomor Saringan (US)

Gambar 3.6 Grafik serie data dari Gambar 3.4 di mana Power Trendline
digunakan untuk mencari ukuran yang fit

Regresi Polinomial

Gambar 3.7 memperlihatkan satu serie data titik x dan y, di mana
koordinat-X adalah suhu (°C) dan koordinat-Y adalah massa jenis air (gr/cm’).
Dengan mem-plot data x dan », akan diketahui bahwa sebaran data yang
dihasilkan memiliki trend yang melengkung. Regresi polinomial dipakai
untuk mendapatkan garis lengkung yang fit dengan sejumlah data titik.

Regresi dalam grafik dibuat dengan Add Trendline > Type > pilih Linear,
Polinomial Order 2 dan Order 3 > Option > Display Equation > Display
R-squared. Hasilnya seperti yang diperlihatkan pada Gambar 3.8. Terlihat
bahwa regresi polinomial lebih baik daripada regresi linear untuk serie data
ini. Titik-titik yang fit yang dibuat oleh regresi orde 2 dan 3 tampak seperti
benar-benar berimpit dengan datanya dan hanya dibedakan oleh nilai R, di

mana orde 3 adalah lebih baik. Excel 2000 menyediakan tipe regresi
polinomial hingga orde 6.
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A B
Suhu Masa Jenis Air

1 (°C) (griem®)
2 X Y

3 4 1.00000
4 16 0.99897
5 17 0.99880
6 18 0.99862
7 19 0.99844
8 20 0.99823
9 21 0.99802
10 22 0.99780
11 23 0.99757
12 24 0.99733
13 25 0.99708
14 26 0.99682
15 27 0.99655
16 28 0.99627
17 29 0.99598
18 30 0.99568

Sumber: Bardet, JP, Experimental Soil Mechanics, 1997.

Gambar 3.7 Contoh sebuah serie data untuk analisis regresi

Add Trendline
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1.0000 B
0.9995
09990 1 = D
c’g (a) Linear
& 09985 — — — —(b) Kuadratik Polinomial
2 09980 - (c) Kubik Polinorial
@ o0ggys | (@:y=-0.0002x+10015
= R2=09207
2 09970
] 09965 | (b) :y =-6E-06x2 +2E-05x +1
s R2=09999
= 09960 |
09955 4 ©: y=4E-08x3-8:;06;(2 +5E-05x+09999 1
0.9950 . . . ' .

0 5 10 15 20 25 30
Suhu x (°C)

Gambar 3.8 Analisis regresi dengan Trendline dari data Gambar 3.7

3.1.4 Interpolasi

Dalam suatu perhitungan engineering, kadang-kadang hanya diperlukan suatu
interpolasi data tanpa perlu menganalisis data dengan regresi. Di sini kita
mencari nilai y yang koresponding dengan nilai x yang diketahui dalam satu
segmen garis, berdasarkan tabulasi sejumlah data (x;y;), di mana x; secara
kontinyu mungkin bertambah atau berkurang. Interpolasi linear nilai y yang
koresponding dengan x adalah:

Yin — Vi
y=y+ 2y (3.13)
X — X,

i+l i
dimana (x-x,)(x—x,,)<0 dan x, # x,,,

Jika axis-X dikerjakan dalam skala log, Persamaan 3.13 menjadi:

In(y,,,) —In(y,)

i+l i

In(y) = In(y,) + (x~x;) (3.14)
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dimana (x—x,)(x—x,,) <0 dan x; # x,,,

Persamaan 3.14 dapat juga ditulis:

n2- = XX gy Yin (3.15)

Vi Xt — X% Yi

atau sama dengan:

Ce=x; ) (xp0—%;)
y= y[Z_lj (3.16)
Vi

Contoh Interpolasi

Dalam uji analisis ayakan (sieve analysis), diambil contoh tanah pasir seberat
1000 gr yang diletakan di dalam mesin ayakan. Ukuran saringan yang dipaka?
dan hasilnya setelah pengujian dipresentasikan dalam Tabel 3.1. Prosentasi
lolos dihitung berdasarkan akumulasi berat yang tertinggal.

Tabel 3.1 Hasil Uji Sieve Analysis

A B
1 Ukuran Ayakan % Lewat
2 (mm) Ayakan
3 9.50 100.00
4 4.75 97.80
5 2.36 95.48
6 1.18 88.50
7 0.60 70.60
8 0.30 24.10
9 0.15 2.40
10 0.00
Interpolasi semilog
Dso= 0.441
Interpolasi linear
Dso=  0.467
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Gambar 3.9 Interpolasi linear dan semilog dari data Tabel 3.1

Di sini kita akan mencari nilai prosentasi lolos yang koresponding dengan
ukuran butir dari material. Misalnya untuk mencari penyebaran ukuran butir
dglam 50% berat contoh pasir atau ukuran Ds,. Nilai yang bersesuaian dapat
diperoleh melalui Persamaan 3.13 dan 3.16, atau dengan membuat macro
seperti berikut.

LOGINTER : interpolasi semilog
=RESULT(1)

=ARGUMENT("Value" 1)

=ARGUMENT("X",64)

=ARGUMENT("Y",64)
=IF(OR(ROWS(X)<>ROWS(Y),COLUMNS(X)>1,
COLUMNS(Y)>1),RETURN(#VALUE!)) : pesan error
=FOR("I",1,ROWS(X)-1)
=IF(AND((INDEX(X,+1)-Value)*(INDEX(X,|)-Value)<=0
INDEX(X,1+1)<>INDEX(X,1)))

: data 1, sebuah bilangan

: data 2, sebuah array

: data 3, sebuah array

: syarat persamaan

=RETURN(INDEX(Y,)*(INDEX(Y, I+1)/INDEX(Y, 1))

A((Value-INDEX(X, 1)) (INDEX(X,1+1)-INDEX(X,1)))) : Persamaan 3.16
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=END.IF()

=NEXT()

=RETURN(#VALUE!)

Interpolasi semilog dalam Tabel 3.1 adalah =LOGINTER(50,B3:B9,A3:A9).
Macro interpolasi linear dikerjakan dengan mengganti Persamaan 3.16
dengan Persamaan 3.13 dalam macro LOGINTER.

Analisis saringan di sini dipakai untuk mengetahui baik atau buruknya
gradasi pasir. Gradasi dari pasir atau partikel berbutir (lanau hingga kerikil)
dapat diukur dengan koefisien keseragaman (Cy) dan koefisien kelengkungan
(C¢) yang dirumuskan sebagai:

CU=D60
DIO

c - Dy,

" D,D
60 10

Makin besar nilai C, maka makin besar pula rentang distribusi butiran.
Sedangkan partikel yang bergradasi baik biasanya memiliki nilai C¢ antara

1 sampai 3.

3.2 Data Statistik

3.2.1 Histogram dan Distribusi Kumulatif

Langkah awal suatu penyajian data statistik adalah membuat hasil pengujian
ke dalam gambar histogram untuk melihat penyebaran ukurannya. Dalam
histogram, data di-plot terhadap distribusinya. Sebagai contoh, dari uji kuat
tekan beton karakteristik diperoleh data secara acak dari 40 sampel berikut

mi1.
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Hasil Uji Kuat Tekan (kg/cm?)
376.28 399.30 375.41 370.41
394.43 409.47 393.53 371.43
387.19 374.34 386.30 372.44
390.35 392.29 389.46 390.30
401.27 386.78 390.37 384.82
379.95 361.23 379.08 362.28
380.97 402.90 380.10 400.86
389.33 368.22 388.44 366.35
384.64 399.20 383.76 407.46
396.34 365.36 398.83 363.51

Hasil uji ini kemudian dibagi ke dalam beberapa kelas dengan interval
(diambil) = 5 kg/cm®, kemudian ditabulasikan seperti pada Tabel 3.2.
Banyaknya data setiap kelas disebut frekuensi kelas. Untuk mempermudah
proses pendistribusikan data ini, dapat dilakukan dengan menggunakan
macro. Gunakan pencabangan If A >=B And A <= C Then dalam looping
For ... Next, di mana A adalah data hasil vji, dan kriterianya adalah range
nilai dari B sampai C.

Tabel 3.2 Data Distribusi untuk Membuat Gambar Histogram

Interval Kelas Titik Tengah Frekuensi Prosentasi Kumulatif
Kglem? kg/cm? N (%) (%)
360-365 362.5 3 75 7.5
365-370 367.5 3 7.5 15.0
370-375 3725 4 10.0 250
375-380 3775 4 10.0 35.0
380-385 3825 5 125 47.5
385-390 387.5 6 15.0 62.5
390-395 392.5 6 15.0 77.5
395-400 397.5 4 10.0 87.5
400-405 402.5 3 7.5 95.0
405-410 407.5 2 5.0 100.0
40 100.0
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Dari data pada Tabel 3.2, kemudian dibuat gambar histogram dan

kumulatifnya. Untuk membuat histogram, klik Chart Wizard ; pada
toolbar > Chart type Column > Series > Add > Category Xx) z_l’zus labels:
pilih range “Titik Tengah” > Values: pilih range ”Progentas1 > Ne.x't:
masukkan judul/title pada gambar. Untuk grafik frekuensi kumul_ajuf, pilih
grafik tipe XY (Scatter) dengan garis > Series > X-Values: pilih range
"Titik Tengah” dan Y-Values: pilih range ”Kumulatif”.

Frekwensi ()

3625 3675 3725 3775 3825 3875 3925 3975 4025 407.5
Kuat Tekan (kg/cm?)

Gambar 3.10 Histogram hasil uji kuat tekan beton

100
90 1
80 -
70 -
60 -
50 -
40
30 A
20 A
10 4

0 T T T T
360 370 380 390 400 410

Kuat Tekan (kg/crm?)

Frekwensi Kumulatif (%)

Gambar 3.11 Frekuensi kumulatif kuat tekan beton
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3.2.2 Range, Mean, dan Standard Deviation

Hasil penggolongan atau pendistribusian data umumnya didefinisikan ke
dalam tiga parameter statistik, yaitu range (jarak), mean (rata-rata), dan
standard deviation. Range adalah perbedaan antara nilai yang terkecil dan
yang terbesar dari sekumpulan data. Dari hasil uji di atas terdapat range
sebesar 48.24, yaitu dari 361.23 hingga 409.47 dalam satuan kg/cm’. Mean
atau nilai rata-rata adalah hasil penjumlahan nilai data. dibagi dengan jumlah
total data (n). Dari hasil uji di atas diperoleh mean 384.875 kg/cm®. Jika
kumpulan data dibagi ke dalam M kelas, rumusan mean adalah:

M
>imx,
x =4 (3.17)
n
di mana;

m; = frekuensi pada interval kelas ke-i

x; = titik tengah interval kelas ke-;

Mean merupakan nilai yang umum dipakai untuk mewakili nilai-nilai dari
sekumpulan data. Konsisten dengan hal tersebut, beberapa ukuran dibuat
untuk menyatakan penyimpangan atau deviasi, dan salah satu di antaranya
adalah rumusan mean square deviation (MSD). MSD ini juga disebut dengan

variance (varians), dan merupakan ukuran yang lazim dipakai. Rumusnya
adalah:

M _
Zm,. (x, —x)?
= (3.18)
n

Ukuran lain yang dipakai adalah standard deviation atau deviasi standar (S),
yang merupakan penarikan akar dari MSD:

(3.19)

Melalui Persamaan 3.19, deviasi standar untuk data hasi‘l uji pada ggbel ?121
dapat dihitung sebesar 12.49 kg/cm?, dan untuk. pgmbagl =(n- 11)h qukro :n
12.65 kg/em®. Telah diketahui bahwa dev1a51. sﬁapdar a(li<a a'1 ur "
penyimpangan nilai hasil uji dari rata-ratanya; di sml.besar- ecilnya jug
dapat menjadi ukuran dari mutu pelaksanaan suatu pekerjaan.

3.2.3 Distribusi Normal

Dari histogram dan pengukuran parameter statistik di atas dapat digambarkan
lengkung distribusi normal. Fungsi lengkung distribusi normal adalah:

%[T]z (3.20)

S8, D)= ——e

S\2z

Untuk distribusi log-normal dapat diperoleh dengan mengganti x dengan
In (x) dalam Persamaan 3.20.

m Data
—— Normal

Frekwensi (%)

400 410

0 T
360 370 380 390

Kuat Tekan (kg/cm?)

Gambar 3.12 Garis distribusi normal yang fit dengan data Tabel 3.2
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) 100
| a0 |
80 -
70 4
60

Frekwensi Kumulatif (%)

[ 0 : .

il T T
’\ | 360 370 380 390 400 410
1 Kuat Tekan (kg/crm?)

m Data
—— Normal

Gambar 3.13 Distribusi kumulatif normal yang fit dengan data Tabel 3.2

A B l C I D l E F G

‘. 1 _[Interval K:Ias Titik Tengah Frekuensi Prosen Kumulatif | Normal Normal

‘ 2 kg/cm Kg/cm? (%) (%) Kumulatif|

1 3 k N f

‘! ‘ 4 360-365 362.5 3 7.5 75 32 37

H““ 5 365-370 367.5 3 7.5 15.0 6.1 8.2

i 6 370-375 3725 4 10.0 250 9:8 16. 1

!‘ 7 375-380 3775 4 10.0 35.0 13.4 27.8

) 8 380-385 382.5 5 12,5 475 15.7 42.5

“\ 9 385-390 387.5 6 15.0 62.5 15.6 58.3

| 10 390-395 3925 6 15.0 77.5 13.2 72.9
11 395-400 397.5 4 10.0 87.5 9 6 84.4
12 400-405 402.5 3 7.5 95.0 5~9 92.1
13 405-410 407.5 2 5.0 100.0 3.1 96.5
14 40 100.0 ' .
15
16 Mean = 384.875 kg/cm?
17 S= 12499  kglem®
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F G
1 Normal Normal
2 | Kumulatif
3
| 4 |=500/(S*SQRT(2*PI()))*EXP(-0.5((k-Mean)/S)"2) =NORMDIST(k,Mean,S, TRUE)*100
5 =500/(S*SQRT(2*PI()))*EXP(-O.5*((k-Mean)/S)"2) =NORMDIST(k,Mean,S, TRUE)*100
D E I F
15
16 Mean = =SUMPRODUCT(k,n)/SUM(n) kg/cm®
17 S= =SQRT(SUMPRODUCT(n,(k-Mean)*2)/SUM(n)) kg/em®

Gambar 3.14 Contoh penyajian data hasil uji yang digunakan untuk
mencari distribusi normal dan formula-formula yang digunakan

Gambar 3.12 dan 3.13 memperlihatkan garis distribusi normal yang fit
dengan prosentasi frekuensi dalam Tabel 3.2. Gambar 3.14 memperlihatkan
formula-formula yang digunakan dalam penyajian hasil uji tersebut.

Mean: =SUMPRODUCT (k,n)/SUM(n)
$: =SQRT(SUMPRODUCT (n, (k-Mean)"2)/SUM(n))
Normal: =500/(S*SQRT(2*PI()))*EXP(-0.5*((k-Mean)/S)"2)
Normal Kumulatif: =NORMDIST(k,Mean,S, TRUE)*100

Nilai mean (rata-rata) dan S (deviasi standar) dihitung memakai
Persamaan 3.17 dan 3.19. Skala aktual untuk fungsi normal (Persamaan 3.20)

ditentukan dari interval yang dipakai, dalam hal ini diambil 5 kg/cm’.

Kemudian dikalikan dengan 100 untuk penggambaran dalam persen (%).

Dalam Excel juga dikenal beberapa cara lain untuk mencari distribusi, seperti
Exponential, Weibull, Gamma, Poisson, dan Student-z.
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BAB 4
PROGRAM MATRIKS

Perhitungan dengan cara matriks sangat cocok dan mudah untuk diselesaikan
dengan komputer. Oleh karena itu, seiring dengan semakin pesatnya
penggunaan komputer, cara ini menjadi sangat populer dan banyak dipakai
sebagai ganti dari analisis dengan metode yang manual. Dalam aplikasinya,
perhitungan dengan cara matriks ini dipakai untuk analisis struktur atau
dalam langkah-langkah penyelesaian dengan metode numerik (numerical

method).

4.1 Pengertian Matriks

Suatu matriks adalah suatu array persegi panjang yang di dalamnya terdiri
atas komponen-komponen bilangan pembentuknya.

ay, a,, e Qg
as
a
31
A =
Laml A2 amn_

Notasi untuk matriks biasanya dipakai [ ] dan () atau { } untuk matriks baris
atau kolom. Matriks A dapat ditulis [A] = [a;], di mana a;; adalah komponen-
komponen matriks, i = 1, 2, ..., m dan j = 1, 2, ..., n. Subskrip m
menunjukkan banyaknya baris dan » untuk kolom, atau biasa disebut orde
(m x n). Apabila anggota m = n maka disebut matriks bujur sangkar.

67



4.1.1 Tipe Matriks

1.

68

Matriks baris,
jikam=1.
Contoh: {1 2 3 4}

- Matriks kolom,

jikan=1,

Contoh:

BN

. Matriks Bujur Sangkar

Matriks Diagonal

Semua komponennya = 0 kecuali pada diagonal utamanya.

S OO =
S O N O
S W o o
0 © O ©

Upper Triangular Matrix

Semua komponen di bawah diagonal utamanya = (.

(all a, a5 a, .. q,
0 ay ay Ay .. a4y,
0
0 Ay Az ... 4y,
0 0 0
a44 e a4n
0 0 0
I 0 .. a

Lower Triangular Matrix

Semua komponen di atas diagonal utamanya = 0.

(@, 0 0 O 0
a, a, 0 0 0
a, 4z 4y 0 0
a, Gy Ay Gy 0
- - - - 0
A I T
Matriks Skalar

Matriks skalar adalah matriks diagonal di mana komponen diagonalnya
merupakan bilangan yang sama.

= = R
S O O
o O O
H» O © O

Matriks Satuan (unit matriks)

Matriks satuan adalah matriks skalar di mana komponen diagonalnya = 1.
Matriks ini juga disebut matriks indentitas dan umumnya dinotasikan

dengan[I].

oo o =
o O = O
S = O O
- o o <

Band Matrix

Band matriks adalah matriks bujur sangkar (n x n) di mana komponen
yang bukan nol dikelompokkan dan membentuk jalur komponen

diagonal.
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(@, a, 0 o 0 0
y a 0 0 0 0
0 0 ay a, 0 0
0 0 Ay Gy ... 0 0
0 0 0 o ayins a,,,
(0 0 o0 o a,, a. ]

Matriks Simetris
Suatu matriks [A] dikatakan simetris, jika
[A]T =[A] atau a;; = aj;

Contoh:
1 4 -5
4 2 6
-5 6 3
4.1.2 Operasi Matriks

Penjumlahan dan Pengurangan Matriks

Aoabi
diffrlrjfll:m[(ﬁ dan [EH] adalah dua matriks berukuran sama, keduanya dapat
ditulis: [ay] dan [B] = [b;] menghasilkan [C] = [c;] maka

[CI1=[A]+[B]

€ij = ay + by untuk setiap i dan ;.

Contoh: [A]=[2 4 3]

o -3 2
15 4 [B] = [4 5 _J

[A]+[B]=[2+0 4-3 3+2] 2 1 5
144 5+2 4-3||5 7 1
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Mengurangi [A] dengan [B] adalah sama dengan menjumlahkan [A] dengan
|-B] atau ditulis [A] - [B] = [A]+ [-Bl

Perkalian Matriks

Perkalian [A] (m x n) dengan [B] (n X p) menghasilkan [C] orde (mx p). Jadi
syarat perkalian matriks adalah jumlah kolom [A] harus sama dengan jumlah

baris [B]. Jika [A] = [a;], [B] = [b;] dan [C] = [c;] maka

i = anby; + apby + ...+ Aimbm

atau ditulis,

Contoh 1:

a, ap
[Al=|ay; ap

as  ayp

b, b
[B] = \: 1 121\
by by

a, ap b b
[Cl1=[A]x[B]=|ay &y [b” b‘z}

as Ay s
ayby, +ayby,

ayby, +ayby,

ayby, +ayby

a, b, + a;by,
ay by, +anby

ayb,; + ayby,

Contoh 2:
2 3
Al=14 1 B]= 303
[A]= BI=| ", &
7 4
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[C]=[A]x[B]=

~N AN
Ho—-= W

kM

23+3.-1 23+35 3 21
=1434+1.-1 43+15|= (11 17
73+4.~-1 73+45 17 41

Invers Matriks

Pembaglan tidak dikenal dalam operasi matriks, untuk itu digunakan inver:
n}atqks. Invers matriks hanya dikerjakan pada matriks bujur sangkar darsl
ditulis C:lengan notasi [ ]'. Perkalian dengan invers matriks sama dengan
pembaglan dalam matriks. Contoh, [A][B] =[C] di mana [A] adalah matriks
bujur sgngkar, maka persamaan tersebut dapat ditulis menjadi operasi
pembagian [B] = [A]'I[C]. [A]" disebut invers dari [A] b

Tranpose Matriks

Apal?ila [A] adalah matriks orde (m x n), maka tranpose dari [A] adalah
matriks flen.gan orde (n x m) atau ditulis dengan [A]". Baris dan kolom dari
[A] menjadi kolom dan baris dari [A]".

[B]=[A]"
b,‘j =aj,'
Contoh:
1 2 3
[A]=
] [4 5 6]
1 4
[A]'=1{2 5
3 6
72

Beberapa sifat yang berhubungan dengan transpose matriks:
(A1) =[A]

(AFB])" =[A]" + [BI'

(A1) = [B" [A"

4.2 Macro Program

Macro dengan aplikasi Visual Basic (VB) dapat dikembangkan sedemikian
rupa sehingga menjadi sebuah program penyelesaian perhitungan yang
kompatibel untuk suatu aplikasi teknik. Hal ini berbeda dengan sebuah fungsi
dalam macrosheet atau VB yang terbatas digunakan untuk menyelesaikan
tugas-tugas tertentu saja. Macro yang demikian disebut dengan macro
program atau dapat disebut dengan program saja. Tahapan-tahapan

operasinya adalah:

1. Membaca input data dari worksheet
2. Mengeksekusi input data dalam VB
3. Mencetak hasil ke worksheet

4.2.1 Membuat Macro Program

Langkah-langkah membuat macro program sama seperti membuat fungsi
pemakai, namun dengan lebih dulu menuliskan namanya. Langkah-

langkahnya dengan memilih Tools > Macro > Macros atau Run Macro
kemudian tuliskan nama program misalnya Test/ > Create hingga muncul
jendela Visual Basic Editor seperti Gambar 4.1. Setelah itu diikuti oleh
penulisan perintah-perintah di dalam prosedur Sub, sama seperti membuat
perintah untuk sebuah fungsi. Namun pembacaan data input menjadi lebih
spesifik dan mengacu pada referensi sel dari worksheet. Judul kolom
worksheet dibuat menjadi kode numerik, misalnya untuk sel yang berada
pada baris 3 kolom ke-2 (B3) menjadi Cells (3, 2) dan seterusnya.

td

73




Option Explicit

Sub Testl()

End 3ub

Gambar 4.1 Prosedur program dalam module VB

Untuk mengoperasikan macro, ada dua cara yang dapat dilakukan, yaitu:

1. Dengan Tools > Macro > Macros > Test/ > Run atau mengklik Run
Macro pada toolbar > Test/ > Run.

2. Mengklik Command Button = pada worksheet.

Cara pertama dilakukan apabila kita sudah mendefinisikan nama program.
Sedangkan cara kedua di sini dipakai hanya untuk mempersingkat langkah
pertama. Untuk mengerjakan cara kedua ini, harus dibuat dulu objek
Command Button ke dalam worksheet. Untuk itu aktifkan Control Toolbox

5 lalu pilih dengan mengklik kontrol Command Button pada Control
Toolbox dan tempatkan ke dalam worksheet dengan mengklik satu kali pada
wprksheet. Setelah jadi, klik dua kali Command Button hingga keluar jendela
Visual Basic Editor seperti di bawah ini. Program kemudian dapat ditulis di
dalam prosedur Private Sub CommandButtonl Click().

icrosoft Visual Basic - Book1 [design] - {Sheet [Code]]

uttor

| option Explicit

Private Sub CommandButtonl Click()

End Sub
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Kalimat Option Explicit yang muncul sebelum prosedur menyatakan bahwa
VB menghendaki pendeklarasian variabel lebih dahulu. Pilihan ini akan
muncul jika kita mengaktifkan Require Variable Declaration dalam Tools

> Options > Editor.

Untuk mengedit program, cara pertama dengan Run Macro > Edit.
Sedangkan cara kedua dengan mengklik dua kali Command Button pada saat
Design Mode aktif. Untuk menjalankan program dengan cara kedua adalah
dengan mengklik Command Button pada saat Design Mode tidak aktif.

4.2.2 Program Untuk Operasi Matriks

Program perhitungan yang dipakai untuk keperluan analisis dalam rekayasa
Teknik Sipil pada umumnya dibuat untuk mengerjakan operasi matriks. Oleh
karena itu, perkalian dan invers matriks adalah dua operasi utama dalam
program. Berikut ini contoh-contoh penulisan program untuk operasi
perkalian dan mencari invers matriks.

Perkalian Matriks

Dalam contoh berikut diberikan sebuah program untuk menghitung perkalian
dua matriks. Program diberi nama PerkalianMatriks1. Input data dan hasilnya
dikerjakan pada Sheetl. Tanda apostrophe (*) adalah tanda agar program
mengabaikan komentar di dalamnya. Tanda ini untuk menyisipkan penjelasan.

Sub PerkalianMatriksl ()

Dim MA(3, 2) As Double
Dim MB(2, 2) As Double
Dim MC(1 To 3, 1 To 2) As Double

"Input Komponen [A] atau MA

MA(1l, 1) = Sheetl.Cells(6, 2)
MA{(2, 1) = Sheetl.Cells(7, 2)
MA (3, 1) = Sheetl.Cells(8, 2)
MA (1, 2) = Sheetl.Cells(6, 3)
MA (2, 2) = Sheetl.Cells(7, 3)
MA(3, 2) = Sheetl.Cells(8, 3)

'Input Komponen [B] atau MB

MB(1, 1) = Sheetl.Cells(6, 5)
MB(2, 1) = Sheetl.Cells(7, 5)
MB(1l, 2) = Sheetl.Cells(6, 6)
MB(2, 2) = Sheetl.Cells(7, 6)
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:[C] = [A].[B]
ﬁgg B fﬁ& :lL; : B fMAE%, 2) * MB(2, 1)
: - . MA(2, 2) * MB(2, 1)
MC(3, 1) = MA(3, 1) * 1)+ va .
. (3, 2) * MB(2. 1)
MC(1, 2) = MA(L, 1) * 2) + MA .
. (1, 2) * MB(2. 2
ﬁgg 2) - MAE2, 1) * 2) + MA(2, 2) * MBE2 2;
. 2) = MA(3, 1) * 2) + MA(3, 2) * MB(2. 2)

Sheetl.Ran C
Fnd Sub ge(Cells (12, 2), Cells(14, 3)).FormulaArray = MC

lI{Dalam contoh ini, [A] merppunyai orde (3x2) dan [B] orde (2x2). Data input
k(c))rrﬁponen [g] dibuat dari dari range sel (6,2) hingga sel (8,3), sedangkan
p Ilnaqnen [ ] pada range sel (6,5) hingga (7,6). Soal perkalian matriks ini

iambil dari Contqh 2 dalam Bab 4.1.2. Hasil soal kemudian dicetak pada
{zjintg:k sel (.12, 2) hingga (14, 3), memakai penulisan FormulaArray = [C].
- nMacmenJila;kan program, 'langkah yang digunakan adalah Tools > Macro
i :;Is erkalianMatriks! > Run. Hasilnya seperti diperlihatkan di

A B c D E F G

1

2 |[A]= 3x2

3 |[B]= 2x2

4 [A][B]= 3x2

5

6 [Al=| 2 3 Bl=| 3

7 1 P 5
9
10_{[C] =[A][B]
11
12 [Cl=| 3 21
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Untuk matriks berukuran besar, contoh PerkalianMatriksl menjadi tidak
cfisien, karena semua operasinya dalam contoh itu dituliskan satu per satu.
Scbagai gantinya dapat dipakai perintah For ... Next untuk membaca input
data, untuk mengolah data maupun mencetak hasilnya. Cara ini banyak
menghemat penulisan program. Dalam contoh berikut ini kita akan
menghitung perkalian matriks (6x6) dengan matriks (6x3). Program diberi
nama PerkalianMatriks2. Input data dan hasilnya sekarang dikerjakan pada

Sheet2.

sub PerkalianMatriks2 ()

Dim m, n, p As Integer

m Sheet2.Cells (2, 5)

n Sheet2.Cells (3, 5)

o] Sheet2.Cells (4, 5)

ReDim MA(1 To m, 1 To n) As Double
ReDim MB(1 To n, 1 To p) As Double
ReDim MC(1 To m, 1 To p) As Double

'Baca input [A]

For II = 1 Tom
For IJ = 1 To n
MA(II, IJ) = Sheet2.Cells(5 + II, 1 + IJ)

Next IJ: Next II
'Baca input [B]

For IT = 1 To n
For I0 = 1 To p
MB(II, IJ) = Sheet2.Cells(5 + II, 9 + IJ)

Next IJ: Next II

'Perkalian Matriks
" [A] (mxn) x [B] (nxp) menghasilkan

" [C] (mxp)

For IT = 1 Tom
For IJ 1 To p
MC(II, IJ) =0

I
For IK = 1 To n
MC(II, IJ) = MC(II, IJ) + MA(II, IK) * MB(IK, IJ)

Next IK: Next IJ: Next II

‘Cetak Hasil
For IT = 1 Tom
For IJ = 1 To p
Sheet2.Cells (15 + II, 1 + IJ) = MC(ITI, 1J)

Next IJ
Next II

End Sub

Dalam program ini, pencetak an hasil dengan FormulaArray telah diganti
dengan dua perintah For ... Next. Looping pertama dan kedua masing-
masing untuk pencetakan baris dan kolom dari [C]. Dengan demikian, kita
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tidak perlu menghitung range array yang akan dihasilkan karena sudah
diketahui sebesar m x p. Selain itu, ukuran ini dapat diubah-ubah berdasarkan
nilai yang akan dimasukkan ke dalam program. Array yang demikian disebut
array dinamis, dan didefinisikan dengan statement ReDim. Sedangkan array
yang statis adalah array yang ukurannya sudah ditetapkan pada awal program
dan didefinisikan dengan statement Dim.

Perkalian matriks juga dapat dikerjakan di dalam spreadsheet dengan fungsi
MMULT(arrayl,array2). Untuk contoh PerkalianMatriks2, formulanya
adalah =MMULT(B6:G11,J6:L11). Untuk mencetak komponen-komponen
hasil perkalian digunakan fungsi Indeks. Misalnya untuk mencetak
komponen [Cs3] formulanya adalah =INDEX(MMULT(B6:G11,J6:L11),5,3)
dan seterusnya.

Invers Matriks

Ada beberapa metode untuk mencari invers dari'tr.latrlk.s, salah ?21?3
dengan metode Gauss-Jordan. Sebenarnya metodg ini lqblh umum di eaan
scbagai eliminasi Gauss-Jordan dalam menyglesalkan s1st§rrL n pelrsanll(ah_
linear dengan n bilangan yang tidak diketahui. Secara gars ezaﬁ };ml% an
langkahnya dengan menempatkan mat.riks satuan [ I ] di se ela rSadari
matriks yang akan dicari invers-nya. Misalnya [ F .] adala.h su::titu 1inve s dari
|A], maka melalui operasi penjumlahan d_an perkalian baris ?ad.a I?m;;) oner:
komponen [A] dan [ I ], [A] akan menjadi [ 1] dan [I]menjadi[F].

ini dapat dinyatakan dengan:

[A:I]>[I:F] dirnana[F]=[A]'1

i ii iks dapat dilihat di bawah ini.
Penulisan program untuk mencari invers matriks (
Sebagai contoh kita ambil data [A] dari PerkalianMatriks2. Input data dan

hasilnya dikerjakan pada lembar yang sama pada Sheet2.

Sub INVERS({)

'Baca input data
m = Cells (2, 5)
ReDim MA(1 To m,

1 To m) As Double

A Bl]C|D|E|F |G |H|I1]|J]|Kk]|L

p

2 [A] = mxn m =

3 [B] = nxp n=

4 [Cl=_ |mxp p=

5

6 Al=| 20 | 5 0] o B]=/025| 0 | o
“‘ 7 5 | 20 0| o 0.25| 1 0
| 8 0 |03 ]10]0]0 050 110
;‘11‘ 9 0010300 050, 0 | 1
10 0] o0 0 |12] & 025 0 | 1
‘w‘ 11 oo 0o | 6 |12 025| 0 | o
; 12

13
i 14 |[C] =[AL[B]
| 15
o 16 [c1=l6.25] 5 | o
“ 17 6.25| 20 | 0
| 18 20 | 30 | 10
19 -20 | 10 | 30
“ 20 45 12
| 21 4.5 6
| 22
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For II = 1 Tom

For IJ = 1 Tom

MA(II, IJ) = Sheet2.Cells(5 + II, 1 + 1J)
Next IJ

Next II

‘Mencari Invers Matriks Dengan Metode Gauss-Jordan :
For IT = 1 Tom
For IJ = 1 Tom
If IJ <> II Then MA(IT, IJ) = MA(II, IJ)
Next IJ
For IK = 1 Tom
If IK = II Then GoTo 10
For IJ = 1 Tom
If IJ <> IT Then MA(IK, IJ) = MA(IK, IJ)
MA(IK, II)
Next IJ
10 Next IK
For IK = 1 Tom

/ MA(II, II)

- MA(II, IJ) *

Tf IK <> II Then MA(IK, II) = -MA(IK, II) / MA(II, 11)
Next IK

MA(II, II) = 1 / MA(II, II)

Next II

‘Cetak Hasil
For IT = 1 tom
For IJ = 1 tom
Sheet2.Cells (15 + II, 6 + IJ) = MA(II, IJ)
Next IJ
Next IT
End Sub
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) A B Cc D E F G H | J K L
2 [A] = mxn m= 6

3 [B] = nxp n= 6

4 [C]= mxp p= 3

5

6 [Al=| 20 5 0 0 0 0 [B]={ 025 | 0 0
7 5 20 0 0 0 0 025 | 1 0
8 0 0 30 | 10 0 0 050 1 0
9 0 0 10 | 30 0 0 -050| 0 1
::) 0 0 0 12 6 025 | o 1
” 0 0 0 0 6 12 025 | 0 0
13

14 |IC] =[AL[B]

15

16 [C]=|625| 5 0 [AI'= |0.053]-0.01! 0 0] 0 0
11; 6.25] 20 0 -0.01/0.053| 0 0 0 0
” :zg ?2 :13;) 0 0 j0.038/-0.01] o 0
” 2 0 0 |-0.01j0.038] 0o 0
. 4:5 (()) 162 0 0 0 0 10.111/-0.06
” 0 0 0 0 |-0.06 |0.111

iSne‘fzi:h[ A{)]r(()ﬁgtram clgalankgn, isi Sheet2 akan tampak seperti di atas. Hasil
ny empatkan pada range sel (G16 : L21). Untuk ika i
ini adalah sebuah invers, maka hasil k i (At [ ———
seb \ ali [A]" dengan [C] h =
Cobalah dlpepksa dengan fungsi MMULT. Mencari inveErs ]ma?::il;(ss daEB].
spreadsheet juga dapat dilakukan dengan fungsi MINVERSE Cam
menggunakan fungsi ini sama seperti MMULT. S

423 Tip

Pada operasi macro program cara pertama, Anda dapat berpindah-pindah dari
workshc?et ke jendela VB atayq%sebaliknya dengan mengklik icon Excel
atau Visual Basic Editor &1 seperti diperlihatkan pada Gambar 4.2Y
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Scdangkan apabila cara kedua yang dipakai, Anda harus mengaktifkan

Design Mode kemudian mengklik dua kali pada Command Button untuk
ke jendela VB. Untuk menjalankan program, matikan Design Mode (Exit
Design Mode) kemudian klik sekali pada Command Button.

Ke VB Ke Excel

| Basic - Book1 - [Modulel (Codel}

Microsoft ¥i

Option Expliecirt

| Sub Testlf)

| End Sub

Gambar 4.2 Shortcut perpindahan antara worksheet dan jendela VB

Perpindahan dari worksheet ke jendela VB dan sebaliknya adalah hal yang
akan sering dilakukan jika Anda mendesain sebuah program. Hal ini
digunakan untuk menelusuri langkah-langkah program, misalnya pada setiap
operasi perhitungan. Sebenarnya untuk mempercepat proses perpindahan ini
adalah dengan menempatkan worksheet dan jendela VB pada satu layar,
seperti tampak di monitor pada Gambar 4.3. Dengan demikian, apabila
program dijalankan, interaksinya dengan worksheet dapat dilihat secara
bersamaan. Berikut langkah-langkah untuk menempatkan worksheet dan
jendela VB dalam satu layar dan sebuah tip yang dapat Anda gunakan

sesudahnya.

1. Dalam worksheet klik icon Restore gj, kemudian drag lembar ini ke kiri
dan tempatkan kira-kira setengah ukuran layar monitor.

2. Kemudian pindah ke jendela VB, dengan cara yang sama tempatkan ke
sebelah kanan layar monitor. Sekarang Anda sudah mendapatkan kedua
jendela ini secara bersamaan.

3. Untuk ke baris program yang dikehendaki, tempatkan kursor dan tekan
Ctrl+F8, maka program akan berpindah ke baris tersebut yang ditandai
dengan wamna kuning (default). Tekan F8 untuk meneruskan operasi
program.

4. Hasil operasi yang tidak dicetak dapat dilihat nilainya dengan

menempelkan pointer pada salah variabel program, misalnya pada satu
variabel matriks seperti yang diperlihatkan Gambar 4.4. Tahan pointer
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sebentar hingga muncul nilainya. Nilai ini menunjukkan nilai sel dari
worksheet di sebelah kiri.

Dengan langkah 1 dan 2, perpindahan antar worksheet — jendela VB cukup
dengan mengklik satu lembar tanpa kehilangan lembar lainnya. Ini akan
sangat membantu apabila Anda ingin menjalankan program sekaligus melihat
hasilnya. Untuk menjalankan program dari awal, tekan F8 kemudian tekan
lagi F8 untuk melanjutkan ke baris berikutnya.

Langkah-langkah di atas juga sangat membantu dalam mengembangkan alur
program dan memperbaiki kesalahan penulisan program. Salah satu bentuk
kesalahan yang mungkin terjadi adalah tidak cocoknya dimensi array suatu
variabel dengan statement yang dibuat sehingga waktu program dijalankan,
VB mengeluarkan kotak pesan error “subscript out of range”. Misalnya
dalam suatu pengulangan (looping) di mana prosesnya melebihi subscript
yang ditetapkan. Untuk menuju lokasi di mana terjadi kesalahan, klik Debug

dan Reset - ® untuk menghentikan jalannya program.

[FET Microsoft Excel - Babd

PerkalianMatriks

Sub PerkalianMatriksz{)

Dim m, n, p As Integer
m = Sheet2.Cells(2, S}
n = SheetZ.Cell=(3, 5)
p = Sheet2.Cells{4, 5)
ReDim MA(1 To m, 1 To n} 4s Double
ReDim MB{1 To n, 1, To p) is Double
ReDim MC(1 To m, 1 To p) As Double

fBaca auput (&)

For IT = 1 Tom

For I0 = 1 To n

MA(II, 1J) = Sheet2.Cells(5 + II, 1 +
Next IJ: Next II

TBacE iuput [§)

For IT = 1 To n

For I0 =1 To p

MB(II, IJ) = Sheet2.Cells(5 + II, 9 +
Next IJ: Next II

rtan Hatrike o

Gambar 4.3 Penempatan worksheet dan jendela VB dalam satu layar
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Sub PerkalianMatriksZ ()

Dim w, n, p As Integer

= Sheetz.Cellsi2, 5)
n = SheetZ.Cells ({3, 5]

= Sheet2.Cells (4, 5]
ReDim MA(1 To m, 1 To n) As Double
ReDim ME(1 To n, 1 To p) As Double
ReDim MC(1 To m, 1 To p)} i4s Double

Fhaos dnpuat (A

For IT = 1 To m

For IJ = 1 To n

MA(II, IJ) = Sheet2.Cells(5 + II, 1 + LJ}
Next IJ: N[Sheet2.Cels(5 +11. 1 +1J)=20]

fRBaca input [B]

For II = 1 To n

For IJ0 = 1 To p

MB(II, IJ) = Sheet2.Cells(5 + II, 9 + IJ}

Gambar 4.4 Melihat nilai variabel program dengan pointer

4.3 Metode Matriks Untuk Analisis Struktur

Struktur pada umumnya merupakan suatu rangkaian elemen struktur yang
saling terhubung satu sama lain pada titik-titik diskritnya .(nodal-nodalnya).
Penyelesaian untuk sistem rangkaian elemen ini dapat dinyatakan dengan
susunan persamaan linear simultan yang dibuat dalam ‘bentuk matriks.
Dengan bentuk matriks, perhitungan struktur menjadi mudah untuk
diselesaikan dengan bantuan komputer.

4.3.1 Struktur Atas

Metode yang akan dipakai untuk analisis struktur adalah dengaq metode
kekakuan. Sedikit pengenalan mengenai dasar-dasar metode ini akan
dijelaskan di sini, pembaca dianjurkan membaca pada referensi lain untuk
melengkapi pembahasan pada topik ini. Pada dasarnya, dengal.l metode
kekakuan, kita mencari hubungan gaya—lendutan struktur yang dinyatakan

sebagai berikut.
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L e

{P} = [K]{X} @.1) (PYi= {Po} + [KIi{X}i (4.5)
di mana:

{P,}  adalah reaksi-reaksi di ujung elemen akibat beban yang langsung
diterima oleh elemen tersebut

[K]i  matriks kekakuan lokal elemen

{X}i  matriks deformasi elemen = [Tli{Xs}

[T matriks transformasi elemen

I di mana:

1\“‘1 {P}  matriks vektor gaya-gaya luar yang bekerja di nodal
\‘ ‘1 [K] matriks kekakuan dari struktur
i {X} matriks vektor lendutan di nodal

1 Dengan‘menurunkan [K], dapat diperoleh hubungan gaya-lendutan seperti

yang dinyatakan oleh Persamaan 4.1. Pada prosesnya di sini adalah
menurunkan matriks kekakuan dari satu elemen, yang kemudian dipakai
", untuk elemen lainnya yang sama dan disatukan membentuk matriks
i kekakuan struktur. Untuk memenuhi kontinuitas deformasi pada eclemen-
m elemennya adalah dengan mensuperposisikan vektor-vektor yang sesuai.

Untuk mencari reaksi perletakan, dapat langsung ditinjau dalam koordinat
struktur dengan menggunakan Persamaan 4.4 menjadi:

Selapjutnya untuk menyederhanakan perhitungan, dilakukan partisi atau (Roj P} = Bl
pemisahan komponen matriks dari hubungan gaya—lendutan, yaitu di nodal atau

yang beba§ dan di perletakan. Hal ini karena lendutan di perletakan umumnya ’
= 0. Apabila X;, menyatakan vektor lendutan di perletakan, X; adalah di nodal
yang bebas, Py dan Py, adalah vektor gaya luar yang koresponding dengan
lendutannya, maka Persamaan 4.1 dapat ditulis sebagai berikut:

{5} Ky | Ky || X,
R] [ Ky 1 Ky |4X, 4.2)

Apabila vektor lendutan nodal perletakan {X,} = 0, Persamaan 4.2 dapat

{Ro}= Kol {X5} — {Po} (4.6)

4.3.2 Struktur Bawah

Analisis struktur di sini adalah mencari hubungan gaya—lendutan pada
struktur yang berinteraksi langsung dengan tanah. Pada umumnya dikerjakan
dengan metode finite element. Metode ini banyak dipakai karena lebih efisien
dalam hal memberikan informasi dari hasil analisisnya dibandingkan dengan
metode-metode yang klasik, terutama apabila dikerjakan pada struktur-

ditulis menjadi:
struktur yang besar atau pada model struktur yang spesifik. Dalam metode
{Pr} = [Kee] { X7} (4.3) finite element, sistem struktur adalah rangkaian yang dibangun dari sejumlah
. finite element, di mana satu dengan lainnya terhubung hanya pada nodal-
dan, nodalnya.
{Po} = [Kug] (X5} Beberapa persamaan dibuat untuk mencari hubungan gaya—lendutan di nodal,
44 dimulai dengan mencari hubungan antara gaya-gaya luar di nodal {P} dengan

Vek‘for'lendutan di nodal bebas kemudian diperoleh dari Persamaan 4.3
menjad1. {Xﬁ = [Kff]_I{Pf}. Setelah {X;} diketahui, gaya-gaya dalam elemen
dapat.dlcan. Di sini gaya-gaya dalam elemen ditinjau dalam koordinat lokal
dan diperoleh melalui persamaan berikut ini. ’
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gaya-gaya dalam elemen {F} berdasarkan prinsip kesetimbangan.

Hubungan P dan F dinyatakan sebagai:

(P} =[AHF} 4.7

Hubungan lendutan (nodal) X dan deformasi (elemen) d adalah:

{d} = [B]{X}, dan dapat dibuktikan {d} = [A]T (X} 4.8)
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Dari sifat elastis elemen, hubungan F dan d dinyatakan:

{F}y =[SHd} (4.9)
Subsitusi Persamaan 4.8 ke 4.9 mendapatkan,

{F} = [S]{d} = [SI[AT" (X} (4.10)
Subsitusi Persamaan 4.10 ke 4.7 mendapatkan,

{P} =[AJ{F} = [A]S][AT" () @.11)
{X} adalah lendutan yang hendak dicari, maka:

X} =((AIS)AT" ) {P) (4.12)
Subsitusi {X} kembali ke Persamaan 4.10 untuk mencari gaya dalam {F}.

Persamaan.4..10, 4.11 dan 4.12 ini adalah persamaan-persamaan fundamental
dalam analisis dengan metode finite element (Bowles, 1982).
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PROGRAM EXCEL UNTUK
REKAYASA TEKNIK SIPIL

Materi program yang diberikan di sini terdiri atas beberapa program untuk
analisis struktur atas dan struktur bawah. Juga ditambah satu program untuk
penyelesaian konsolidasi tanah. Metode yang dipakai untuk analisis struktur
adalah metode seperti yang sudah dijelaskan pada Subbab 4.3. Diharapkan
referensi-referensi ini akan saling melengkapi dan dapat dijadikan sebagai
pengetahuan dasar bagi pembaca untuk membuat sebuah program
penyelesaian. Harap dibedakan tujuan pemrograman di Excel dengan tujuan
pemrograman yang membangun suatu program aplikasi sendiri. Dengan
Excel berarti program secara keseluruhan menjadi lebih mudah dan praktis,
sebab hanya dibuat kasus per kasus. Setiap kasus dikemas sedemikian rupa
dengan memanfaatkan fasilitas dalam worksheet kemudian dipresentasikan
seperti halnya dalam membuat laporan secara teknis. Ini sesuai dengan

hakekat bekerja dengan Excel.

5.1 Struktur Frame Balok

Contoh:

Frame sederhana, dengan panjang elemen masing-masing 4 m. Kekakuan
elemen BC adalah 2 kali kekakuan elemen AB atau CD. Titik B dan C adalah
nodal bebas, masing-masing terdiri atas 3 komponen lendutan.
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1ton

q=0.6 ton/m'

B T ©

0.5 ton —
2 ElI j

40m EI EI 40m

Semua elemen balok terbuat dari material elastis linear yang sama dengan
modulus elastisitas, £ = 2.1 x 10° ton/m?.

Dimensi elemen AB = BC = CD =30 cm.

Beban luar yang diketahui adalah:

Beban H pada nodal B = 0.5 ton.

Beban V pada nodal C = 1 ton.

Beban merata g pada elemen BC = 0.6 ton/m’.

Beban merata ¢ menjadi vektor gaya-gaya luar yang ekuivalen di nodal B
dan C:

(Lihat Gambar 5.1.)
Preowy = - Pepay = 1/12.q.L2 =-0.8 ton.m.
Pgyy= Py =- %.q.L=-1.2ton.

8
| > A C arah vektor
B 4 7 gaya-lendutan positif (+)

Gambar 5.1 Vektor gaya-lendutan di nodal dalam
sistem koordinat struktur (global)

2 5
B C
3 6
4
5 2
7 B /
6 3 h
1
2 A B_’S
37. 2,

Gambar 5.2 Vektor gaya-lendutan elemen dalam sistem koordinat lokal
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Gambar 5.3 Vektor gaya-lendutan elemen yang sesuai dengan

sistem koordinat global

Tahapan Analisis Frame

Matriks kekakuan untuk elemen balok diturunkan sebagai berikut.

6EI
Nz
2E1
7

_E4

(5.1)

2. Matriks transformasi vektor dari koordinat elemen lokal ke koordinat

\
|
global adalah:
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Untuk 6 komponen vektor gaya-lendutan setiap elemen,

B aBC =0 C

o CD = 270°
5 @

Ai a AB = 90° 5

[ cosa sina 0 0 0 0
—sina cosa 0O 0 0 0
. 0 0 1 0 0 o0
[Tli= . (5.2)
0 0 0 cosa sina O
0 0 0 -sina cosa O
Y 0 0 0 0 I
Matriks kekakuan elemen pada sistem koordinat global,
(5.3)

[K]s = [Tl [K]i[T]i

Matriks kekakuan elemen kemudian disuperposisikan dengan kekakuan
elemen lainnya, yang secara keseluruhan membentuk matriks kekakuan

[K]global struktur.

Superposisi [K]s > [K]global 5.4

Lendutan di nodal bebas dihitung berdasarkan Persamaan 4.3, menjadi:

(X} = [Kel] " {Pg} (5.5)
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'4ﬁ—_________—______—_————————-————————————-—---‘--_________________________,4,

Gaya-gaya dalam setiap elemen dapat dicari dengan mentransformasikan
lebih dulu lendutan dari koordinat global kembali ke koordinat elemen
(lokal),

{31 =[Ti{X}

Setelah mendapatkan lendutan elemen {X}i, maka gaya dalam elemen
dapat diperoleh melalui Persamaan 4.5:

{Pyi={Po} + [K]i{X}i (5.6)
4. Reaksi perletakan kemudian dapat dihitung dari Persamaan 4.6,

{Ro} = [Koe] { X5} — {Py} (5.7)

Dari urutan proses di atas kemudian dibuatkan program sederhana untuk
analisis struktur frame yang diberi nama FRAME2D.

Pemrograman

Dalam membuat program formula matriks, yang harus dikuasai tentunya cara
bagaimana merancang-bangun matriks. Dalam hal ini adalah bagaimana
membuat variabel-variabel persamaan seperti pada Persamaan 5.3 sampai
577. Ada beberapa hal dalam penulisan program yang sebenarnya
memerlukan sedikit imajinasi dan kreatifitas dari penulisnya. Hal pertama
misalnya, bagaimana merancang [K]global. Di sini diperlukan manipulasi
langkah, agar [K]elemen dapat ditempatkan pada posisinya di dalam
[K]global. Cara yang dipakai adalah dengan membuat sebuah variabel
integer, yaitu Indexs untuk menyamakan subskripnya. Indexs membaca
penomoran yang dipakai untuk elemen dalam sistem koordinat global dan
dijadikan sebagai subskrip [K]global sekaligus kemudian melakukan
superposisinya. Programnya sebagai berikut.

'Mengosongkan [K]Global
For IT = 1 To NP

For IJ = 1 To NP

GK(II, IJ) = 0

Next IJ

Next II
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‘subskrip [Klelemen pada [K]global
tor II = 1 To NM
For IJ = 1 To 6

indexs (IJ, II) = Cells(10 + II, 1 + IJ)

Next IJ

Next II

for IT = 1 To NM

tor IJ = 1 To 2

éiilige;s%lg? i1y, Indexs (IK, 1)) = GK (Indexs (IJ, I1),
Indexs (IK, II)) + P2(IJ, IK, II)

Next IK

Next IJ

Next IT

Hal yang kedua adalah untuk melakukan partisi (pemisahan) rpatriks untuk
membentuk [Kg] dan [Ke. Langkah-langkah ini pun dgpat dibuat dengan
cara membuat variabel integer, yaitu Index untuk partisi [Kg] dan SupM

untuk partisi [Kys].

‘Partisi [GK]--->[GKP]

For II = 1 To DOF

Index(IT, 1) = Cells(7, 2 + II)
Next II
For II = 1 To DOF
IJ = 1 To DOF
gg;(Index(II, 1), Index(IJ, 1)) = GK(Index(II, 1), Index(IJ, 1))
GKP(II, IJ) = GKP(Index(II, 1), Index(IJ, 1))
Next IJ
Next II

'Mencari reaksi perletakan
‘Melakukan partisi pada perletakan

For II = 1 To 6

SupM(II, 1) = Cells(8, 1 + I1)

Next II

For II = 1 To DOF

For IJ = 1 To 6

GKS(IJ, II) = GK(SupM(IJ, 1), Index(II, 1))
Next IJ

Next IT

isti dilibat pada bagian akhir
Listing program FRAME2D selengkapnya dapat lihat
buku %mp Data input dan output untuk soal frame dlperh-hatkan dalam fom
FRAME2D pada Gambar 5.4. Berikut ini hasil perhitungan dari setiap

tahapan analisis frame.
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Elemen AB

[K] (matriks kekakuan elemen)

47250.00 0.00 0.00 -47250.00 0.00 0.00
0.00 265.78 531.56 0.00 -265.78 531.56
0.00 531.56 1417.50 0.00 -531.56 708.75

-47250.00 0.00 0.00 47250.00 0.00 0.00
0.00 -265.78 -5631.56 0.00 265.78 -531.56
0.00 531.56 708.75 0.00 -5631.56 1417.50

[T] (matriks transformasi vektor dari koordinat lokal ke koordinat global)

0.00 1.00 0.00 0.00 0.00 0.00
-1.00 0.00 0.00 0.00 0.00 0.00
0.00 0.00 1.00 0.00 0.00 0.00
0.00 0.00 0.00 0.00 1.00 0.00
0.00 0.00 0.00 -1.00 0.00 0.00
0.00 0.00 0.00 0.00 0.00 1.00

[K]s = [TIi"[KJi[T]i

(matriks kekakuan elemen dalam koordinat global)

265.78 0.00 -531.56 -265.78 0.00 -531.56
0.00 47250.00 0.00 0.00 -47250.00 0.00
-5631.56 0.00 1417.50 531.56 0.00 708.75
-265.78 0.00 531.56 265.78 0.00 531.56
0.00 -47250.00 0.00 0.00 47250.00 0.00
-531.56 0.00 708.75 531.56 0.00 1417.50
94

Elemen BC
K]

59850.00 0.00 0.00 -59850.00 0.00 0.00
0.00 540.15 1080.29 0.00 -540.15 1080.29
0.00 1080.29 2880.78 0.00 -1080.29 1440.39

-59850.00 0.00 0.00 59850.00 0.00 0.00
0.00 -540.15 -1080.29 0.00 540.15 -1080.29
0.00 1080.29 1440.39 0.00 -1080.29 2880.78

[T]
1.00 0.00 0.00 0.00 0.00 0.00
0.00 1.00 0.00 0.00 0.00 0.00
0.00 0.00 1.00 0.00 0.00 0.00
0.00 0.00 0.00 1.00 0.00 0.00
0.00 0.00 0.00 0.00 1.00 0.00
0.00 0.00 0.00 0.00 0.00 1.00
[Kls
59850.00 0.00 0.00 -59850.00 0.00 0.00
0.00 540.15 1080.29 0.00 -540.15 1080.29
0.00 1080.29 2880.78 0.00 -1080.29 1440.39
-59850.00 0.00 0.00 59850.00 0.00 0.00
0.00 -540.15 -1080.29 0.00 540.15 -1080.29
0.00 1080.29 1440.39 0.00 -1080.29 2880.78
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Partisi di nodal bebas 2 [Kg]

T

Persamaan 5.7. Hasil program dipresentasikan dalam form input-ouput

4 5 6 7 8 9
4 | 6011578 | 0.00 531.56 | -59850.00 | 0.00 0.00
5 0.00 47790.15 | 1080.29 0.00 -540.15 1080.29
6 531.56 1080.29 4298.28 0.00 -1080.29 | 1440.39
7 | -59850.00 | 0.00 0.00 | 6011578 | 0.00 531.56
8 0.00 -540.15 | -1080.29 0.00 47790.15 | -1080.29
9 0.00 1080.29 1440.39 531.56 -1080.29 | 4298.28
Partisi di nodal perletakan = [Ky]
4 5 6 7 8 9
-265.78 0.00 -531.56 0.00 0.00 0.00
0.00 -47250.00 0.00 0.00 0.00 0.00
531.56 0.00 708.75 0.00 0.00 0.00
10 0.00 0.00 0.00 -265.78 0.00 | -531.56
11 0.00 0.00 0.00 0.00 | -47250.00| 0.00
12 0.00 0.00 0.00 531.56 0.00 708.75
0.00000
0.00000
0.00000
0.00117
—0.00002
Lendutan di nodal bebas: {X¢} = { 0.00039
0.00117
—0.00005
0.00017
0.00000
0.00000
0.00000

Setelah mendapatkan {X;}, gaya-gaya dalam elemen dapat dihitung melalui

Persamaan perletakan  kemudian
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(5.6).

Reaksi

dihitung  dengan

FRAME2D pada Gambar 5.4.

3 4 ] 3 8 .

i z 3 [ 1 12

NPy = NP3 HP4 NP5 NP6 | LENGTH | WIDTH | INERTIA | AREA a
1 2 3 4 5 3 4.00 0300 0.00068 0.09 90,0
4 5 8 7 8 9 400 0.380 0.00137 011 00
7 5 3 10 11 12 480 0.500] _0.00068 003] 2700
_Global P-X . .. Local P-X. . N T
FORE < SO DU S MEMNO NPT NP2 NP3 NP4 NPS . NPE

00 0.00000: o 097021 0.40176 034308 097021 010176 008367 o
0.0 000000 2 03924 022079 086367, 039824 022979 005548
00, 000000 ) 37 a42979 039824 08THAE 242079 (039824 073749

05 000117 : | .

Sz 000002 : -

0% -000033 ... Support Reaction & . . . . RO S

Lop ooon7 b BL B2 RS Re . RS P8
22 oponos. U nioize | 097021 034336 039624 242979 073749
08 000017 ) :

Do 000000

.00 000000
00 0.00000

Gambar 5.4 Form input dan output FRAME2D

Keterangan:

1.

NP: jumlah komponen vektor gaya-lendutan, NM: jumlah elemen, Ec:
modulus elastis bahan, o: sudut transformasi elemen.

DOF: degree of freedom atau derajat kebebasan struktur. Dalam form
penulisannya dibuat berurut, yaitu jumlah DOF (input) adalah 6, yaitu
pada komponen vektor 4, 5, 6,7, 8 dan 9.

Nodal perletakan (input) adalah pada komponen vektor 1, 2, 3, 10, 11,
dan 12.

Nomor member (MEMNO) 1, 2, dan 3 berturut-turut adalah elemen AB,
BC, dan CD.

Hasil gaya untuk elemen BC

dijumlahkan dengan {P,}. Hasi
diperoleh menurut Persamaan 5.6:

(MEMNO 2) dalam FORM2D belum
1 akhir untuk gaya dalam elemen
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NP1 = 0.39824, NP2 = -0.22979 + (+1.2), NP3 = -0.86367 + (+0.8),
NP4 =-0.39824, NP5 =0.22979 + (+1.2), NP6 = -0.05548 + (-0.8).

Sebenarnya matriks elemen {P,} dapat dibuat programnya (berdasarkan
Jenis hubungan elemen, jenis beban, eksentrisitas beban dan sebagainya),
namun hal ini akan memperbanyak penulisan data input. Oleh karena itu
lebih baik (praktis) untuk dihitung terpisah. Anda dapat memanfaatkan
ruang kosong dalam form input untuk menuliskan besarnya {P,},
kemudian ditambahkan ke dalam operasi program, schingga output
FRAME2D nantinya sudah merupakan hasil akhir.

Salah satu kemudahan membuat program di dalam Excel adalah untuk hal-
hal yang sifatnya administratif, seperti form input dan outputnya dapat
dikerjakan di dalam worksheet. Jadi kita tidak menemui kesulitan dalam
mengatur tata letak, menambahkan teks, mengatur format tampilan, dan
sebagainya. Hal ini juga ditunjang dengan fungsi-fungsi built-in dalam
worksheet hingga fasilitas untuk penggambaran grafik. Ada kalanya beberapa
operasi perhitungan atau pun subprogram dikerjakan di dalam worksheet,
kemudian dipanggil dan diolah oleh VBA.

5.2 Struktur Rangka Batang

Elemen batang dalam rangka batang (truss) dianalisis dengan menganggap
pada elemen hanya bekerja gaya aksial saja. Dengan demikian setiap elemen
batang mempunyai 2 komponen vektor yang bebas di ujung-ujungnya.
Rangka batang ini umumnya terbuat dari bahan baja di mana satu sama lain
terhubung sebagai sendi.

Matriks kekakuan elemen batang diturunkan sebagai berikut:

ﬂ 0 _A_E 0
6 0 OL 0
[K]i=
L L
0 0 0 0
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Matriks transformasi elemen batang ke koordinat global adalah:

cosa sing 0 0

. —sina cosa 0 0
[Thi= 0 0 cosa sina
0 0 —sina cosa

Persamaan matriks kekakuan elemen dalam sistem koordinat global adalah:

[K]si= [Tl KJ[Tl (5.8)

i i isi -komponen vektor yang
K]s kemudian disuperposisikan pada komponen _
ges]zai untuk mendapatkan [K]global. Gaya dalam dan reaksi per.le.takan dapat
dihitung melalui Persamaan 4.2, yaitu dengan mengadakan partisi komponen
matriks di nodal bebas dan nodal perletakan.

Contoh:

Pada soal berikut ini kita mengerjakan langkah demi langkah program untuk
menyelesaikan analisis rangka batang berikut cara-cara yang dlpgka}. Denlgan
demikian akan lebih mudah disampaikan hal-hal yang prinsip da ani
penulisan program di Excel. Bagian ini juga melengkapi penjelasan pada soa
FRAME2D sebelumnya.

Contoh soal diperlihatkan dalam Gambar 5.5, berikut sistem penomorannya
dalam Gambar 5.6 sampai Gambar 5.8. Setiap elemen batang tg:rbuat {1ar1
material elastis linear yang sama dengan E = 2100000 kg/cm” dan luas

penampang 4 = 68.4 cm’. |
Struktur rangka batang secara keseluruhan hanya mempunyai 2 derajat

kebebasan (DOF), pada komponen vektor 3 dan 4. S_edz}ngkan pada ke(liug
perletakannya tidak ada komponen vektor yang bebas, jadi tidak ada translasi

sama sekali.
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20 ton

10 ton

40m

A Y
/20 Cc
L&‘ 3.0m 3.0m ‘_Z_;L LX

Gambar 5.5 Geometri dan pembebanan pada rangka batang

Gambar 5.7 Vektor gaya-lendutan elemen batang dalam
sistem koordinat lokal -

Gambar 5.6 Vektor gaya-lendutan di nodal dalam sistem koordinat global

102

Gambar 5.8 Vektor gaya-lendutan elemen batang yang sesuai dengan
sistem koordinat global
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44~——————————————————————————————-‘-p------—-———————_-___________'447

lS;eEellcllllm masuk ke dalam langkah pertama, kita bangun dulu matriks

uz u?k an le.:lci:men gdl:m matriks transformasinya, yaitu [K] dan [T) Program
. analisis rangka batang ini dimodifikasi dari .

dinamakan menjadi TRUSS. + ot progiam FRAMED dan

'Bangun [T] Elemen

RAD = 180 / 3.14159265358979
For II = 1 To NM

T(1, 1, II1) = Cos (ALPHA(IT

. . 1 :

i%ﬂmﬁmﬂl,l)/RMM:Tu,B,Iﬁ Jof%2'4T?ﬂ }b s

T2, 1 ID - -Sin(ALPHA(IT, 1) / RAD): T(2, 2

T?i(Ang?£§I’ 1) / RAD): T(2, 3, I1) - 0: T(2, 4, 11) —0o )
.1, = 0: T(3, 2, 1I) = 0: T(3, 3, 11) - L

4(?13)1: TI(I3) 4'0II)(Z Sin(ALPHA (1T, 1) / ’RAD)) - Cos(ALPHAMIL, 1)
.1, = 0: T(4, 2, ITI) = 0+ T(4, 3 j

1) ) RAD): T(a - : , , II) = ~Sin(ALPHA(II,

Next TT (4, 4, 1II) = Cos (ALPHA(II, 1) / RAD)

'Bangun [K] Elemen

For IT = 1 To NM

MK(1, 1, II) = A(II, 1 *
3, 1h L s N ) Ec / L(II, 1): MK(1l, 2, II) = 0: MK(1,
ﬁ;(é LgII, 1): MK(1, 4, II) =0

, , II) = 0: = :
il MK(2, 2, II) = 0: MK(2, 3, II) = 0: MK (2, 4,
MK (3, 1, II) = -A(II, 1) *
MK(3. 3, 11) < A(Lr 13 *) Ec / L(II, 1): MK(3, 2, II) = 0:
E;(é LiII, 1): MK(3, 4, II) = 0

, , II) = 0: M = :
g K(4, 2, II) = 0: MK(4, 3, II) = 0: MK (4, 4,
Next II
Catatan:

Setiap matriks elemen mem i tiga i i

punyai tiga indeks di dalamnya; indeks
pertama dap kedua rpenyatakan subskrip baris dan kolom da}ll'i matriks
sedangkan indeks ketiga menyatakan matriks untuk elemen ke-i. ’

Langkah pertama dalam analisis ran

gka batang adalah mencari matriks
gekakuan elemen AB, AC, dan BC dalam koordinat global berdasarkan
ersamaan 5.8. Programnya sebagai berikut.

'Transpose [T]--->[TT]elemen
For II = 1 To NM

For IJ = 1 To 4

For IK = 1 To 4

TT(IJ, IK, II) = T(IK, I

Next IK ' Tt
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Next IJ
Next II

‘Bangun [Klelemen = [TT].[K]elemen. [T]

For IT = 1 To NM

For IJ = 1 To 4

For IK = 1 To 4

P1(1J, IK, II) =0

For IL = 1 To 4

P1(1J, IK, II) - P1(1IJ, IK, II1) + TT(IJ, IL, II) * MK(IL, IK,
II)

Next IL

Next IK

Next IJ

For IJ = 1 To 4

For IK = 1 To 4

P2(IJ, IK, II) =0

For IL = 1 To 4

p2 (17, IK, II) = P2(IJ, IK, II) + P1(IJ, IL, II) * T(IL, IK, II)
Next IL

Next IK

Next IJ

Next II

Catatan:

Membuat matriks transpose adalah dengan membuat subkrip baris
menjadi subskrip kolom, dan sebaliknya. Jadi transpose T(1J, IK, II) =
T(IK, 1J, II). Untuk perkalian tiga matriks, perlu dibuat variabel baru,
yaitu P1 dan P2. P2 adalah matriks kekakuan elemen yang merupakan

hasil akhir perkalian tiga matriks.

Langkah berikutnya melakukan superposisi [K]AB, [K]AC, dan [K]BC pada
komponen-komponen vektor yang sesuai. Dalam form input sudah dibuat
nomor vektor tersebut yang mengikuti sistem penomoran struktur pada
contoh soal. Form input soal diperlihatkan pada Gambar 5.9. Sekarang
diperlukan manipulasi langkah program untuk menempatkan komponen-

komponen [K]elemen pada [K]global.

MEMNO | NP1 NP2 NP3 NP4
1 1
2 1 2 5 €
3 3 4 5

Gambar 5.9 Form input penomoran vektor gaya-lendutan elemen batang
dengan sistem koordinat global
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'Bangun [K]global

For IT = 1 To NP
For IJ = 1 To NP
GK(II, IJ) = 0
Next IJ

Next II

'Subskrip [K]lelemen pada [Klglobal

For IT = 1 To NM

For IJ = 1 To 4

Indexs (1J, II) = Cells (10 + II, 1 + IJ)

Next IJ
Next IT

For ITI = 1 To NM

For IJ = 1 To 4

For IK = 1 To 4

GK (Indexs (1J, i1y, Indexs (IK, II)) = GK (Indexs (IJ, I1),
Indexs (IK, II)) + P2(IJ, IK, II)
Next IK

Next IJ

Next II

Catatan:

Dalam program, dibuat suatu variabel integer, yaitu Indexs(p,q) yang
membaca form input pada Gambar 5.9. Subskrip p adalah nomor vektor
elemen batang dalam koordinat global, sedangkan q adalah nomor elemen
itu sendiri. Komponen [K]elemen kemudian dapat ditempatkan di dalam
[K]global, yaitu dengan menempatkan Indexs(p,q) sebagai subskrip
[K]global sekaligus mengerjakan superposisinya melalui operasi berikut.

GK (Indexs (IJ, 11), Indexs (IK, I1)) = GK(Indexs(IJ, I1),
Indexs (IK, I1)) + P2(1J, IK, I1)

Dengan cara ini, tidak ada masalah bagi Anda dalam memberikan nomor
urut pada elemen, asal penulisan nomor vektor gaya-lendutan setiap

elemen sesuai dengan sistem penomoran yang ditinjau secara global
struktur.,

Sampai langkah ini, akan dikeluarkan dulu setiap tahapan dalam program.
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Matriks Kekakuan Elemen:
[KIAB
28728.00 0.00 -28728.00 0.00
0.00 0.00 0.00 0.00
-28728.00 0.00 28728.00 0.00
0.00 0.00 0.00 0.00
[KIAC
23940.00 0.00 -23940.00 0.00
0.00 0.00 0.00 0.00
-23940.00 0.00 23940.00 0.00
0.00 0.00 0.00 0.00
[KIBC
28728.00 0.00 -28728.00 0.00
0.00 0.00 0.00 0.00
-28728.00 0.00 28728.00 0.00
0.00 0.00 0.00 0.00

Matriks Transformasi Elemen:

[TIAB
0.60 0.80 0.00 0.00
-0.80 0.60 0.00 0.00
0.00 0.00 0.60 0.80
0.00 0.00 -0.80 0.60

[TIAC

1.00 0.00 0.00 0.00
0.00 1.00 0.00 0.00
0.00 0.00 1.00 0.00
0.00 0.00 0.00 1.00
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BC
0.60 -0.80 0.00 0.00
0.80 0.60 0.00 0.00
0.00 0.00 0.60 -0.80
0.00 0.00 0.80 0.60

Matriks Kekakuan Elemen dalam Koordinat Global:

[Kls = [TJi"[K]i[T]i

3 |-10342.08 | -13789.44 | 20684.16 0.00 -10342.08 | 13789.44
4 |-13789.44 | -18385.92 0.00 36771.84 | 13789.44 |-18385.92
5 |-23940.00 0.00 -10342.08 | 13789.44 | 34282.08 |-13789.44
6 0.00 0.00 13789.44 |-18385.92 | -13789.44 | 18385.92

K]s AB
10342.08 13789.44 -10342.08 -13789.44
13789.44 18385.92 -13789.44 -18385.92
-10342.08 -13789.44 10342.08 13789.44
-13789.44 -18385.92 13789.44 18385.92
[K]s AC
23940.00 0.00 -23940.00 0.00
0.00 0.00 0.00 0.00
-23940.00 0.00 23940.00 0.00
0.00 0.00 0.00 0.00
s BC
10342.08 -13789.44 -10342.08 13789.44
-13789.44 18385.92 13789.44 -18385.92
-10342.08 13789.44 10342.08 -13789.44
13789.44 -18385.92 -13789.44 18385.92
Matriks Kekakuan Global:
1 2 3 4 5 6
1 34282.08 | 13789.44 | -10342.08 | -1 3789.44 | -23940.00 0.00
2 13789.44 | 18385.92 [ -13789.44 | -1 8385.92 0.00 0.00

j isi 1 di nodal bebas dan nodal
Langkah selanjutnya melakukan partisi [K]globa
perlgtakan. Manipulasi langkah program untuk membentuk [Kg] sudah
dibahas sebelumnya dalam contoh struktur frame balok.

[K]global =

o NN~ W
~
g

_ [20684.16  0.00
Kel=|" 000 36771.84

Dari Persamaan 4.3,
{P¢} = [Ke] { X5}

{Xi} = [Kel ' {Pg}

[ 0.00048
=13 _0.00054

Setelah lendutan di titik bebas diketahui, dapat dicari gaya dalam setiap

elemen melalui persamaan:

{Pyi= {Po} + [KJi([T]i{X7})
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[T]i{A"f} adalah matriks lendutan {X;} yang ditransformasikan dari sistem
koordinat global ke sistem koordinat lokal.

Di sini tidak ada beban yang langsung diterima oleh elemen batang sehingga
{Po} = 0. Persamaan untuk mencari gaya dalam elemen menjadi:

{P}i=[KJi([TIi{Xs})

Besarnya gaya dalam setiap elemen adalah:

AB : AC : BC:
4.167 0.00 20.833
0.00 0.00 0.00

-4.167 0.00 -20.833
0.00 0.00 0.00

Besarnya reaksi perletakan dapat dicari dari Persamaan 4.6:
{Ro} = [Kod (X5} — {Py}

Di sini t.idak ada reaksi langsung yang diterima pada perletakan dari gaya
luar, sehingga {P,} = 0. Jadi Persamaan 4.6 menjadi:

{Ro}= [Kioe] {Xr}

Dalam tahap ini, kita harus membentuk [Ky] lebih dahulu. Cara yang dipakai
sama seperti dalam membentuk [Ky]. Programnya adalah:

For IT = 1 To 4
SupM(II, 1) = Cells(7, 4 + I1)
Next IT

For II =
For IJ =
GKS(1J, I
Next IJ
Next II

4
GK(SupM(IJ, 1), Index(II, 1))
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Catatan:

Di sini ditambah suatu variabel integer SupM(p,1) yang membaca nomor
vektor perletakan dalam sistem koordinat global. Jadi SupM(1,1) nilainya
adalah = 1, SupM(2,1) = 2, SupM(3,1) = 5 dan SupM(4,1) = 6.
Sedangkan variabel Index sudah dipakai sebelumnya, mempunyai nilai-
nilai = 3 dan 4 (lihat FRAME2D). [K,] dalam program diberi nama GKS,
dan dengan looping di atas subskrip [Kys] menjadi:

1,3 14
23 24
53 54
6,3 6,4

[Ke] =

dan komponennya adalah:

—10342.08 -13789.44

—13789.44 —18385.92

—10342.08 13789.44
13789.44 —18385.92

Besarnya reaksi perletakan kemudian dihitung:

2.500

Ry} = 3333 |
212,500

16.667

Hasil perhitungan dari gaya dalam elemen dan reaksi perletakan kemudian
digambarkan ke dalam rangka batang seperti yang diperlihatkan dalam
Gambar 5.10. Tanda negatif dipakai untuk menyatakan gaya elemen yang
bersifat tekan, dan positif untuk gaya elemen yang bersifat tarik.
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I s

20 ton
10 ton
B -
-4.167 ton -20.833 ton
A C
2.50 ton N 12.50 ton
3.333 ton 16.667 ton

Gambar 5.10 Penggambaran hasil perhitungan pada rangka batang

Periksa kesetimbangan pada titik B:
LH=10+4.167x3/5-20.833x3/5=0
LV=20-4.167x4/5-20.833x4/5=0 ...OK!

Periksa kesetimbangan seluruh struktur:
XFy=20-3.333-16.667=0
ZFy=10+250-12.50=0 ...OK!
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Form input-output TRUSS untuk perhitungan rangka batang adalah sebagai
berikut.

Microsoft Excel - Truss

Unit TON-METER

tondm?

LENGTH| AREA
500 000684
6.00[ 0.00684
5.00] 000684

Global P-X Local P-X )
PL P MEMNO NP1 NP2
000 0.00000 1 41667 00000 -4.1667

000 0,00000 e 00000 00000 0.0000
1000, 0.00048 . 3 208333 0.0000: -20.8333

1
2
.3
4 _-2000 -0.00054
3
3

‘000 0.00000°
000 0.00000.

Support Reaction
Rl R R3 R4
250000 33333 -125000: 16.6667

Keterangan:

1.

3.

NP: jumlah komponen vektor gaya-lendutan, NM: jumlah elemen,
Ec: modulus elastis bahan, o.: sudut transformasi elemen.

DOF: degree of freedom atau derajat kebebasan struktur. Dalam form di
atas, jumlah DOF adalah 2, yaitu pada komponen vektor 3 dan 4. Pada
kasus lain, DOF dapat = 3 apabila perletakan C adalah sebuah rol,

sehingga ada translasi mendatar.

Nodal perletakan pada komponen vektor 1, 2, 5, 6.
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Form input TRUSS seperti di atas tentu akan terlalu terbatas untuk soal-soal
struktur yang terdiri atas banyak elemen. Sebenarnya bentuk ideal form
adalah setiap data input dan output ditempatkan ke dalam satu kolom sendiri,
sehingga seberapa banyaknya data struktur yang ada dapat dituliskan
seluruhnya. Namun dari segi kepraktisan, adakalanya perlu dilakukan
pembatasan untuk setiap soal.

Sekarang form TRUSS akan dibuat seperti pada Gambar 5.11 karena akan
dipakai untuk analisis struktur dengan jumlah elemen yang lebih banyak.
Untuk itu, data input DOF dan nomor-nomor vektornya perlu dibuat menjadi
beberapa kolom dengan sejumlah baris. Setiap perubahan ini tentu akan ikut
mengubah perintah program yang membaca data input. Untuk dua kolom
pada C7:D7 dan sejumlah baris, dapat dibuat perintah berikut:

c = -1

For II = 1 To DOF

For IJ = 1 To 2

If IT + IJ + c > DOF Then GoTo 5 Else Index(II + IJ + c, 1) =
Cells(6 + II, 2 + IJ)

Next IJ

c=c+ 1

Next II

Catatan:

Dalam membuat langkah-langkah program, tidak ada suatu rumusan
tertentu yang harus digunakan. Seperti juga pada seni penulisan lainnya,
di sini hanyalah berdasarkan kreasi dari penulisnya. Hal ini tidak baku,
Anda dapat memakai cara penulisan lain asal memang dapat mengerjakan
perintah yang dimaksud.

Unit TON-METER

© 210E7 tonim!

Gambar 5.11 Contoh form input TRUSS
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5 6: 7 <§ 9 QE 1 50m
(N (2 (N (N l
lﬁ 5.0m Jv_ 50m l 5.0m ! S.Orn'—ﬁE
4 8 112
3 7 11
2 6 10 14 16
1 5 9 13 ’ 15
2 ton P
40 ton

Gambar 5.12 Struktur rangka batang

Dalam contoh berikut, program TRUSS akan dipakai untuk menganalisis
struktur rangka batang dengan geometri, sistem penomoran struktur,
pembebanan dan kondisi perletakan seperti Gambar 5.12.

Data struktur pada Gambar 5.12 kemudian diimplementasikan ke dalam form
input TRUSS sebagai berikut.
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Supports |
23

MEI\1/IN0 NP1 NP2 NP3 NP4 LENGTH| AREA -3
x ; z g 12 5.00{ 6.013200] 2.0
2 2 = - “ 5.00] 0.013200 &40
: 2 1 e " $.00] 0.013200 0.0]
4 3 4 2 5 5.00] 0.013200 0.0
2 5 £ £ ! 7.07] v.013200 450
£ . = 2 : §.00] 9.013200 90.0]
L $ u 7 i 7.07] 6013200 1350
o £ : 9 2 = 5.09 0.012200, 300,
- 2 = 1 - ! 7.07| 0.013200 45.0
2 1 3 1 4 3 5.06| 0.013200 90.0
- o 2 : ! l; 7.07| 0.013200 1350
= s . A T 5.00] 0.013200 0.0
. 2 5.00] 2.013200 00

B T R
L MEMNO . NP1 . NP2

L
..2060,

Hasil lendutan {X} kemudian diplot ke dalam grafik dan ditunjukkan pada

Gambar 5.13‘.. Grafik dibuat di Excel dengan tipe XY(scatter), terdiri atas

beberapa serie data dari koordinat struktur sebelum dan sesud’ah dibebani

Juga diberikan faktor skala agar hasil lendutan tampak dalam gambar'

II)’:;rglt)uatan seri data dan formula yang digunakan dapat dilihat di dalam ﬁle~
am.
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meter

Gambar 5.13 Lendutan rangka batang

5.3 Balok di Atas Medium Elastis

Balok yang dibebani di atas medium elastis adalah teori yang sering dipakai
dalam prediksi beban—deformasi untuk analisis struktur yang berinteraksi
langsung dengan tanah. Medium elastis adalah pendekatan terhadap perilaku
tanah sebagai kumpulan pegas yang elastis linear, independent dan satu sama
lain tidak saling berhubungan (asumsi tanah Winkler). Dengan semakin
pesatnya penggunaan komputer, kemudian teori tersebut lebih banyak
diselesaikan dengan metode numerik, khususnya metode finite element.

Dalam metode finite element, sistem struktur dianggap sebagai rangkaian
terpasang dari sejumlah elemen dengan jumlah dan ukuran yang ferbatas
(finite-element). Medium tanah pada setiap elemen diwakili oleh sepasang
pegas pada kedua nodalnya. Dasar-dasar yang digunakan di sini adalah
Persamaan 4.7 sampai 4.12, dan notasi-notasi yang dipakai menyatakan
hubungan komponen gaya-gaya eksternal (nodal) dan internal finite element

(member) pada Gambar 5.14.
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diagram
kesetimbangn
P-F

;i\a L N
P - X
AR e | n .
1\ % .2 P P
no. no. t 3
F I i

nodal elemen
elemen F-d 1 2
£ F,

o o= d,

Gambar 5. .14 Komponen gaya-gaya eksternal (nodal) dan
internal (member) dari finite element

Komponen [A], [S] elemen adalah:

1 0 00
1 1
r 7 '
A:
[A] 0 1 00
L
L L
[4EI 2EI 7
— == 0 o
L L
2EI 4E]
S]= | — —
[S] I Loo
0 0 K, 0
| 0 0 0 K]
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Keterangan:
E modulus elastisitas elemen (balok)
1 momen inersia penampang elemen
K, K, konstanta pegas (spring) tanah = (L/2).B.Ks
B lebar balok
Ks modulus subgrade reaction

Lendutan pondasi {X} dan gaya elemen {F } dicari melalui Persamaan 4.12
dan 4.10:

X, P\M
X PV
. {lAl(SIAT } St
3 3
X, I 30%
(| M X,
FiM X
e S S VN R
E(v X,
F|v X,

{[AI[SI[A]" }' invers dari matriks global struktur

[SIIA]" matriks elemen
M vektor gaya momen
vV vektor gaya vertikal

Gaya elemen F; dan F, di sini adalah reaksi pegas tanah pada elemen atau
disebut dengan reaksi tanah (soil reaction).

Keuntungan metode ini adalah bahwa setiap faktor dari pengaruh
karakteristik elemen yang tidak konstan dan medium yang tidak seragam
dapat dengan mudah dimasukkan ke dalam perhitungan. Namun demikian,
penting untuk membagi struktur menjadi lebih banyak elemen pada sekitar
nodal pembebanannya agar hasil gaya-gaya dalam yang timbul dapat
terekspos dengan baik.
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Contoh:

Program perhitungan untuk balok di atas medium elastis diberi nama BOF.
Aplikasi program ini sekarang dipakai untuk analisis pondasi di atas medium
tanah dengan modulus tanah Ks. Data pondasi untuk soal diambil dari buku
JE Bowles, Foundation Analysis and Design. Adaptasi ini untuk
membandingkan output program yang dibuat di Excel dengan Program For
Beams (PFB) yang sudah dibuat dalam bahasa Fortran (versi terdahulu).
Hasilnya kemudian dibuat pada Tabel 5.1.

Pondasi dibagi 12 elemen/13 nodal, dengan panjang elemen seperti yang
diperlihatkan pada Gambar 5.15.

Pu = oy -

1350 N 2025 kN
Mu = R
108 KNm 50 m

Dinding atau
kolom

0.40

0.46

) -@%ﬂo.w}— 061 ~f— 107 —— 107 oo —F 061 4 PP} 045 | os0 |
\W”123‘\4W5 YT &7 7 8NXT9 0 11 12 W3 T

nodal

060

Data dan model dari buku J.E Bowles, Foundation Analysis and Design, 1982.

Gambar 5.15 Analisis pondasi dengan metode finite element

Load Factor, LF=1.571

Modulus reaksi tanah, Xs = 14000 kN/m?
Modulus elastis pondasi, Eb = 21700000 kPa
Dimensi pondasi = 0.60 m

Lebar pondasi, B=2.64 m

Ambil, Input Ks = LF.Ks = 22000 kN/m®

Analisis balok dengan metode finite elemen memakai sistem penomoran
yang menerus, schingga mudah diterka bahwa tipe matriks global ASAT
adalah sebuah band matriks, di mana komponen-komponen semua matriks
elemen ASAT akan membentuk jalur diagonal. Dalam merancang matriks

global ini, dapat dilakukan dengan melihat penempatan komponen matriks
elemen seperti berikut.
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[ASAT]elemen1(1,1) menempati [ASA:] global(1,1), dan seterusnya.
[ASAT]elemen2(1,1) menempati [ASAT] global(3,3), dan seterusnya.
[ASAT]elemen3(l,1) menempati [ASA "]global(5,5), dan seterusnya,
dan seterusnya hingga NM.

Dengan pola penempatan seperti di atas, dapat dibangun matriks global
sebagai berikut.

n =20

For II = 1 To NM

For IJ = 1 To 4

For IK = 1 To 4

GASAT(IJ + n, IK + n) = ASAT(IJ, IK, II)
Next IK

Next IJ

n=n+2

Next II

Selanjutnya dengan melihat penempatan komponen matriks elemen dan
sekaligus mengerjakan superposisinya pada komponen-komponen vektor
yang sesuai:

ey — GO
[ASAT]global(4,3),(4,4) = [ASAT|elemen {(4,3),(4,4)} +
[ASAT]elemen2{(2,1),(2,2)}

Sy~ (AShemenz GG
[ASAT]global(6,5),(6,6) = [ASAT|elemen2{(4,3),(4,4)} +

[ASA"Jelemen3 {(2,1),(2,2)}
dan seterusnya.

Hubungan di atas dapat ditulis ke dalam perintah program berikut:

n =20

=1 To NM - 1
gggA%%B + n, 3 +n) = ASAT(3, 3, IK) + ASAT(1l, 1, %E + i;
GASAT(3 + n, 4 + n) = ASAT(3, 4, IK) + ASAT(1, i, = + I
GASAT(4 + n, 3 + n) = ASAT(4, 3, IK) + ASAT(2, 5 X + 1
GASAT(4 + n, 4 + n) = ASAT(4, 4, IK) + ASAT (2, +
n=n+2
Next IK

Dalam pemrograman di Excel, cara penulisan seperti ini sebenarnya dapat
juga digantikan dengan memanfaatkan data input dalam form. Perbedaan
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yang tgmpak adalah bahwa pada listing ini tidak terdapat rujukan pada alamat
ls:l. Point yang akan ditekankan dalam pemrograman di Excel adalah bah\ja
t1ta ;ekerja denggn suatu form yang aktif, di mana di dalamnya sudah
ersedia semua variabel program yang dibutuhkan. Cara penulisan seperti di

atas dapat digantikan dengan ¢ i
sebelumnya: g ara seperti dalam FRAME2D dan TRUSS

For II 1 To NM
For 10 = 1 To 4
Indexs(IJ, II) = Cells(1l + II, 1 + 1IJ)

Next IJ

Next II

For IT = 1 To NM
For IJ = 1 To 4
For IK = 1 To 4

GASAT (Indexs (IJ, 1II), Indexs (IK, 1II))

Indexs (IK, II)) + ASAT
Next IK (27, 1K 1D

Next IJ
Next II

= GASAT (Indexs (IJ, II),

g

‘ INPUT :
Dim, E, {1}, {P}, {NM}, {NP}, {Length}, {Width}, {Ks}, {K}
1
[ Matriks [A] elemen ]
[

L Matriks [S] elemen j
I
[ Matriks Elemen [AJ[S]AJIT |

Membuat {Indexs}i :
Membaca {NP}i sebagai
subskrip [ASAT]elemen pada
[ASAT]global
]

[ Matriks Global [ASAT] i
|
[Lendutan Pondasi {(X)=[ASAT]giobal"-1 P}
[
Tegangan Tanah
{g}={KsKXx}

[
|Gaya Elemen {F}i=[S]i[A]iT.{X}l
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Data input dan output program untuk contoh soal dipresentasikan sebagai
berikut.

P . Urit ki-meter

N 1
(beam) 17E+07 kPa
Dim 360

520 22,000,080
C o 2200000

8 0.300

10 0&10

12 147G

14 1970 i
iB 0310 25400 0047520
18 0518 26407 0047520
e 0.230

22 0230

24 0450

® £.500 2EH40 0047

TR

Motrents (kN.m)

Translatior No Soif Pressure Mo Soil Reactions (kN)
1 1 -0.00251 2 001179 1 259419 1 0000 -27.3%5 136973 65574
2 3 -0.00251 4 001129 2 248 386 2 -80805: 296981  B5.574 62677
3 5 -0.00247 € ..0.0a78 3 237 414 3 -296.981: 574536 94018 87.702
4 7 -0.00235 8 001007 4 22147 4 -574.536. 976621 178.328. 155.248
5 El -0.00189 10 0008768 s 192.806 s 976621 1224419 2723207 227861
6 1 -0.00074 12 0.00733 B 161.329 & -1224.419. 984584, 227861 222541
7 13 0.00040 14 0.00717 7 167.775 7 -954 594 405382, 189519 207563
8 15 0.00101 16 000785 8 172301 8 -405382° -194373 139140 150760
9 17 0.00108 18 0.00851 9 187233 9 194373 -468.253 56844 58.450
10 18 0.00100 20 000875 10 192522 10 R 549.259. -384 282 58 450 59 906
" Pl 0.00090 22 000897 " 197.318 " : 384282 -141.201° 117.207_ 122103
12 23 0.00078 24 0.00934 12 205 564 12 141201 0.000: 135672 282402
13 25 000075 26 000872 13 213841

Tabel 5.1 Beberapa Perbandingan Output BOF dan PFB

Hasil yang BOF PFB
seharusnya
ESFv=0 3375.0 3375.0 3371.92
M ujung kanan elemen 1 dan kiri -108.0 -108.0 -108.0
elemen 2 = P;
TM ujung kanan elemen 9 dan kiri 81.0 81.0 81.26
elemen 10 =Py
Gaya momen di ujung kiri elemen 1 0.0 0.0 0.0
Gaya momen di ujung kanan 0.0 0.0 -0.063
elemen 12
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) H
[
W
i asil . .
4 . akahoutpul?t’ t.egangan tanah (soil pressure) digunakan untuk memeriksa
. (P) N'Ilje'm erian bebgn pada pondasi tidak melebihi daya dukung izin tanah _AE
u qa)- Nilai yang maksimum (dalam soal ini dibagi : sL
‘ : agi dengan LF) tidak boleh
melebihi g,. ole
12.6(2.0x10°
5 UIltllk I'Od 1= ——3%&;&‘——) = 8400 kN/IIl
4 Dinding Penahan Tanah
Aplikasi progra : 8 0
m . .
oy program BOF sckarang akan dipakai untuk analisis dinding penahan Untuk rod 2 = 15.9(2.0x107)c0820° _ 551 40 kN/m
Izla .bPrggram sedikit dimodifikasi agar cocok untuk pemodelan di mana 3(4.5)10° - '
a . . :
E o la iaﬁl'an.yang bebas (di muka dinding) mempunyai K = 0 Program
atls}lls inding penahan tanah diberi nama WALL. Data dan model untuk
con Loy . : .
Desi;n soal ini diadaptasi dari buku J.E Bowles, Foundation Analysis and
' Form input-output WALL
97 &0 e Nodal P - X
alP—
- 1 5.54 Kpa
=] Tanoh grenular, v = 17.9 kN/n? o Pa-Xz (——“\
o= 32° 10 P1-Py \\
rod angkur 1 3 P4-Py \
: Lz ;g,shcma 15 P3-Pjy \
spasi = 3 m o Elemen F —d \\
i 10 n Tt e . 405 N Fieag met 4 _ AN 0
= e ", T L
o rod angur 2 : N Fo-ds Fa-dj AN 3 5 - 0.00038: - Ba0ooo
| A = 159 cme AN 4 7 0 0000361 PR
spasi = 3 n 20 N 5 9 000038 P
Tanah N 6 1 000038 N
kohesif N 7 13 0.00038 4000
q,= 6l kPa 175 \ 8. 15 00 000058 b
Y= 208 kN/m? 145 Kpa N\ 8 7l 000036 et - [
10 t_‘_‘”_”_:::::::=--\ 10 19 o.n003s; Famoe 365000 366000
40 m S i 1 000036 CUT3000 266000 388000
: 0.00035 732000 366000 356000
10 NP =2 X 14 = 28 e
NM = 13
lﬁw Diagram tekanan § R
tanah i .. Soil Pressu Moments (kMN.m)
1 0.00 1000281, 2 000348 0000 1 0.000 ) D.00;
Data dan model . ) 2 380 3 opo284. 4 -0000E7 2 ‘oooo 2 3597, 17693 0000 0,000
daribuk1.E Bowles, Foundation Analysis and Design, 1952 e dwmmocogme o wm o3 U oS GRS
‘5 0o © 79 ""pon44r 1000101 S ~bpoo s 85886 118310 0000 0000
Gambar 5 16 4 . . . . 6 2086 917 oposoe. 12 00137 8 oooo & 183100 160712 0000, 0000
. nalzs:s 7 0.00 © 437 Toonsss. 14 0018130 7 0.000 7 480712, 201777 357082 0000
dmdl.ng penahan tanah dengan meftode 8 5790 15 Dooss2 16 002741 8 o000 8 ¥ 01777 337995 0000 0.000
ﬁ}ute element 9 %0 CTq7 ooo1ssi 18 003196 8 oo 9 | 337995, 147753 0000 0,000
10 02 18 -0.00714 20 002371 10 173.544 10 147.753 6879 86772 58320
11 9400 21 -0.00807 22 0.01593 11 116,640 11 -5.879 44871 58320 29.26%
12 1885 23 -0.00773 24 0.00800 12 58531 12 -44 871 24333 29.265 1.897
13 200 s -0.00727 26 0.00052. 13 3794 13 -24.333 0.000 1.897  -24.333
Dia ram te . . . R 14 8514 27 -0.00711 28 -0.00665 14 -49 B6E
dangg aya palzznant,tanah;elﬂ;adap dinding diperlihatkan dalam Gambar 5.16 o e
setiap nodal dapat dicari dengan i il ; : 170
. an interpolasi linear. Nilai 7582
tanah kohesif di m inding diambi s T. Ntlat pegas o
uka dinding diambil = 3660 kN/ b imes
. m. Sedangkan rod m 13268
terbuat dari bahan baj : : gkan rod angkur Ey BT
aja, dengan spesifikasi yang diperli 5w
o ng diperlihatkan dal 5
Nilai T y n dalam gambar. 22 amo
pegas rod angkur per meter lebar dinding diperoleh melalui rumus: % o
. 25 0
26 000
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Hasil gaya momen kemudian di

sl ibuat ke dalam grafik s i

legmr }I;?)tslilirf{ r11)1«'c;<11(a‘Gambar 5.17. Uptuk keperluan desgain, diari%?{tinoﬁgg

negationn bom sgnum yang bekerja di bawah angkur, sedangkan mom .

pega a di sekltqr angkur dan sekitar ujung tancapan. G. n
gangan pada rod angkur diperoleh sebagai berikut: pan. Gaya dan

Rod 1 Pya =3 x 18.708 = 56.124 kN

‘fs'z Paksial :56124_ 2
4 e - 4.454 kN/cm

Rod 2: ial =
Puksial = 3 x 357.082/cos 20° = 1139.996 kN

f;: Pﬂksial =M_71 )
A4 159 1698 kNem
(ki
400
200 0 200

{meten

Gambar 5.17 Distribusi momen lentur sepanjang dinding
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5.4 Pondasi Pelat

Program komputer untuk analisis pon
finite grid (FG) seperti yang diajukan o
suatu pendekatan terhadap analisis finit
FG memakai persamaan-persamaan yang sama
medium elastis pada Bab 5.3. Dengan menjumlahkan g
nodal dalam Gambar 5.18 dan dari sifat elastis elemen,

dasi pelat dapat menggunakan metode
leh Bowles (1974). Metode ini adalah
e element. Analisis dengan metode
dengan analisis balok di atas
aya-gaya pada setiap
[A] dan [S] elemen

dibangun sebagai berikut.
[—sina 0 —coso. 0 O]
cosoL 0 —sino. 0
L2 0 -
[Al= 6 —sina cosaL
0 coso.  sino
L e LR

4BL 2EL o

L L

———2? i?— 0 0 O
[S1=

0 0 Q67 0 O

L

0 0 0 K, ©0

LO 0 0 0 K,]|
Keterangan:

G, Q,J komponen torsi
(G: modulus geser bahan pondasi,

Q) : faktor torsi, diambil = 1 untuk pondasi pelat)
K1, K> konstanta pegas tanah

J: momen inersia polar,

Proses perhitungan dalam program sama seperti bagan alir BOF. Program

analisis untuk pondasi pelat (mat foundation) diberi nama MATF.
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Contoh:

Pondasi pelat di atas tanah yang uniform dengan Ks = 2000 ton/m’,
menerima beban vertikal dan momen pada kolomnya. Data input
selengkapnya diperlihatkan dalam form input MATF berdasarkan geometri
dan sistem penomoran grid pada Gambar 5.19.

S
S
nodal P-X . f_..4 _____ _)J4.4
6
2
Lz

2
elemen F-d %

\®
s FS
konstanta
pegas
tanah

Gambar 5.18 Komponen gaya-gaya finite element grid untuk
analisis pondasi pelat

Data Input:

Beban vertikal kolom diketahui = 40 ton. Dalam program, besar beban ini
menjadi terbagi rata sebesar 10 ton kepada 4 nodal kolom yaitu pada nodal
15, 16, 21 dan 22. Demikian pula dengan beban momennya.

Data input untuk X dibedakan untuk nodal sebelah dalam dan luar. Pada
nodal sebelah dalam harus diperhitungkan pengaruh akumulasi pegas tanah
dari elemen-elemen yang bersebelahan karena superposisinya. Dengan
demikian, secara global kontribusinya akan mencerminkan kondisi tanah
yang uniform.
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Gambar 5.19 Geometri struktur dan sistem penomoran grid

grid pada Gambar 5.19, Anda akan rpendapaﬂ(an data
input seperti dalam form. Tampak bahwa data _yang dlbutuhl‘:anmm;:i‘la(l
. b n grid ini sangat banyak, oleh karena itu dl.perh?kan sua
yong t:niluntuk mengisinya. Caranya dengan membatasi bgglan-bqglan yang1
zi;Iill%al Entuk kemudian di-copy ke tempat lain. Gn(}( plor;;i:;il I};ﬁgil i}l:l;t;]splliln
i banyak bagian-bagian data yang tipikal, ba
gﬁ?ﬂﬁlg digu?lakan %dalam form dibatasi dengan garis).

Dari sistem penomoran
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Form input MATF

NGTH WIDTH NERTIANERTIA, . o

500000 _ 15000 . 1ep00
i

Form output MATF

G

. NP DISPLACEMENT i
1 _ooooos 2!
4 000011 5 0.00258
7000021 8 000259
10 000033 11

T13 000038 14
1§ 000037 17 000212
13 000006 20 000253
22 000003 23 000263
25 000018 26 0.00270
28 000031 29
31 000034 3
34 000032 35
37 000002 38
40 00000z 41, 000264
43 000008 44 000293
46 000015 47 000270
43 000016 60
52 000014 53
55 .000002 56
53 -000002: 59 000264
61 -000008 62

64 000015
§7. 000016
70000014
73, -0,00008
76 -000003
79000018,
82 -0.00031
85 -0.00034
83 -000032
91._-0.00008
94 000011
97 -0,00021
100 -0.00033.
103000033
106 000037

Periksa:

3 .0.00224
g -0.00070
9 000084
12 000234
15000372
18 0.00501
21, -000220
24 000064
27 000036
30 000253
33 000394
36 000522
33 000218
42 -0.00082
45 000104
48" 0.00269
51 000411
54 000536
57 -000218
60 _-0.00062
63 000104
66 0.00269
63 000411
72, 00053
75 000220
78 -0.00084
81 000096
84 000253
57 0.00394
90 000522
93000224
9 -000070
99 000084
102 0.00234
105 000372
108: 0.00501

MM ELEMENT FORCES fF}

1 003302 029189 013899 040405 012684
2 040634 045135 (0.36658 012664
3 135399 -0.38964 045102 015123
4 177780 081518 0.19777 042073 066933
5 079162 -0.10817 -0.05220, -0.66933 -0.90160
& 013839 -0.02904 008302 04405 039671
7 022759 040893 069823 025327, 0.11578
o 008444 -055356 180584, -0.30245 -0.17275
9 025325 -0.75478 138817 -D84146 046562
10 024397 106725, 003357 -133866 -0.70952
11 005220 -048088 010817 -0.30180; 093340
12007518 084200 036736 079342, 011575
13 128979 028892 152251 0.11575 0.17278
14 134363 273473 197268 -0.17275 045582
15 428324, 293503 059965 045582 -0.70952
16 231617 -005280 035444 070952 -187881
17 029640, 010116 000734 039671 039268
18156208 0.18406 -027042 0.11575  0.11126
19100372 137714 353839 017275 -0.19891
20 061825 420310 291662 045582 -0.48412
21 010316 -405838 065243 070952 073382
27 082511 -122473 016097 -0.33940 -0.96483
23 ‘000784 124598 009884 078575 0.11126
24 151641 476772 081398 011126 -0.13831
25 Beases 173542 112203 -0.1863) 048412
26 1024796 130138 019221 048412 073982
27 265631 016097 032083 073982 -192967
23 013801 -019801 000000 033288 0.39288
29 063308 053308 000000 031126 011126
30 186518 -163513 000000 -0.13631: -0.18691
31227329 -327323 000000 -048412 -048412
32354534 354534 000000 073982 -D.73982
33 154562 154562 000000, 096483 -0.95483
34000734 124598 009684 078575 011126
35 151641 476772 081338 011126 -0.13691
36 663389 173542 112203 018691 -0.48412
37 1024796 -190188 -0.19221 048412 -0.73982
38 256431 016097 032083 -0.73982 192967
33 010116 039640 000784 039288  0.39671
40 012406 -1562028 027042 011126 011575
41 137714 -100372 353839 -0.13691 017275
42 420710 081925 291662 D48412 045582
43 405838 -0.10316 086243 -0.73962 -0.70952
44 122479 082511 -0.16097 -0.96483 .0,33340
45 007513 084200 DIETIE 079342 011575
46 126979 028892 -152281 0.11575 017275
47 124363 273479 197268 -0,17275 045582
48 426324 293503 -053966 045562 -0.70952
49 231617 005280 036444 070952 -1.87881
50 002304 013893 008302 039671 040405
51 040693 -022759 069823 011575 025327
57 05556 008444 180584, 017275 030245
53 075478 026325 138817 045582 084146
64 106725 024997 003357 -070952 -1.33868
55 045068 -005220 -D.10817 -093340 090160
56 008302 029139 013899 Q40405 012664
57 040634 045185 036658 012664 015123
53 135299 -0.38964 045102 015123 -042073
69 1777800 081518 013777, 042073 -0.66933
50 078162 -0.10817 005220 -068933 -090160

o I{Fs+Fs} =-40.0* = beban nodal kolom 4 x 10.0 ton ... OK!
o SMNJ;s =4.76772 + 6.69389 — (-3.53839) + (0) = 15.0 versus 15.0 t.m

... OK! dst.
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o IMNJ, = 0.29189 +0.40634 + (-0.69823) = 0,
o EMNIJyp = -2.73479 + 426324 — (-1.38817) + (-2.91662) = 0...OK! dst.

Catatan:

1. * dalam menyamakan XFy di nodal, analisis FG mengambil nilai negatif
untuk gaya pegas elemen. Jadi gaya yang negatif menyatakan gaya ini
pada translasi yang positif (searah gravitasi) atau sebaliknya (gaya positif
menyatakan kondisi tarik pada pegas).

2. Dalam contoh soal ini terjadi translasi yang negatif (tarik pada pegas), di
mana sebagian pondasi bergerak menjauhi tanah. Oleh karena itu matriks
ASAT perlu dibangun kembali dengan K = 0 pada nodal-nodal tersebut.
Di sini berat pondasi juga perlu dimasukkan ke dalam perhitungan.
Hasilnya kemudian diperiksa dan Jika perlu ulangi langkah ini hingga
tercapai konvergensi dalam penyelesaiannya.

Lendutan pondasi kemudian diplot dan hasilnya dipresentasikan dalam
Gambar 5.20. Mengeluarkan hasil lendutan ke dalam penggambaran grafik
sebenarmnya merupakan pengujian yang paling mudah dilakukan untuk
memeriksa apakah semua data input sudah dituliskan dengan benar. Grafik
3D Excel di sini banyak sekali membantu, terutama untuk memeriksa data
input yang memang relatif banyak seperti dalam contoh soal di atas. Dapat
juga ditambahkan bahwa setiap kali selesai membangun atau merancang
matriks, Anda dapat memeriksa setiap komponennya dengan cara mencetak
ke worksheet. Cari dalam form tempat yang kosong untuk menempatkannya
dan jangan lupa memperhitungkan ukuran matriks yang akan dicetak agar
tidak menghapus isi data yang lain.

Skema matriks global ASAT diperlihatkan pada Gambar 5.21. Sebenarnya
setiap konstruksi akan mempunyai skema matriks globalnya sendiri yang
spesifik, umumnya merupakan band matriks di mana komponen-komponen
yang bukan nol akan membentuk jalur komponen diagonal, sedangkan
komponen yang nilainya nol berada di luar tepi diagonal. Pada umumnya
Jjuga merupakan matriks simetris. Di sini ada Suatu rumusan untuk mencari
bandwidth, yaitu jarak maksimum komponen matriks elemen terhadap
diagonal matriks global pada setiap baris. Untuk grid seperti dalam contoh
soal ini, rumusan bandwidth (NB) adalah:

NB = NPyux — NP i + 1

Di mana nilai NP,,,, dan NP, ditentukan dari dua nodal yang bersebelahan
dalam satu elemen grid. Dari Gambar 5.19, NB adalah = 21-1+1 = 21 dan
skemanya seperti yang diperlihatkan dalam Gambar 5.21.
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i rti bandwidth ini tidak perlu
1 emrograman di Excel, rumusan sepe:
(?ill?rlglfan dalgam merancang matriks. Anda dapat mt?manfqatkan forril unlzui
membuat variabel yang dibutuhkan dalam memampulgm langkah- an% a
program. Contohnya sudah diperlihatkan dalam teknik-teknik penulisan
FRAME2D dan TRUSS.

i i - triks, teknik penulisan
in teknik penulisan untuk merancang-bangun matriks, . 1
ﬁﬁiﬁf mchetai hasil program ke worksheet sama pentingnya ur:ltuk dlllzuﬁzll:
ilah-mi iap hasil output program dan seka
Anda harus dapat memilah-milah setiap aligue
dan X, menyatakan vektor rotasi
ngurutkannya. Dalam MATF, X, >

?:dagi dan X; untuk translasinya. F\, F, F3 m:enyatakan ngtor gaya molr.nen
di elémen serta F, dan Fs untuk gaya vertikalnya. Berikut ini penulisan
untuk pencetakan lendutan {X} ke dalam worksheet:

‘Cetak {X} :

" untuk rotasi akibat torsi

i ; % ' untuk rotasi akibat momen
= ' untuk translasi
g ; i 'sgil pressure = KS * X(3)
For IT = 1 To N{B) R
13 + IT, =
gg%%zil3 + IT, 19) = X(a, 1)
Cells (13 + II, 20) = b
Cells(13 + II, 21) = X(b, 1)
Cells (13 + II, 22) = c¢
Cells (13 + II, %z; = é(c 1)
+ II, =
ggiizg%% + II, 25) = KS(I1, 1) * X(c, 1)
a=a+ 3
b=Db+ 3
c=cCc+ 3
d=4d+1
Next II

| i k baris demi baris yang
erintah di atas, program akan menceta '
gﬁf&? gari baris ke-14 pada worksheet. Variabel g, btali ;hbuf;lj1 zr;gtlku
i i hasil lendutan terce eng
memanipulasi langkah program agar has deng "
ilai 3 di lah vektor P-X di setiap noda
lipatan. Nilai 3 ditentukan berdasarkan jum '
l]()ei lfi?xi program juga menyisipkan indeks lendutan sebelum mencetak hasil
lendutannya. ' N )
Perintah pencetakan untuk gaya elemen {F} sed{i}l;x}t (lfblh betrlzlanali::.mlir(lltil;n
jari i i il itempatkan,
lajarinya, lihat pada form di mana hasi . .
gfl:;pﬁséng i’)rogram MATF. Anda dapat memahami hubungan 1lzelrlmtah
program dan pencetakannya dengan menjalankan program langkah per
langkah dengan menekan Ctrl+F8 > F8.
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)2 . BANDWIDTH— - NP
! oo 11213l al5]6|7]8]9|0]11]12]13]14]15]16|17|18]19|20|21|22| 23|24
- 1 x [ x| x[x[x]x x| x| x [
20 x| x| x| x| x]|x xxIx] I
3| xIx| x| x| x]|x NM 67 | x|x[x N
4l x| x| xIx x| x| x| xIx xx]x
~ SE-Tsometric 5 X | X | X|X|X|X|X|X]|X 71 [ x|x]|x
6 x x| x| x| x|x[x{x]|x x| x|x
7 x I x [ x [ x]x{x{x{xIx
8 x [ x| x[x[x|x][x!x]|x
9 x [ x [ xx [ x[ x| x|x]|x
10 X | x [ x| x| x| x| x| x|x
1 x| x| xIx ] xix|x|x]|x
12 x [ xIx[x[x[x[x]x)x
13 x| x [ x [ x]xIx|xIx|x
14 x| x| x [ x]xIx]x|xIx
15 x| x Ix ] x I x [ x x| x| x
16 x| x| x x| x| x|x|x|x
17 x| xIx[xIx x| x| x]x
b 18 x| x x| xIx[x[x]x|x
19] x | x| x 6 x | x [ x [ x[x] x| x| x|x
“"‘*‘i Gambar 5.20 Lendutan pondasi pelat 20| X | X | x| x x| x x| x| x| x| x]x
;“i 21| x | x| x X | x| xIx | xix|x|x|x
‘1“ 22|\ X | X|X 7 x| x| x| x]x[x
P‘ 2| [N [x[x[x|- | x| x IxTx ] x| x
I 24| ~IxxIx 1 1 x | x [xIx]x|x

| Gambar 5.21 Skema matriks global pelat

5.5 Konsolidasi Satu Dimensi

Konsolidasi satu dimensi dapat diselesaikan dengan cara numerik, yaitu
dengan metode finite difference (FD). Metode ini berdasarkan pada suatu
grid kedalaman dan waktu seperti yang diperlihatkan Gambar 5.22.
Kedalaman lapisan tanah dibagi m bagian yang sama dengan tebal Az,
sedangkan periode waktu dibagi » bagian yang sama dengan selang At
Penyelesaian dengan metode finite difference diambil dari teorema Taylor, di
mana untuk persamaan konsolidasi satu dimensi menjadi,

i =ui;+ P iyt = 2 Uiy (5.9
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4~__————————-—---q‘.---""""""_____________—__-____________7447

c, At
(azy

di mana, B =

¢y koefisien konsolidasi
u;;  tekanan air pori berlebih pada kedalaman i dan waktu 7.

B disebut sebagai operator dari Persamaan 5.9, dan supaya
konvergen nilai ini tidak boleh melebihi Y%, Nilai yang dipakai
berada dalam kisaran 1/6 hingga .

Untuk suatu periode waktu ¢ pada lapisan terbuka:

T - cv(nAt)

= = 4Bn/m* (5.10)
g (‘/zmAz)2 P

Pada lapisan setengah tertutup, penyebutnya menjadi (mAz)” :
T, =Bn/m* (5.11)
T, disebut faktor waktu.

Untuk titik-titik pada batas impermeabel di mana tidak ada aliran air yang
melewati batas ini, Persamaan 5.9 menjadi:

Ui =i+ BQQuiy; - 2u;)) (5.12)

Dalam pemrograman, baik Persamaan 5.9 maupun Persamaan 5.12 tidaklah
sulit untuk dibuatkan programnya, karena analisisnya berdasarkan pada suatu
grid yang sama sisi. Hal ini dapat dibuat seperti membangun sebuah matriks
dengan ukuran m x » (lihat Gambar 5.22). Metode FD ini sebenarnya juga
dapat diselesaikan dengan formula spreadsheet. Oleh karena bentuk
penyelesaiannya adalah sebuah grid m x n, maka dapat dibuat dalam
worksheet menjadi baris dan kolom. Namun di sini banyak ditemukan
keterbatasan-keterbatasan yang paling mendasar dan penyelesaiannya sudah
menjadi tidak praktis. Dalam pemrograman VB, penyelesaian grid FD
dikerjakan dengan membuatnya ke dalam perintah pengulangan. Dengan
demikian untuk mencari hasil tekanan air pori pada periode waktu tertentu
dapat diketahui dengan memberikan nilai yang ditetapkan pada pengulangan
tersebut. Untuk lapisan sctengah tertutup dapat ditulis:
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5 For j = 0 To n 'half closed layered

u(o, j + 1) =0
Next j L
For 1 = To m .
u(i, 0) = Cells(12 + i, 2)
Next I
For j = 0 Ton )
i = To m . i -1,
Tr- o Then u(i, 3 + 1) = u(i, j) + Beta * (2 * u(i - 1, J)
_ * i j)): GoTo 10 . . ; iy - 2
u(? juili)jl)u(i, §) + Beta * (u{i - 1, 3) + uli + 1, 3J)
* u(i, 3j))
Next i
10 Next j: GoTo 20
h
—-—AI_L
P

R
| | I
H~4@Li_—%—4
| |
|

S

|

]

W L 2. S

| | | |

lups | | |

H—ﬁ—’f_-f_j

]

R

Gambar 5.22 Grid kedalaman dan waktu (h-t)

isti ilihat pada bagian akhir buku ini.
t rogram selengkapnya dapat dili igian akhir bul
I};;S)girrlfmppegnyelesaian finite difference untuk konsolidasi ini diberi nama

FDC.

Contoh 1: | .
Suatu lapisan lempung setengah tertutup (hale/cl(l)lseddlayeé:}e)c&li)1 f;p;’;l::z ilrxlr
i fisien ¢, = 7.19 m"/tahun dan .
mengalir pada batas atas. Koe N D e serrn. demon
istribusi tekanan air pori awal te'rhadap' edalal leng
]c?ilsstrilbusi tekanan di bawah pondasi seperti Contoh 4 dalam Bab 2. Diminta
mencari besarnya distribusi tekanan air pori setelah 6 bulan.
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I
]‘ i
\
‘hl‘\ Kedalaman (m) | Tekanan air pori (ton/m?) Contoh 2:
b gg 10.00 Sekarang kondisi lapisan lempung berada di atas suatu lapisan pasir,
: 9.76 sehingga dapat diasumsikan sebagai lapisan yang terbuka (open layered) di
1.0 8.63 mana air juga mengalir pada batas bawah. Data yang diberikan sama seperti
1.5 7.01 soal 1.
2.0 5.49
2.5 4.28
3.0 3.36 Form input-output FDC
1§ £ 2.68 o
i 4.0 217 Microsoft Excel - Fdc
4 4.5 1.79
5.0 1.49
5.5 1.26
6.0 1.08
12 Cona A Closen Layered
7.169 mtyear 5 year(s)
Form input-outp“t FDC Tl\;z g?g? (0.1667< p <0.5)

Initial PreAfter () Pressure
tonfm? . tonim?®
10.00 0.00

9.76 0.52
.63 1.00
.01 1.40
5.43 1.68
4.28 1.86
3.36 1.90
288 1.80
217 1.59
1.79 1.28
1.49 0.90
1.28 0.46

0.00

1= 0pen Layered
. i 2 = Half Closed Layered
myear . year(s)

Tw=' 0,100

0.167 (0.1667<p <0.5)
Initial PreAfter () Pressure
tonim® | tonsm?

10.00 U.00

376 0.58 | o . . . . . . .
BE3 . 1.09 \ | Hasil di atas memperlihatkan bahwa konsolidasi lebih cepat selesai pada
7.01 1.5 . . . . ..

: H - - lapisan terbuka dibanding lapisan setengah tertutup. Hal ini memang

" sag 1.94
ez disebabkan lintasan airnya yang lebih pendek seperti juga yang dinyatakan

3.38 2.41 1 i . ) . .
i 2% L o oleh faktor waktu (7v). Hasil akhir dari tekanan air pori akan berangsur

217 1258
115 . 258 i ; menjadi simetris terhadap tengah-tengah lapisan lempung. Pada batas atas

1.49 2.54

2 28 dan bawah yang permeabel, tekanan air pori akan segera nol sesaat setelah
= konsolidasi dimulai hingga periode waktu ¢ Di sini diperlukan suatu

Jjudgement yang tepat untuk memodelkan kondisi batas bawah ke dalam

FDC, terutama untuk lapisan lempung yang relatif tipis.

15
2.0
25
3.0
35
4.0
4.5
5.0

o o
(=3&,}

139




Keuntupgan dgngan metqde finite difference, yaitu setiap pola dari tekanan
]a;lr gorl berlebih dapat dimasukkan ke dalam perhitungan. Data input dapat
erdasarkan keadaan awal di lapangan atau model beban yang bekerja secara

bertahap, misalnya dalam i idasi
, penyelesaian konsol i
bendungan atau tanah timbunan. folldast tanah di-bawah
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 BAB 6 |
SCRIPT FILE AUTOCAD

Dalam menampilkan output program secara grafis, dapat digunakan alternatif
lain dengan membuatnya di AutoCAD. Anda dapat bekerja lebih jauh dengan
grafik atau gambar struktur. Kelebihan AutoCAD adalah software ini dibuat
hanya khusus untuk menyelesaikan pekerjaan gambar. Pada awalnya, cukup
diperlukan penguasaan pada tingkat dasar untuk dapat membuat tampilan
grafik, mengedit, mengatur halaman dan mencetaknya ke atas kertas. Namun
minat yang semakin besar untuk membuat program, akan seiring dengan
kecakapan menggunakan sofware ini.

Script file di sini adalah file yang berisi teks urut-urutan perintah yang
dijalankan oleh AutoCAD untuk proses suatu penggambaran. Urut-urutan ini
dibuat otomasinya oleh VBA sebagai ganti langkah-langkah manual yang
memerlukan waktu lama. Script file dibuat menggunakan pengolah kata,
seperti MS.WIN Notepad atau MS. Word yang disimpan dalam format
ASCII dan diberi extension .scr.

Gambar 5.20 menunjukkan contoh hasil script file untuk penggambaran
lendutan (translasi) pondasi pelat. Di dalamnya berisi teks berikut.

_3dmesh

6

6

0,0,0.224472720870677
0,0.6,0.220394494686006
0,1.2,0.218264578883796
0,1.8,0.218264578883788
0,2.4,0.220394494685983
0,3,0.224472720870639
0.6,0,7.03540050240806E-02
0.6,0.6,6.43051243562464E-02
0.6,1.2,6.18111921247522E-02
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0.6,1.8,6.18111921247445E-02
0.6,2.4,0.064305124356223
0.6,3,7.03540050240418E-02
1.2,0,-8.40146054744982E-02
1.2,0.6,-9.59696803024441E-02
1.2,1.2,-0.103838921406436
1.2,1.8,-0.103838921406445
1.2,2.4,-9.59696803024683E-02
1.2,3,-0.084014605474538
1.8,0,-0.233739891927716
1.8,0.6,-0.253231609112864
1.8,1.2,-0.268952870823938
1.8,1.8,-0.268952870823946
1.8,2.4,-0.253231609112889
1.8,3,-0.233739891927757
2.4,0,-0.371850787539531
2.4,0.6,-0.394176821686788
2.4,1.2,-0.411012481540078
2.4,1.8,-0.411012481540086
2.4,2.4,-0.394176821686812
2.4,3,-0.371850787539572
3,0,-0.500891019972049
3,0.6,-0.521891277201477
3,1.2,-0.536019076286047
3,1.8,-0.536019076286054
3,2.4,-0.521891277201499
3,3,-0.500891019972088

Keterangan:

l. _3dmesh adalah perintah yang dijalankan pertama kali oleh AutoCAD
untuk memulai penggambaran mesh atau grid 3 dimensi.

2. Perintah berikut untuk menentukan ukuran mesh secara berurut dalam
arah aksis-X dan Y. Pondasi pelat pada contoh Bab 5.5 mempunyai
ukuran 6 x 6 sesuai dengan jumlah nodal pada kedua sisinya. Setiap
ukuran ini ditulis pada satu baris sendiri, berisi angka tanpa boleh
disertai oleh karakter lain termasuk spasi.

3. Menentukan koordinat masing-masing nodal. AutoCAD menggunakan
titik vertex, yaitu lokasi dari setiap sudut elemen mesh. Data input dibaca
mulai dari vertex (0,0), pada x = 0, x = 0.6 dan seterusnya seperti dalam
script di atas. Penting untuk dicatat bahwa hasil output MATF untuk
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lendutan tidak mempunyai urutan yang sama depgan yang dibaca oleh
AutoCAD. Oleh karena itu diperlukan penyesuaian dan dibuatkan urut-

urutannya.

Bentuk perintah untuk penulisan script file adalah:

Open "c:\nama file' For Output As #1
Print #1, "teks" N

Write #1, variabe . .
Print #1, numerik & "karakter & numerik

Close #1

Dengan kode program di atas, secara otomatis scrigt file akan diberi namzt
”nama file” dan disimpan di direktori C. Tanda ”& setelah statement Prin
#1 untuk menggabungkan data karakter dan numer11.< dalam membuat Verl:ex
atau nodal (x,,z). Untuk maksud yang sama, Anda juga dapat menggunakan
statement Write #1, var x, var y, var z.

Masalah yang dihadapi di sini adalah bagaimana menyamakan 'pgr.rllcb::fliap
output program dengan urutan perintah dalam AutoCAD. Seperti ;{ € dul?
hasil translasi pelat dicetak ke dalam worksheet dgngan mengurut anXarl
nomor subskrip yang terkecil hingga terbesar, yaitu X3, Xe hmgga léog.
Penempatannya seperti yang diperlihatkap pa.da Gambar 6.1a. Se angdan
dari pembacaan vertex AutoCAD dimulai dari Xo3, X75, ...Xog, X7g ... dan

seterusnya hingga yang terakhir, yaitu Xjs.

GY
Lo o

3 6 9 12 15 18

21 24 27 30 33 36

39 |42 45 48 51 54

57 60 63 66 69 72

75 78 81 84 87 90

93 96 99 102 1105 108

Gambar 6.1a Penomoran untuk translasi pada pelat
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Di sini kita perlu membangun suatu matriks baris (NJ x 1) yang berisi urutan
nomor translasi yang dibaca AutoCAD berdasarkan Gambar 6.1a. Sebagai
variabel bantu, program sudah mempunyai X(NJ x 1) yaitu berisi data
translasi dengan urutan 3, 6, 9, hingga 108. Jadi Anda diminta membangun
matriks baru (NJ x 1) dari X(NJ x 1). Matriks baris yang akan dicari,
misalnya dinamakan {Xr}. Untuk mendapatkan {Xt}, langkah pertama adalah
membuat dulu suatu matriks (6 x 6) atau (GY+1 x GX+1) yaitu untuk
menggambarkan model penomoran pada Gambar 6.1a, dimulai dari nodal di
sebelah kiri atas kemudian ke arah kanan. Perintahnya adalah:

a =3

For IT = 1 To GY + 1

For IJ = 1 To GX + 1

Mat(II, IJ) = X(a, 1)

a=a+ 3

Next IJ
Next II

Dengan demikian, isi komponen [Mat] adalah Mat (1,1) = X3, Mat (1,2) = X,
hingga Mat (6,6) = Xjos. Langkah kedua adalah membuat skema urutan
pembacaan AutoCAD di dalam [Mat] itu sendiri:

Ll 1,2 13 14 15 L6
M1 1
[Mat] = T\ 1 1

61 62 63 64 65 6,6

Dari skema tersebut dapat dibuat perintah berikut:

a=1
For 11 1 To GX + 1
For 1IJ GY + 1 To 1 Step -1

Xr(a, 1) = Mat(IJ, II) * Sc 'Sc adalah skala agar lendutan
tampak dalam gambar

a=a+ 1

Next IJ

Next II

Setelah membuat urutan pembacaan untuk lendutan translasinya (aksis-Z),
sekarang yang harus dibuat adalah koordinat grid pada aksis-X dan Y.
Perhatikan sebuah grid pelat pada Gambar 6.1b. Kuncinya di sini adalah,
setiap panjang elemen dalam grid diwakili oleh setiap panjang elemen pada
sisi atas dan samping pelat. Koordinat grid kemudian diperoleh dengan
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menjumlahkan panjang-panjang elemen tersebut. Setelah itu dium'Fkgn sesuai
pembacaan di AutoCAD, sama seperti dalam mengerjakan translasi di atas.

Elemen no: 1 2 3
6
17

28

39

Gambar 6.1b Grid pondasi pelat

Perintah selengkapnya untuk penggambaran AutoCAD adalah:

‘Membuat AutoCAD ScriptFile: MatFl.scr
'untuk plot Lendutan

‘Membuat urutan lendutan:
a =3

For I1 = 1 To GY + 1

For IJ = 1 To GX + 1

Mat (II, 1IJ) = X(a, 1)
a=a+ 3

Next IJ

Next II

1 To GX + 1

For IJ = GY + 1 To 1 Step -1
Xr(a, 1) = Mat(1Jg, II) * Sc
a=a+ 1

Next IJ

Next II

‘Membuat koordinat grid:

a=20

For IT = 1 To GY + 1

For IJ = 1 To GX + 1

LX(1J, 1, II) = a

Next IJ

a =a + L(II, 1)

Next ITI

For II = 1 To GY + 1

a=20

b= (GX + 1) + (GY - 1) * (GX + GX + 1)

For IJ = 1 To GX + 1
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LY(IJ, 1, II) = a

If I0 = GX + 1 Then GoTo 30 Else a = a + L(b, 1
b=Db- (GX + GX + 1) ) g
Next IJ

30 Next II

Open "c:\MatFl.scr" For Output As #1

Print #1, "_3dmesh®

Write #1, GY + 1

Write #1, GX + 1

d=20

c =1

For IT = 1 To GX + 1

a =20

For I0 = 1 To GY + 1

Print #1, LX(I1J, 1, I1) & "," & LY(IJ, 1, II) & "," & -Xr(c, 1)
c=c+ 1 '
a=a+1

Next IJ

d=4d + 1

Next II

Close #1

Sekgrang Jalankan program MATF. Setelah itu buka AutoCAD Anda.
Ketlkkan scr pada baris Command dan tekan Enter hingga keluar kotak
dlglog Select Script File. Pilih file MatF1.scr pada directory C, kemudian
klik Open atau tekan Enter. Isi script kemudian diplot pada layar. Gambar di
sini dikerjakan pada AutoCAD versi 2002.

Gambar 6.2 Kotak dialog Select Script File
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Untuk menampilkan gambar secara 3 dimensi, lakukan langkah berikut:

1. Dari menu View, klik 3D Views > Top.

2. Klik icon 3D Orbit . pada toolbar atau dari menu View > 3D Orbit.

3. Drag mouse pada kutub-kutub lingkaran orbit, hingga mendapatkan
tampilan yang Anda inginkan.

AntoLAL 2002 - Wramion). dreat

Gambar 6.3 Tampilan AutoCAD 2002 dengan 3D Orbit
Untuk melihat urut-urutan perintah penggambaran yang sudah dikerjakan
AutoCAD, tekan F2.

Sebenarnya ada altenatif lain untuk membuat script file (namun tidak
praktis), yaitu dengan membuat sebagian perintahnya di dalam worksheet,
karena output lendutan sudah tercetak di sana. Kemudian hasilnya dipanggil
dan diurutkan oleh VBA. Atau alternatif lainnya dengan membuat semuanya
secara manual dalam worksheet menggunakan fungsi CONCATENATE.
Setelah selesai kemudian di-copy dan di-paste di WIN Notepad. File
disimpan dengan ekstension .scr. Di sini nilai positif (+) untuk penggambaran
translasi yang berada di atas titik 0 (posisi awal) dan nilai negatif (—) untuk
sebaliknya. Oleh karena itu, kalikan hasilnya dengan -1 agar arah translasi
sesuai dengan arah pembebanannya.

Membuat script file pada AutoCAD tidak hanya digunakan untuk
penggambaran grafik dari hasil program atau membuat gambar struktur. Pada
aplikasi lain juga dapat digunakan untuk. pekerjaan topografi-survey,

147




pekerjaan cut and fill, membuat drilling log, dan sebagainya. Pada tingkat ini
tentunya diperlukan penguasaan software yang lebih baik.

Tampilan gambar 3D dalam Excel dapat juga diberikan di sini, namun hal ini
tentu tidak dapat diperbandingkan dengan tampilan AutoCAD. Gambar 6.4
dan 6.§ menunjukkan hasil contoh penggambaran Excel untuk lendutan
pondasi pelat. Ada beberapa hal di sini yang dapat dicatat.

Distribusi Lendutan (m)

A £30.00000-0.00100
[30.00100-0.00200
] | I ! J [30.00200-0.00300
J0.00300-0.00400

— / 10.00400-0.00500
\: [ 0 0.00500-0.00600
[10.00600-0.00700

Perspective 45° 00 06 12 18 24 30 [30,00700-0.00800
[00.00800-0.00800
[00.00900-0.01000

(meter)
™~
1]
L1

Gambar 6.4 Chart Excel untuk lendutan pondasi akibat beban vertikal

Distribusi Lendutan (m)

/ / / 0-0.02000-0.01600

} [1-0.01600--0.01200
| I [1-0.01200-0.00800

[3-0.00800-0.00400
{1-0.00400-0.00000

VNN commwomao

00 06 12 18 24 30  D0.004000.00800
[90.00800-0.01200

P " o
erspective 45 [710.01200-0.01600

[00.01600-0.02000

Gambar 6.5 Chart Excel untuk lendutan pondasi pelat akibat
beban vertikal dan momen

Penggambaran grafik 3D di Excel dibuat dengan menggunakan Chart type >
Surface. Satu serie data berisi sepasang data aksis-X dan Z, dan setiap serie
data mempunyai pengukuran yang sama pada aksis-Z. Format aksis-Z
kemudian dibuat dalam reverse order agar arah lendutan searah
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pembebanannya. Namun grafik di sini tidak mempunyai opsi untuk data pada
aksis-Y sehingga penggambaran lendutan hanya tepat untuk elemen grid
yang sama panjang.

Secara default Excel akan mengelompokkan data pada aksis-Z yang
mempunyai range sama. Setiap range dapat dibatasi alur-alur garis yang
memotong elemen grid dan dikelompokkan ke dalam warna tertentu, apabila
Anda memilih surface yang berwarna. Keuntungan pembagian ini adalah
memudahkan melihat daerah range nilai tertentu yang mungkin tidak kasat
mata dalam tampilan 3D.

Gambar 6.4 dan 6.5 memperlihatkan pondasi pelat dengan range
lendutannya. Untuk beban vertikal yang terpusat seperti dalam Gambar 6.4,
range lendutan akan simetris terhadap titik pusat pelat dan jika pada pelat
juga dikerjakan momen, hasilnya seperti Gambar 6.5. Jadi, jika translasi
berbanding lurus dengan tegangan tanah (soil pressure), lokasi tegangan yang
mempunyai nilai-nilai maksimum dengan mudah dapat diperiksa dalam
sistem koordinat pelat. Pada daerah ini tegangan tanahnya tidak boleh
melebihi daya dukung tanah pada daerah tersebut. Penggambaran ini akan
sangat membantu jika dikerjakan pada pelat-pelat yang relatif besar seperti
pondasi raft di atas permukaan tanah yang mempunyai deskripsi tanah yang

tidak seragam.

Penggambaran grafik tipe surface ini menjadi lebih maksimal jika kita juga
mengeluarkan hasil distribusi gaya geser dan momen dari elemen struktur.
Dan juga menjadi mudah untuk diperiksa arah distribusi gaya-gaya tersebut
secara keseluruhan (global struktur).
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BAB 7
LISTING PROGRAM

| 7.1 Visual Basic for Application

Visual Basic for Application (VBA) adalah bahasa pemrograman yang
diturunkan dari Visual Basic (VB) untuk pengembangan aplikasi macro.
Selain Microsoft Office, banyak software non-Microsoft yang sekarang ini
juga menggunakan VBA, sebut saja di antaranya AutoCAD, CorelDRAW,
Visio, Norton, dan sebagainya. Jadi VB tidak mempunyai kaitan khusus dan
bukan merupakan bagian internal dari Excel. VB membaca dan menganalisis
objek yang diekspos oleh Excel melalui perpustakaan objek (object library)
i yang terdapat di dalam Excel. Referensi untuk objek-objek tersebut disimpan
\ di Microsoft Excel 9.0 Object Library (EXCEL9.OLB). Dalam struktur
i pemrograman untuk suatu aplikasi perhitungan, Excel mengekspos objek
1 berupa referensi sel-sel data input untuk diproses oleh VB dan hasilnya
kemudian dikembalikan ke dalam worksheet. Jadi dalam penulisan input
program, yang dilakukan sebenarnya adalah menyimpan nilai objek dalam
variabel, atau nilai variabel = nilai referensi sel dari objek worksheet.

“ Cara terbaik untuk mengetahui bagaimana VB berkomunikasi dengan objek

‘ Excel adalah dengan merekam macro. Tool ini memberi pengenalan yang
cepat tentang semua objek Excel sekaligus cara menuliskan kode program
dalam VB. Sebagai contoh, kita akan merekam macro untuk menghapus data
pada suatu range sel. Anggap saja kita perlu membuat suatu otomasi langkah
untuk membersihkan data output yang lama, karena program akan mencetak
yang baru. Misalkan proses ini akan dikerjakan pada program BOF. Di sini
data output ditempatkan pada range sel D27:N39. Langkah-langkah untuk
merekam macro adalah sebagai berikut.

1. Kilik Record Macro
berikut ini.

pada toolbar, hingga muncul kotak dialog
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Record Macro

2. Ganti nama defaultnya menjadi HapusQutput, dan klik OK.

3. Sekarapg memulai proses merekam macro. Pilih range sel D27:N50
sebaggu data yang akan dibersihkan. Meskipun data ouput dalam contoh
ana.h.sm balok hanya pada range sel D27:N39, ada baiknya diambil lebih
dari itu untuk soal lain dengan jumlah elemen yang lebih banyak. Jadi
N50 diambil sementara sebagai range yang maksimum, atau setara
dengan data 23 finite element balok. ’

4. quan Delete untuk menghapus range sel D27:N50 kemudian tempatkan
pointer pada sel D27.

5. Akhiri proses ini dengan mengklik stop recording -

Macro yang dibuat disimpan di dalam workbook, dan untuk melihatnya

Anda harus membuka jendela Visual Basic Editor dengan Run Macro
HapusOutputd> Edit. Sebenarnya tidaklah sulit untuk memahami bahasa
macro yang ditampilkan di sini, karena sudah mencerminkan | -
langkah yang sudah kita lakukan. o fenglal

Option Explicit
Sub HapusOutput ()

HapusOutput Macro
Macro recorded 8/16/2003 by Guntar_P.

Range ("D27:N50") .Select
Selection.ClearContents
Range ("D27") .Select

End Sub

Sekarang lihat listing program BOF. Macro HapusOutput di sini ditempatkan

pada awal langkah program. Sekarang kembali ke worksheet. Jalankan BOF
agar data yang tadi dihapus dicetak kembali. Kemudian tempatkan pointer
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pada sembarang sel. Setelah siap, jalankan BOF sekali lagi, dan perhatikan
pada layar. Sesaat setelah program dijalankan, hasil output yang ada segera
terhapus dan pointer berada pada sel D27, dan secara hampir bersamaan pula
hasil output yang baru dari VB dicetak ke dalam worksheet.

o Rotation (rad)

I s SRS TR
TR . T e

5T nooer 8

T o002 8
N -0.00183 10
1 00074 12
13 000040: 14

s ogot0t. 16 -
17 0001081 18
19 000100 20

2t 000090 22
23 oooors 24
25 ... 000075 2

ooz

Dalam prosedur macro yang dibuat di atas terdapat kata-kata perintah atau
statement seperti Range(), Select, Selection, dan ClearContents. Statement
dapat dibedakan maknanya menurut istilah-istilah yang digunakan dalam VB.
Dalam bagian ini, Select dan ClearContents disebut dengan metode yaitu
tindakan yang dilakukan saat program dijalankan statement. Sedangkan
Range() dan Selection adalah statement yang merujuk pada objek, dalam hal
ini adalah objek Range. Bagian dari objek adalah propertinya, yaitu semua
atribut yang didefinisikan untuk objek tersebut.

Kode program di sini dibuat secara berurut, yaitu nama objek, tanda titik dan
diikuti properti atau metodenya. Properti selalu diikuti dengan sama dengan
(=) untuk memasukkan nilainya. Misalnya akan mendefinisikan lebar kolom
lebih besar dari ukuran standarnya, maka statement-nya adalah,
Columns ("C:C") .ColumnWidth = 10.0, artinya properti Columnwidth dari
kolom C ditetapkan nilainya menjadi 10.0. Pada contoh lain, misalnya akan
mendefinisikan nama suatu sel atau range sel, statement-nya adalah,
Range () .Name = "NamaRange" atau Cells().Name = "NamaSel".
Perintahnya sama kalau dikerjakan melalui menu Insert > Name > Define
atau Create. Hal ini sudah pernah dijelaskan pada bab awal buku ini. Supaya
macro dapat digunakan untuk setiap objek yang diseleksi, digunakan kata
Selection.
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Contoh:

Select@on.Font.ColorIndex = 3
Selection.CreateNames Top:=True,

Right:=False befti=False,

Bottom:=False,

Uptuk mempelajari setiap objek secara lengkap, Anda harus menam-
plllfannya secara fokus. Caranya dengan menyimpan objek ke dalam sebuah
variabel, sama seperti menyimpan sebuah nilai ke dalam variabel, yaitu
df:ngan menggunakan tanda sama dengan (=). Pada permulaan sta,tement
dlgunakqn kata kunci Set. Setelah itu digunakan Locals Windows untuk
menaqxpxlkan nilai dan tipe variabel tersebut. Misalkan, ambil variabel
myObject untuk menyimpan objek Range sel Al. Ketikkan’ teks ”Test Cell”
pada sel Al. Kemudian buat macro-nya sebagai berikut:

Sub StoreObject ()

Set myObject = R "Al”"
End Sub ’ ange ("A1T)

(Tambahkan Dim myObject sesudah Sub S j ji
i toreObject
menggunakan Option Explicit.) ect) g Anda

Dari menu VBA klik \"iew >.Locals Window dan jalankan macro dengan
mepekan F8. Tek'an tiga kali untuk menetapkan Range(”A1”) ke dalam
variabel. Locals Window akan tampak seperti berikut.

Option Explicit
Sub Storedbject ()
Dim myObject
__Set myObject = Range ("A1"
Eod b ? :

Variant/ObjsctiRange
Variant/Boolean
Application/Apphcation
AreasiAress
Borders/Borders
Range/Range

Variabel m}"Object tampak memiliki tanda plus di sebelah kiri dan tipenya
adalah Variant/Object/Range. Klik tanda plus pada variabel myOb'eyct
tersgbut. Sebuz}h daftar dengan semua properti objek Range sel Al munf:ul
Setiap properti menampilkan nilai atau mempunyai tanda plus di dekatnya.
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Properti dengan tanda plus adalah referensi untuk sebuah objek, sedangkan
yang tidak mempunyai tanda plus adalah sebuah nilai. Sekarang drag scroll
bar ke bawah hingga ke properti Value. Terlihat bahwa Value dari myObject
adalah string “Test Cell”. Anda dapat mengganti properti ini dari Locals
Windows dengan mengklik satu kali pada teks tersebut. Ganti nilainya
misalnya menjadi string "New” dan tekan Enter. Sekarang terlihat dalam
worksheet nilainya sudah berubah menjadi yang baru. Beberapa properti dari
Range A1 adalah read-only sehingga Anda tidak dapat mengubahnya.

Untuk melihat semua objek yang terdapat di ”Excel, Anda dapat mengakses

dari Object Browser dengan mengklik icon 2 pada toolbar VBA atau tekan
F2. Pilih perpustakaan Excel. Objek di sini digolongkan ke dalam kelasnya
(classes di sebelah kiri) sedangkan anggotanya adalah properti, metode,
fungsi dan sebagainya (members di sebelah kanan). Name, Cells,
FormulaArray, misalnya, merupakan properti dari objek Range. Sedangkan
dalam hierarkinya, Range menjadi properti dari objek Worksheet, dan
Worksheet menjadi properti dari objek Workbook.

Membuat program untuk aplikasi perhitungan sebenarnya sama dengan
membuat suatu prosedur macro untuk otomasi langkah-langkah pekerjaan di
dalam worksheet. Namun di sini VB lebih banyak mengerjakan prosedur
matematiknya dan hanya sedikit berhubungan dengan objek. Oleh karena itu,
nilai objek menjadi sangat strategis. Pada pemrograman mandiri, data input-
ouput ditempatkan dalam file-file sendiri (*.dat, * txt, *.out, dan sebagainya).
Sedangkan di Excel kita menempatkan data input-output di dalam worksheet.
Supaya data tersebut dapat disimpan-pakai, worksheet perlu diberi nama
seperti layaknya sebuah file data. Misalnya untuk suatu program di mana
terdapat 3 sheet data seperti terlihat pada Gambar 7.1, masing-masing dengan
nama Datal, Data2, dan Data3. Penulisan untuk referensi selnya adalah
Worksheets ("Datal®) .Cells () yaitu untuk membaca data pada sheet Datal,
atau Worksheets ("Data2") .Cells() untuk membaca sheet Data2, dan
seterusnya. Anda tidak perlu lagi menggunakan Worksheets () apabila data
input disimpan dalam nama defaultnya, seperti Sheetl, Sheet2, dan
seterusnya. Untuk mempercepat proses penggantian nama ini, Anda dapat
melakukan dengan tool Find # remudian klik Replace seperti
diperlihatkan pada Gambar 7.2. Jika tidak ada nama worksheet yang
ditunjuk, program secara otomatis akan memproses referensi sel dari
worksheet yang aktif (terbuka).
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:Conditio 2 1 =0Open Layered :
2=Half Closed Lavered
1. year(s) .

p= 017
th - Initial Pre
~tonim?
126
5.70
312
1.81
0.786
0.20

0. 007

Replace

Gambar 7.2 Tool Find and Replace untuk mengganti nama sheet data

7.2 Petunjuk Pemakaian Program

Eada }xlvgkt.u Andg membuka file program, akan keluar kotak pesan seperti di
d?1.\)vla ini. Pastlkag Anda mengklik Enable Macros agar macro dapat
bl_]a. gnk'fm‘ Pesan ini sebeqamya peringatan dari Excel mengenai macro yang
erisi virus komputer. Misalnya kalau Anda tidak yakin dengan sumb
macro tersebut, Anda dapat mengklik Disable Macro agar macro tidak aktiefr

Jika perlu, segera kel i i
yang};da. 2 eluar dari Excel dan periksa dengan program antivirus
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Dalam worksheet, data input dibedakan dengan diberi warna biru dari warna
defaultnya (hitam) untuk memudahkan proses memasukkan data. Pemberian
warna ini juga hampir selalu diikuti dengan melakukan proteksi pada sel,
supaya form program tidak terganggu (corrupted) akibat kesalahan
pemencetan tombol keyboard atau gangguan lainnya. Dengan demikian,
hanya sel dengan teks berwarna biru saja yang dapat diubah isinya. Membuat
proteksi sel dalam form berarti membebaskan sel input data dari proteksi
worksheet agar dapat menerima perubahan. Sedangkan bagian sel yang lain
akan diproteksi dan tidak dapat menerima perubahan, misalnya untuk sel-sel
yang menyimpan rumus-rumus atau yang berisi keterangan-keterangan

program.

Langkah-langkah untuk memproteksi sel adalah sebagai berikut.

1. Pilih sel atau range sel yang berisi data input (berwarna biru).

2. Klik Format > Cells hingga keluar kotak dialog Format Cells.

3. Klik tab Protection kemudian klik option Locked schingga tanda
centangnya hilang.

4. Klik OK.

5. Ulangi langkah 1 s.d. 4 untuk data input yang lain.

6. Kemudian proteksi worksheet dengan Tools > Protection > Protect
Worksheet. Tambahkan password jika memang dibutuhkan dan klik

OK untuk semua pilihan.

7. Untuk mengembalikan sheet lagi tanpa proteksi, dilakukan dengan Tools
> Protection > Unprotect Sheet.
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Condiia 2

0120
0.173 :(0.1667<p <0

nitial PreAfter (t) Pressure

. onim? - 1

Untuk menjalankan program, klik Run Macro * > program > Run atau
menggunakan Command Button yang sudah ditempatkan pada form. Waktu
yang diperlukan untuk memproses setiap soal bergantung pada data input
yang mempengaruhi besarmya ukuran array dalam formula matriks. Semakin
besar ukuran matriks, semakin banyak pula jumlah persamaan yang harus
diselesaikan, dan prosesnya memerlukan waktu pula.

Peringatan:

Program Excel di sini dibuat hanya untuk membaca data input pada
worksheet yang terbuka. Oleh karena itu, pastikan bukan sheet atau
workbook lain yang dibuka pada saat program dijalankan, karena dapat
menghapus data pada sheet tersebut. Supaya program hanya membaca data
pada file-nya sendiri, Anda harus menuliskan referensi sel dari worksheet
yang dimaksud. Caranya seperti yang sudah dijelaskan sebelumnya.

7.3 Listing Program

Semua listing program yang dilampirkan di bawah ini merupakan bagian dari
masing-masing form data input dan output yang dikerjakan di dalam
worksheet. Penulisan program dibuat berdasarkan format susunan data yang
ada dalam form, yang pada intinya dibuat seinteraktif mungkin dengan
pemakainya, sebagaimana apabila bekerja dengan Excel. Soal-soal yang ada
di sini adalah rekaan semata untuk keperluan contoh perhitungan.
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Sub FRAME2D()

'Program Frame Balok 2 Dimepsi - FRAME2D
‘dibuat oleh: Guntar Pingagliuan

! asarkan materi dalam buku ) o
‘ggigkasi Excel Untuk Rekayasa Teknik Sipil

Dim NP, NM, DOF As Integer

Dm = Cells(3, 2)
NP = Cells(4, 2)
NM = Cells(5, 2)
Ec = Cells(6, 2)
DOF = Cells(7, 2)

Dim A(NM, 1) As Double
ggDim T(6, 6, NM) As Double
ReDim TT(6, 6, NM) As Double
ReDim MK(6, 6, NM) As Double
ReDim GK (NP, NP) As Double
ReDim Index(DOF, 1) As Integer
ReDim Indexs (NP, NM) As Integer
ReDim GKP (NP, NP) As Double
ReDim GKS (6, DOF) As Double
ReDim P(NP, 1) As Double
ReDim P1(6, 6, NM) As Double
ReDim P2(6, 6, NM) As Double
ReDim L (NM, 1) As Double
ReDim EI(NM, 1) As Double
ReDim X (NP, 1) As Double
ReDim Xs(6, 1, NM) As Double
ReDim Xi(6, 1, NM) As Double
ReDim Pi(6, 1, NM) As Double
ReDim Rs(6, 1) As Double
ReDim ALPHA (NM, 1) As Double
ReDim SupM(6, 1) As Integer

‘Baca Input L, EI, A elemen
For II = 1 To NM

L(II, 1) = Cells(10 + II, 8)
Next II

II = 1 To NM
g?ill, 1) = Ec * Cells(10 + II, 10)

Next II

For II = 1 To NM
A(II, 1) = Cells(1l0 + II, 11)
Next II

'Baca sudut transformasi elemen
For II = 1 To NM

ALPHA(II, 1) = Cells(10 + IT, 12)
Next II

'Baca Input Beban P
For II = 1 To NP
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P(II, 1) =
Next II

Cells(18 + II, 2)

'Bangun [T]elemen

RAD = 180 / 3.14159265358979
For II = 1 To NM
T(1, 1 II) = Cos(ALPHA(I
( ) I, 1) / RAD):
gln(ALPHA(II, 1) / RAD): T{1, 3, II) = 0O: T}l Z(liz 2ot
T1211)1= 0: T(1, 6, II) = 0 ) AT = 0 T
. 1, TI) = -Sin(ALPHA(II, 1) /
, RAD) :
Cos (ALPHA(II, 1) / RAD): T(2, 3, II) = 0: ng 2“2£I SR
3, =0 T@, 6, 1T - 0 A D= 0T
’ , = 0: T(3, 2, II = :
gE4T(i' D =0T, 2 6,)11)[: gwa, 3, TI) = 1: T(3, 4, II) -
Cos}ALﬁHi%%I= f: T(4, 2, II) = 0: T(4, 3, II) = 0: T(4, 4, II) -
, 1) / RAD): T(4, 5, IT) - Sin(ALDH ) ) N
Qo5 (aLemA (LT, 1 A(II, 1) / RAD):
T(5, 1, II) = 0: T(5, 2, II)
T : ., 2, = 0: T(5, 3, II) = 0: T
Sin(ALPHA(ITI, 1) / RAD): T(5, 5, II) = Cos(ALPHA Bt Ay
ZSin(aLpEa (T, (II, 1) / RAD):
T(6, 1, II) = 0: T(6, 2, II)
( : , 2, = 0: T(6, 3, II) = 0:
0: T(6, 5, TI) = 0: T 0r TM6, 4. 1D -
Next II e 6 1 =1
'Bangun [K]elemen
For II = 1 To NM
M —
3$(%})1; %;)Mkf}unz 1;1; Ec / L(IT, 1): MK(1, 2, II) = 0: MK(1
éi)zz o5& 4 1) -A(II, 1) * Ec / L(II, 1): MR(1, 5.
ngz' é' ?i; - %:*MK(Z, 2, II) = 12 * EI(II, 1) / L(II, 1) +~ 3:
MK(2, 5, II) = -12 f”gfffll)l/ BT D N2 M@, 4 ID) < o
QKEi(II, 5 a1y , ) / L(IT, 1) ~ 3: MK(2, 6, II) = 6
MKE3I %, %%; - f:*MK(3, 2, II) = 6 * EI(II, 1) / L(II, 1) A 2:
MK, 3. IT) - EI(fg(Iia %> / L{II, 1): MK(3, 4, II) - 0: MK(3,
SI(II, SR L(II, 1) ~ 2: MK(3, 6, TII) = 2 =
Mggi 31,, IIJ'.I))::O~_A1\/I(I<I(I4, 14) ;IEc / L(II, 1): MK(4, 2, II) = O0:
gk(g1> SN S LT ) = A(II, 1) * Ec / L(II, 1): MK(4,
, 1, II) = 0: MR(S5, 2, IT) = -1
., 2, = -12 * EI(TI, 1 I
i o AL i e
;IKEE(IL 1 i he 2, ) / L(II, 1) ~ 3: MK(5, 6, II) = -6
MKE6: %f %%; N f:*Dg?f;I 21)I3)L?I$ *1FI(II' D B Y e
e S , , : MK(6, 4, II) = 0: MK(6,
2 S T 1) / L(IT, 1) » 2: MK(6, 6, II) =- 4 =
Next IT
'Transpose [T]--->[TT]elemen
For II = 1 To NM
For IJ = 1 To 6
For IK = 1 To 6
TT(IJ, IK, TT) = T(I
Next IK (T T 1)
Next IJ
Next IT
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'Bangun [Klelemen = [TT].[Klelemen. [T]
For II = 1 To NM
For IJ = 1 To 6
For IK = 1 To 6
P1(IJ, IK, II) =0
For IL = 1 To 6
p1(1J, IK, II) = P1(IJ, IK, II) + Tr(I1J, IL, II) * MK(IL, IK,
11)
Next IL
Next IK
Next IJ
For IJ = 1 To 6
For IK = 1 To 6
P2(1J, IK, II) =0
For IL = 1 To 6
P2(IJ, IK, II) = P2(IJ, IK, II) + pPl1(1J, IL, II) * T(IL, IK, II)
Next IL
Next IK
Next IJ
Next II
'Bangun [K]lglobal
For II = 1 To NP
For IJ = 1 To NP
GK(II, 1J) =0
Next IJ
Next II
'Subskrip [Klelemen pada [Klglobal
For II = 1 To NM
For IJ = 1 To 6
Indexs(IJ, II) = Cells(10 + II, 1+ IJ)
Next IJ
Next II
For I1 = 1 To NM
For IJd = 1 To 6
For IK = 1 To 6
GK (Indexs (1J, I1), Indexs (IK, 11)) = GK (Indexs (1J, 11),
Indexs (IK, II)) + P2(I1J, IK, 11)
Next IK
Next IJ
Next II
'partisi [GK]--->[GKP]
For II = 1 To DOF
Tndex(II, 1) = Cells(7, 2 + II)
Next II
For II = 1 To DOF
For IJ = 1 To DOF
GKP (Index(II, 1), Index(IJ, 1)) = GK (Index (II, 1), Index(1J, 1))
GKP(II, IJ) = GKP(Index(II, 1), Index(IJ, 1))
Next IJ
Next II
'Invers [GKP]
For II = 1 To DOF
For IJ = 1 To DOF
If IJ <> II Then GKP(II, I1J) = GKP(II, 1J) / GKP(II, II)
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Next IJ ‘Cetak {P}1

For IK = 1 To DOF ?gi %§ = % %g EM
For %g £K1=TgIDg?en coto 10 Cells(18 + II, 5 + IJ) = Pi(1J, 1, II)
If IJ <> IT Then GKP(IK, IJ) = GKP(IK, IJ) - GKP(II, I1J) Next %g
* GKP(IK, II) Next
Next IJ
10 §§§t1§K~ 1 To DOF Mencar i reakSi'pgrlegakggrletakan
P ' ada
If IK <> II Then GKP(IK, II) = -GKP(IK, II) / GKP(II, Melakukan partisl p
II)
For II = 1 To 6
Next IK
GKP(II, II) = 1 / GRP(II, II) SupM(II, 1) = Cells(8, 1 + II)
Next II Next II
For II = 1 To DOF
' For IJ = 1 To 6
Fg§n$¥tﬁnls;£u§8;r {X} = [GKP]*-1.{P} GKS(IJ, II) = GK(SupM(IJ, 1), Index(II, 1))
X(Index(II, 1), 1) =0 Next %g
For IJ = 1 To DOF Next
- .
§E§232§§%§' 1})'1)1) = X(Index(Il, 1), 1) + GKP(IT, 1J) ‘Reaksi di nodal perletakan
ﬂiiﬁ %g For II = i go gOF
IJ = (¢)
Cetak {X} ggr(l:[ 1) = Rs(II, 1) + GKS(II, 1J) * X(Index(I1J, 1), 1)
‘Ceta '
For II = 1 To NP NexE ;g
Cells (18 + II, 3) = X(II, 1) Nex
Next II
For II = 1 To 6
- M(II, 1), 1)
'Penomoran {X}(NP,1) menjadi {X}s(6,1) Celtsé%G, 4 + II) = Rs(II, 1) P (SupM(
For II = 1 To NM Nex
For IJ = 1 To 6
Xs(IJ, 1, II) = X(Indexs(IJ, II), 1) End Sub
Next IJ
Next II
'Transformasi {X}s ke koordinat elemen
{X}i=[T].{X}s
F ITI = 1 To NM
ng IJ = 1 Tg 6 Sub TRUSS()
Xl(IJ’ l, II) z O ' e Emmm——=——=Z=TCS=SS=S=SSS=SSS=S=SS=S=E=3F
For IK = 1 To 6 T 11 an - TRUSS
i i ! ram Analisa Rangka Batang
X1(1J, 1, I1) = Xi(IJ, 1, II) + T(1J, IK, TI) * Xs(IK, 1, IT) ,giggat oleh: Guntar Pangaribuan
Newt 13 'perdasarkan materi dalam buku & Sipil
Next %g ‘Aplikasi Excel Untuk Rekayasa Tekni ip1
o ‘Rev.l /2002 —==—z==—=====S======
"{P}i=[K]i.{X}i eo===—====s=========s===
ggi %i : % $g EM Dim NP, NM, DOF As Integer
otk Lt 2 O b - Cells(3, 2)
Pi(IJ, 1, II) = Pi(IJ, 1, II) + MK(IJ, IK, II) * Xi(IK, 1, II) NP = Ce}isis, 3
Next IK NM = Cells (5,
Next IJ Ec = Cells(6, 2)
Next II DOF = Cells(7, 2)
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ReDim A(NM, 1) As Double
ReDim T(4, 4, NM) As Double
ReDim TT (4, 4, NM) As Double
ReDim MK(4, 4, NM) As Double
ReDim GK(NP, NP) As Double
ReDim Index(DOF, 1) As Integer
ReDim Indexs (NP, NM) As Integer
ReDim GKP (NP, NP) As Double
ReDim GKS (4, DOF) As Double
ReDim P(NP, 1) As Double
ReDim P1(4, 4, NM) As Double
ReDim P2(4, 4, NM) As Double
ReDim L(NM, 1) As Double
ReDim EI(NM, 1) As Double
ReDim X (NP, 1) As Double
ReDim Xs(4, 1, NM) As Double
ReDim Ps (6, 1, NM) As Double
ReDim Xi(6, 1, NM) As Double
ReDim Pe (6, 1, NM) As Double
ReDim Pi(6, 1, NM) As Double
ReDim Rs(4, 1) As Double
ReDim ALPHA(NM, 1) As Double
ReDim SupM(4, 1) As Integer

'Baca Input L, EI, A elemen
For II = 1 To NM

L(II, 1) = Cells(18 + II, 8)
Next II

For II = 1 To NM

A(II, 1) = Cells(18 + II, 9)
Next II

'Baca sudut transformasi elemen
For II = 1 To NM

ALPHA(II, 1) = Cells(18 + II, 11)
Next IT

‘Baca Input Beban P

For II = 1 To NP

P(II, 1) = Cells(35 + II, 2)
Next IT

'Bangun [T]elemen

RAD = 180 / 3.14159265358979

For IT = 1 To NM

T(1, 1, II) = Cos(ALPHA(II, 1) /  RAD): T(1, 2, 11) =
Sin(ALPHA (II, 1) / RAD): T(1, 3, II) = 0: T(1, 4, II) =0

T(2, 1, TII) = -Sin(ALPHA(II, 1) / RAD): T(2, 2, 1II) =
Cos (ALPHA(II, 1) / RAD): T(2, 3, II) = 0: T(2, 4, II) =0

T(3, 1, II) = 0: T(3, 2, II) = 0: T(3, 3, II) = Cos(ALPHA(II, 1)
/ RAD): T(3, 4, II) = Sin(ALPHA(II, 1) / RAD)

T(4, 1, II) = 0: T(4, 2, II) = 0: T(4, 3, II) = -Sin(ALPHA(II,
1) / RAD): T(4, 4, II) = Cos(ALPHA(II, 1) / RAD)

Next II

'Bangun [K]elemen
For II = 1 To NM
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= MK (1,
MK(1, 1, II) = A(II, 1) * Ec / L(IT, 1): MK(l&)ZL %I) 0 (
3, T0) L -A(II, 1) % e / LT, 1): MK(L, 4, TD) =0 o o0
Mk(z, 1, 11) = 0: MK(2, 2, II) = 0: MK(2, 3,

S0 0:
=% 11y - A, 1 * Ec / LUIL, 1): MK, 20 1)
ﬁ§§3 3/ 10) < A(TI, 1) * Bc / LOT, s MKG, 4 31 =0 0
MK(4, 1, TII) - 0: MK(4, 2, II) = 0: MK(4, 3,

II) = 0
Next II

'Transpose [T]--->[TT]elemen
For II = 1 To NM
For IJ = 1 To i
For IK = 1 To
TT(IJ, IK, II) = T(IK, I1IJ, II)
Next IK
Next IJ
Next II

'Bangun [Klelemen = [TT].[Klelemen. [T]
For II = 1 To NM

For IJd = 1 To 4

For IK = 1 To 4

P1(IJ, IK, II) = 0

E Y , 1K,

g?ﬁléL —IKl TIOI) - P1(IJ, IK, II) + T (IJ, IL, II) * MK(IL
11)

Next IL

Next IK

Next IJ

For IJ = 1 To 4

For IK = 1 To 4

P2 (1IJ, IK, II)4= 0 .

1 I

gg?léL EKl ?g) = P2(IJ, IK, II) + P1(IJ, IL, II) * T(IL, IK,
Next IL

Next IK

Next IJ

Next II

‘Bangun [K]global

For II = 1 To NP

For IJ = 1 To NP

GK(II, IJ) =0

Next IJ

Next IT

'Subskrip [Klelemen pada [Klglobal

For II = 1 To gM

For IJ = 1 To

Indexs (IJ, II) = Cells(18 + II, 1+ IJ)

Next IJ

Next IT

For II = 1 To NM

For IJ = 1 To i .

=1 To ) . ,

g;fligexs(IJ, 11), Indexs (IK, 11)) = GK (Indexs (

Indexs (IK, II)) + P2 (I1J, IK, II)

Next IK
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Next IJ

Next II

'Partisi (GK]--->[GKP]
c = -1

For II 1 To DOF

For IJ = 1 To 2

If IT + IJ + ¢ > DOF Then GoTo 5 Els
Cells(6 + II, 2 + IJ)

Next IJ

c=c+ 1

Next II

e Index(II + IJ + ¢, 1) =

5 For II = 1 To DOF
For IJ = 1 To DOF

GKP (Index(II, 1), Index(IJ, 1)) = GK (Index(II, 1)

Index(1J,
1))

GKP(II, IJ) = GKP(Index(II, 1), Index(IJ, 1))
Next IJ
Next II

'Invers [GKP]
For II = 1 To DOF
For IJ = 1 To DOF

If IJ <> II Then GKP(II, IJ) = GKP(II, IJ) / GKP(II, II)
Next IJ

For IK = 1 To DOF
If IK = II Then GoTo 10
For IJ = 1 To DOF

If IJ <> II Then GKP(IK, IJ) = GKP(IK, IJ) - GKP(II,
* GKP(IK, II)

Next IJ
10 Next IK
For IK = 1 To DOF
If IK <> II Then GKP(IK, II)

1J)

= ~-GKP(IK, II) / GKP(II,
I1)
Next IK
GKP(II, II) =1 / GKP(II, II)
Next II
'Lendutan struktur {X} = [GKP]+-1.{P}
For IT = 1 To DOF
X(Index(II, 1), 1) =0
For IJ = 1 To DOF
X(Index(II 1), 1) = ZX(Index(II, 1), 1) =+ GKP(II, 1J) *
P(Index(IJ, 1), 1)
Next IJ
Next II
'Cetak {X}
For II = 1 To NP
Cells (35 + II, 3) = X(II, 1)
Next II

'Penomoran {X} (NP,1) menjadi {X}s(4,1)
For IT = 1 To NM

For IJ = 1 To 4

Xs(1IJ, 1, II) = X(Indexs(1J, II), 1)
Next IJ

Next II

166

For II = 1 To NM
For IJ = 1 To 4
Xi(I1J, 1, II) : 0 -
Zqing 1 llg? - Rxi(1J, 1, II) + T(IJ, IK, II) * Xs(IK, 1,
1 2 ’ -
Next IK
Next IJ
Next II )
"{P}i=[K]i.{X}1
For II = 1 To NM
For IJ = 1 To 4
pi (13, 1, II) ; 0 Lo
Por K MT) - pi(g, 1, ID) + MK(1J, IK, IT) * Xi(IK, 1,
1 ' ’ -
Next IK
Next IJ
Next II

'Cetak {P}i
FOrII:lTOZTM

r 1IJ = 1 To .
cel15(35 + 11, 5 + 13) = Pi(IJ, 1, ID)
Next IJ
Next TII

i i kan
‘Mencari reaksi pgrleta
‘Melakukan partisi pada perletakan

For IT = 1 To 4
SupM(II, 1) = Cells(16, 1 + II)

Next II
For II = 1 To DOF
IJ =1 To 4
GKS(IT, 1) = GK(SupM(1J, 1), Index(II, 1))
Next IJ
Next IT

‘Reaksi di nodal perletakan

For 11 = 1 Mo por 1)
P 1 ) . TRe(lL, 1) + GKS(II, 1J) * X(Index(I1J, 1),
Next IJ

Next II

=1 To 4
EZ§1§536, 10 + II) = Rs(II, 1) - P(SupM(II, 1), 1
Next II

End Sub
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Sub BOF ()

T

i ‘Bangun Matriks [Alelemen

For II = 1 To NM

- : 1, 4
S1 II) = 0: MA(1, 3, II) = 0: MA(L, 4,
'Program Analisa Balok di Atas Medium Elastis - BOF ! MA;l, é, II) = 1: MA(l, 2, ) L A2
‘dibuat oleh: Guntar Pangaribuan I1) = MA(2, 2, II) = 1 / L(IT, : 4
'berdasarkan materi dalam buku MA(2, 1, II) = ;— Q L&gﬁ'zlg (
'Aplikasi Excel Untuk Rekayasa Teknik Sipil 3, I1) = 1: MA( 5 ﬁA(3 2, II) = 1: MA(3, 3, II) = 0: MA(3, 4,
'Rev.1l /2002 MA(3, é. 11) = O: vl o
‘:=::======::=====::========::=:=====:==:======::=: IZEUJ;)“}: 1 11) = -1 / L(II, 1): i’IA(4, 2, II1) = -1 / L{II,
s - 0: , II) =
Range ("D27:N50") .Select MA(4, 3, II) = 0: MA(4, 4 )
Selection.ClearContents | Next II
R "D27") .
ange ("D27") .Select ‘ ‘Bangun Matriks (S]elemen
NP = Cells(3, 2) | For II = 1 To NM 1) / L(II, 1): MS(1, 2, II) = 2 *
NM - Cells(d, 2) | ws(1, 1. IT) = 4 B ) S Msil, 4, D) = 0 .
Ee - Cells(e, 2y ‘ M1 T e, D 7 wion, b mste, 2, 1D = 4
' MS(2, , = ' . 4, II) =

. , 3, II) = 0: MS(2, 4, X

ReDim MA(4, 4, NM) As Double EI(II, 1) / L(II, 1): MS(2 - 0: MS(3, 3, TI) = K(1, 1, II):
: 1, II) = 0: MS(3, 2, II) :

ReDim TMA(4, 4, NM) As Double MS(3, 1, 0
ReDim MS(4, 4, NM) As Double MS(3, 4, II) = 0: MS(4, 2, II) = 0: MS(4, 3, II) = 0: MS(4, 4,
ReDim MAS(4, 4, NM) As Double MS(4, 1, II) = % roe
ReDim MSAT(4, 4, NM) As Double II) = K(2, 1, II
ReDim ASAT (4, 4, NM) As Double Next II

ReDim GASAT (NP, NP) As Double
ReDim Indexs (NP, NM) As Double
ReDim L(NM, 1) As Double

ReDim K(2, 1, NM) As Double
ReDim KS(NP / 2, 1) As Double
ReDim EI(NM, 1) As Double
ReDim P(NP, 1) As Double

ReDim X (NP, 1) As Double

ReDim Xi(4, 1, NM) As Double
ReDim F(4, 1, NM) As Double

'Baca Input L, EI, K elemen
For II = 1 To NM

L(II, 1) = Cells(11l + II, 6)
Next II

For II = 1 To NM

K(1, 1, II) = Cells(1l + II, 10)
K(2, 1, II) = Cells(11l + II, 11)
Next II

For II = 1 To NP / 2 - 1
KS(II, 1) = Cells(11l + II, 9)
Next II
KS(NP / 2,
1)

1) = Cells (11l +

For II = 1 To NM
EI(II,
Next II

‘Baca Input Beban P
For II = 1 To NP

P(II, 1) = Cells(26 + II, 2)
Next IT
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(NP / 2 1), 9

1) = Cells(11l + II, 8) * Ec

'Transpose [A]
For II = 1 To NM
For Id = 1 To 4
For IK = 1 To 4

TMA (IJ, IK, II) = MA(IK, IJ, II)

Next IK

Next IJ

Next II

'Bangun ASAT elemen
For II = 1 To NM

For 1J = 1 To 4
ForIK=1T04
MAS(IJ, IK, II) =0
MRS (10 "k T%I% - MAS(IJ, IK, II) + MA(ILJ, IL, IT) * MS(IL, IK,
I1)

Next IL

Next IK

Next IJ

For IJ = 1 To 4

For IK = 1 To 4
ASAT(IJ, IK, II) =0

‘asumsi = KS (NP/2 - - 1 To 4

For =

ASAT (IJ, IK, II) = ASAT(IJ, IK,
Ik, II)

Next IL

Next IK

Next IJ

Next II

‘Bangun ASAT global
For II = 1 To NP
For IJ = 1 To NP

II) + MAS(IJ, IL, II) * TMA(IL,
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7444‘_______—________—___________———--———————-—-—1’—___________,

GASAT(II, IJ) = O
Next IJ
Next II

'Subskrip ASAT elemen pada ASAT global
For IT = 1 To NM
For IJ = 1 To 4

Indexs(IJ, II) = Cells(1l + II, 1 + IJ)
Next IJ

Next II

For II = 1 To NM

For IJ0 = 1 To 4

For IK = 1 To 4

GASAT (Indexs(IJ, 1II), Indexs(IK, TII)) = GASAT (Indexs (I1IJ, 1II),
Indexs (IK, II)) + ASAT(IJ, IK, II)

Next IK

Next IJ

Next II

‘Invers ASAT global

For II = 1 To NP

For IJ = 1 To NP

If IJ <> II Then GASAT(II, IJ) = GASAT(II, IJ) / GASAT(II, II)
Next IJ

For IK = 1 To NP

If IK = II Then GoTo 20

For IJ = 1 To NP

If IJ <> II Then GASAT(IK, IJ) = GASAT(IK, IJ) - GASAT(II, IJ) *
GASAT (IK, II)
Next IJ

20 Next IK
For IK = 1 To NP

If IK <> II Then GASAT (IK, II) = -GASAT(IK, II) / GASAT(II, II)
Next IK

GASAT(II, II) = 1 / GASAT (II, II)

Next II

'Lendutan pondasi {X} = [GASAT]*-1.{P}

For IT = 1 To NP

X(II, 1) =0

For IJ = 1 To NP

X(II, 1) = X(II, 1) + GASAT(II, IJ) * P(IJ, 1)
Next IJ

Next II

'Cetak {X}:

a = 1 ' untuk rotasi akibat momen

b = 2 ' untuk translasi akibat gaya vertikal
¢ = 1 ' untuk tegangan tanah akibat diberikan translasi
For IT = 1 To NP / 2

Cells (26 + II, 4) = a

Cells (26 + II, 5) = X(a, 1)

Cells (26 + II, 6) = b

Cells (26 + II, 7) = X(b, 1)

Cells (26 + II, 8) = ¢

Cells(26 + II, 9) = KS(II, 1) * X(b, 1)

a=a + 2

b=Db+ 2

c=c+1
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Next II

' penomoran {x}NP x 1 menjadi {xi}4 x 1
n=1

For II 1 To NM

For IJ 1 To 4

Xi(1J, 1, II) = X(n, 1)
n=n=+1

Next IJ

n=n-2

Next II

‘Gaya dalam elemen {F}i = [S].[A]}T.{Xi}
For II = 1 To NM
For 1J = 1 To 4
For IK = 1 To 4
MSAT (IJ, IK, Ii) =0
IL = 1 To ,
;ggT(IJ, IK, II) = MSAT(1J, 1K, II) + MS(1J, IL
IK, II)
Next IL
Next IK
Next IJ
For IJ = 1 To 4
F(1J, 1, II) = 0

II) * TMA(IL

l= ’ i , II
§?§J1L1 %I?O= F(1J, 1, II) + MSAT(IJ, IL, II) * Xi(IL, 1 )
Next IL
Next IJ
Next IT
‘Cetak {F}i
a=1

For II = 1 To NM
Cells (26 + I1II, 10) = a

23 Then : GoTo 40
§2r1§J>= 3 Then Cells(26 + II, 10 + 1J) = F(1J, 1, II) lo}

Cells(26 + II, 10 + IJ) = F(IJ, 1, II)
40 Next IJ

a=a+1

Next II

End Sub

’
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Sub WALL ()

'Program Analisa Dinding Penahan Tanah - WALL
‘dibuat oleh: Guntar Pangaribuan

‘berdasarkan materi dalam buku

'Aplikasi Excel Untuk Rekayasa Teknik Sipil
'Rev.1l /2002

Range ("D27:050") .Select
Selection.ClearContents
Range ("D27").Select

NM = Cells(4, 2)
NP = Cells(3, 2)
Ec = Cells (6, 2)

ReDim MA(4, 4, NM) As Double
ReDim TMA (4, 4, NM) As Double
ReDim MS(4, 4, NM) As Double
ReDim MAS(4, 4, NM) As Double
ReDim MSAT (4, 4, NM) As Double
ReDim ASAT(4, 4, NM) As Double
ReDim GASAT (NP, NP) As Double
ReDim L(NM, 1) As Double

ReDim K (2, 1, NM) As Double
ReDim KS(NP / 2, 1) As Double
ReDim EI(NM, 1) As Double
ReDim P(NP, 1) As Double

ReDim X (NP, 1) As Double

ReDim Xi(4, 1, NM) As Double
ReDim F(4, 1, NM) As Double
ReDim Indexs(4, NM) As Double

‘Baca Input L, EI, K elemen
For II = 1 To NM

L(II, 1) = Cells(1l1l + II, 6)
Next II

For ITI = 1 To NM

K(1, 1, II) = Cells(11 + II, 11)

K(2, 1, II) = Cells(1l1l + II, 12)

Next II

For IT = 1 To ((NP / 2) - 1)

KS(II, 1) = Cells(1l1l + II, 10)

Next IT

KS(NP / 2, 1) = Cells(11 + (NP / 2 - 1), 10)
- 1)

For IT = 1 To NM
EI(II, 1) = Cells(11l + II, 8) * Ec
Next II

'Baca Input Beban P

For IT = 1 To NP
P(II, 1) = Cells{(26 + II, 2)
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Next II

'Bangun Matriks [A]elemen
For ITI = 1 To NM

MA(1, 1, II) = 1: MA(1, 2, II) = 0: MA(1l, 3, II) = 0: MA(1l, 4,
§i12= 2, II) = 1 / L(II, 1): MA(2Z, 2, II) = 1 / L(IT, 1): MA(2,
) « 1: MA(2, 4, II) = 0 .

ﬁA(g?)l, II) = 0: MA(3, 2, II) = 1: MA(3, 3, II) = 0: MA(3, 4,
;;14? %, I1) = -1 / L(II, 1): MA (4, 2, II) = -1/ L(1I, 1)
MA(4, 3, IT) = O: MA(4, 4, II) = 1
Next II
'Bangun Matriks [S]elemen

= 1 To NM ) .
llj[gr(l?ll, II) = 4 * EI(II, 1) / L(II, 1): MS(1,12: %I) = 2
EI(II, 1) / L(II, 1}: MS(1, 3, II) = 0: MS(1, 4,21 g = ) - a
Ms(2, 1, II) = 2 * EI(II, 1) / L(II, 1): MS(,I % =
EI(II, 1) / L(II, 1): MS(2, 3, II) = 0: MS(2, 4, I J é(l N -
MS(3, 1, IT) = 0: MS(3, 2, II) = 0: MS(3, 3, 11) = , ,

3, 4, I1I) =0 ) ) '
ﬂ224, 1, II) = 0: MS(4, 2, II) = 0: MS(4, 3, II) = 0: MS(4, 4
II) = K(2, 1, II)

Next IT

‘Transpose [Alelemen
For II = 1 To NM
For IJ = 1 To 4

For IK = 1 To 4

TMA(IJ, IK, II) = MA(IK, IJ, II)
Next IK

Next IJ

Next II

‘Bangun ASAT elemen

For II = 1 To NM

For IJ = 1 To 4

For IK = 1 To 4

MAS(IJ, IK, II) =0

=1 To 4
e S(Is, 1K, II) = MAS(IJ, IK, TI) + MA(LJ, TL, II) * MS(IL, IK,

11)
Next IL
Next IK
Next IJ
For IJ = 1 To 4
For IK = 1 To 4
ASAT(IJ, IK, Ii) =0
= 1 To *
igiTﬁgJ, K, IT) = ASAT(IJ, IK, IT) + MAS(IJ, TIL, II) * TMA(IL,
IK, II)
Next IL
Next IK
Next IJ
Next II
'Bangun ASAT global
For ITI = 1 To NP
For IJ = 1 To NP
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GASAT(II, IJ) = 0
Next IJ
Next II

'Subskrip [K]elemen pada [K]global
For II = 1 To NM
For I0 = 1 To 4

Indexs (IJ, II) = Cells(1l + II, 1 + IJ)
Next IJ

Next II

For II = 1 To NM

For IJ = 1 To 4

For IK = 1 To 4

GASAT (Indexs (IJ, II), Indexs(IK, II)) = GASAT(Indexs(IJ,
Indexs (IK, II)) + ASAT(IJ, IK, II)

Next IK

Next IJ

Next II

‘Invers ASAT global

For II = 1 To NP

For IJ = 1 To NP

If IJ <> II Then GASAT(II, IJ) = GASAT(II, IJ) / GASAT (ITI,
Next IJ

For IK = 1 To NP

If IK = II Then GoTo 20

For IJ = 1 To NP

If IJ <> II Then GASAT(IK, IJ) = GASAT(IK, IJ) - GASAT (II,
GASAT (IK, II)
Next IJ

20 Next IK
For IK = 1 To NP

If IK <> II Then GASAT (IK, II) = -GASAT(IK, II) / GASAT(II,
Next IK

GASAT(II, II) = 1 / GASAT(II, II)

Next II

'Lendutan dinding {x} = [GASAT]*-1.{P}

For IT = 1 To NP

X(II, 1) =0

For IJ = 1 To NP

X(II, 1) = X(II, 1) + GASAT(II, IJ) * P(IJ, 1)
Next IJ

Next II

"Cetak {x}:

a 1 ' untuk rotasi akibat momen

b 2 ' untuk translasi akibat gaya vertikal
c 1 ' untuk tegangan tanah akibat diberikan translasi
For IT = 1 To NP / 2

Honon

Cells (26 + II, 4) = a

Cells (26 + II,.5) = X(a, 1)

Cells(26 + II, 6) = b

Cells (26 + II, 7) = X(b, 1)

Cells (26 + II, 8) = c

Cells(26 + II, 9) = KS(II, 1) * X(b, 1)
a=a+ 2

b=Db+2
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i1),

II)

IJ) *

II)

c=c+ 1

Next II

‘Penomoran {x}NP x 1 menjadi {xi}4 x 1
n=1

For IT = 1 To NM

For IJ = 1 To 4

Xi(1J, 1, II) = X(n, 1)

n=mn+1

Next IJ

n=n-2

Next II

'Gaya dalam elemen {F}i = [S].I[A]T.{xi}
For I1 = 1 To NM

For IJ = 1 To 4

For IK = 1 To 4

MSAT(IJ, IK, II) =0
For IL = 1 To 4

MSAT(IJ, IK, II) = MSAT{(IJ, IK, II) + MS(IJ, IL, II) * TMA(IL,
IK, II)
Next IL
Next IK
Next IJ
For IJ = 1 To 4
F(IJ, 1, II) =4O
IL = 1 To )
E??J, 1, II) = F(IJ, 1, II) + MSAT(IJ, IL, II) * Xi(IL, 1,
Next IL
Next IJ
Next II
‘Cetak {F}i
a =1

For II = 1 To NM
Cells(26 + II, 10) = a
For IJ = 1 To 4

1f IJ »= 3 Then Cells(26 + II, 11 + IJ) = F(IJ, 1, II): GoTo 40

Cells(26 + 1I, 10 + 1J) = F(IJ, 1, TT)
40 Next IJ

a=a+ 1

Next II

End Sub
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|
J“ Sub MATF () Next II

il
“ '==:===========:===============:=======:=== For 11 = 1 To NM * |
] 'Program Analisa Pondasi Pelat - MATF EI(II, 1) = Cells(13 + II, 10) ¢
| ‘dibuat oleh: Guntar Pangaribuan J(II, 1) = Cells(13 + II, 11)
ﬂ\ 'berdasarkan materi dalam buku Next II
| ‘Aplikasi Excel Untuk Rekayasa Teknik Sipil ; .

'Rev.1l /2002 'Baca sudut transformasi elemen

SS==============sssz==c-s--s=cssssoccccmcssos ‘ For II = 1 To NM
ALPHA(II, 1) = Cells(13 + II, 12)

1 Range ("U14:AI73") .Select Next II
: Selection.ClearContents
W Range ("Ul4") .Select ‘Baca Input Beban P
| a=20
1 GX = Cells(3, 2) For II = 1 To gJ
j GY = Cells(3, 3) For IJ = 1 To

NP = Cells(4, 2) P(IT + a, 1) = Cells(13 + II, 16 + 1{)
| NM = Cells(5, 2) If IJ >= 3 Then GoTo 5 Else a = a +
i NJ = Cells(6, 2) . Next IJ

Ec = Cells(9, 2) 5 Next II
| G = Cells(5, 7) Jel
| w = Cells (3, 7) 'Bangun [Alelemen

Sc = Cells(10, 2) rad = 180 / 3.14159265358979

; For II = 1 To NM . = 0: MA(1,

d ReDim MA(6, 5, NM) As Double ! MA(1, 1, II) = -Sin(ALPHA(II, l)<{ FﬁﬁX(lMAil'Iis E;)o MA(Ll, 5,
% ReDim TMA(5, 6, NM) As Double 3, II) = -Cos(ALPHA(II, 1) / rad): o

ReDim MS(5, 5, NM) As Double i II) = 0 . = 0: MA(2,
fw ReDim MAS(6, 5, NM) As Double 1 wA(2, 1, 11) = COS(ALPHA(IL, 1) [ xad): MA(Z. 2. 1) = 0 0ne
% ReDim MSAT(5, 6, NM) As Double 3, II) = -Sin(ALPHA(II, 1) / rad): n
I 3 -
| ReDim ASAT(6, 6, NM) As Double I1) =0 5 = / L(II, 1): MA(3,
%‘ ReDim GASAT (NP, NP) As Double WA(3, 1, ID) = 1/ LOI, 1): MR, 2, T1) = &
‘ ReDim L(NM, 1) As Double 3, I1) = 0: MA(3, 4, TD) = -1t MRS, 5 B0 1) ) rad): wmale,
d ReDim LX(GX + 1, 1, GY + 1) As Double MA(4, 1, II) = 0: MA(4, 2, Il)d'. MA(4, 4, II) = 0: MA(4, 5, II)
j ReDim LY(GY + 1, 1, GX + 1) As Double 3, II) = Cos(ALPHA(II, 1) / rad): n s
! ReDim K(2, 1, NM) As Double =0 d): MA(5,
i ReDim Ks (NJ, 1) As Double MA(5, 1, II) = 0: MA(5, 2, TI) = SLKS(EALzHA(IIII)’j)O:/M;a(S), 5, II)
1 ReDim EI(NM, 1) As Double 3, II) = Sin(ALPHA(II, 1) / rad): R
; ReDim J(NM, 1) As Double =0 A — L(II, 1):
’ ReDim P(NP, 1) As Double MA(6, 1, II) = -1 / L(II'II%); gé(ﬁé(g' 511}1) o
k ReDim X(NP, 1) As Double MA(6, 3, II) = 0: MA(6, 4, =0 n
| ReDim Xi (6, 1, NM) As Double Next II

ReDim Xr(NJ, 1) As Double
ReDim F(5, 1, NM) As Double
ReDim ALPHA(NM, 1) As Double
ReDim Indexs(6, NM) As Integer
ReDim Mat (6, 6) As Double
‘Bangun [S]lelemen

f ' , ' F ITI = 1 To NM . - 2 *
v For 1T o1 T ¢ o MS(1, 1, ID = 4 * EIOT, 1)/ DO L): MS(L 20 TD) S 2
| L(II, 1) = Cells(13 + II, 8) EI(II, ]_)O/ L(IT, 1): MS(1l, 3, II) = O: . 4,
= — *
| Nexe II ié(gl)l, IT) = 2 * BI(II, 1) / L(II, 1): MS(Z,Iia }Ié_}“ﬁz
! EI(II, 1) / L(II, 1): MS(2, 3, II) = 0: MS(2, 4, = v ’
F FOI‘II=1TONM S,II)=0 ) =w*G*J(II,
K(1, 1, II) = Cells(13 + II, 14) MS(3, 1, II) = 0: MS(3, 2, ID) = Ot MS(3, 3. 10,
K(2, 1, II) = Cells(13 + II., 15) 1) / L(II, 1): MS(3, 4, II) = 0O: C'MS(4, 3, II) = O: MS(4, 4,
Next IT MS(4, 1, II) = 0: Ms((i, é, IIII)) :00. MS (4, '
II) = K(1, 1, II): MS(4, 5, = ~ 0. 5. 4,
For II = 1 To NJ MS(5, 1, II) = 0: MS(S, 2é If) I==I)0: M5(5, 3, II) 0: MS(
Ks(II, 1) = Cells(13 + II, 13) II) = 0: MS(5, 5, II) = K(2,
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Next II

'Transpose [A]

For II = 1 To NM

For IJ = 1 To 5

For IK = 1 To 6

TMA(IJ, IK, II) = MA(IK, IJ, II)
Next IK

Next IJ

Next II

'Bangun ASAT elemen

For IT = 1 To NM

For IJ = 1 To 6

For IK = 1 To 5

MAS(IJ, IK, II) =0

For IL = 1 To 5

???(IJ, IK, II) = MAS(IJ, IK, II) + MA(1IJ, IL, II) * MS(IL, IK,
Next IL

Next IK

Next IJ

For IJ = 1 To 6

For IK = 1 To 6

ASAT(IJ, IK, II) =0

For IL = 1 To 5
?iAT{%?, IK, II) = ASAT(IJ, IK, II) + MAS(IJ, IL, II) * TMA(IL,
Next IL
Next IK
Next IJ
Next IT

'Bangun ASAT global
For II = 1 To NP
For IJ = 1 To NP

GASAT (I,
Next IJ
Next II

IJ) = 0

For II = 1 To NM
For IJ = 1 To 6

Indexs (I1J, II) = Cells(13 + II, 1 + IJ)
Next IJ

Next II

For IT = 1 To NM

For I0 = 1 To 6

For IK = 1 To 6

GASAT (Indexs(IJ, II), Indexs(IK, B
Todons (1 31)) "+ oA (1o IK} = I1)) GASAT (Indexs (I1J, 1II),
Next IK

Next IJ

Next II

'Invers ASAT global
For II = 1 To NP
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For IJ = 1 To NP

1f IJ <> II Then GASAT(II, IJ) = GASAT(II, IJ) / GASAT(II, II)
Next IJ

For IK = 1 To NP

If IK = II Then GoTo 20

For IJ = 1 To NP

1f IJ <> II Then GASAT(IK, IJ) = GASAT(IK, IJ) - GASAT(II, IJ) *
GASAT (IK, II)
Next IJ

20 Next IK
For IK = 1 To NP

If IK <> II Then GASAT(IK, II) = -GASAT(IK, II) / GASAT (II, II)
Next IK

GASAT(II, II) =1/ GASAT(II, II)

Next II

" {X} = [GASAT]*-1.{P}

For II = 1 To NP

X(I1I, 1) =0

For IJ = 1 To NP

X(II, 1) = X(II, 1) + GASAT(II, IJ) * P(1IJ, 1)
Next IJ

Next II

‘Cetak {X}:

a = 1 ' untuk rotasi akibat torsi
b = 2 ' untuk rotasi akibat momen
¢ = 3 ' untuk translasi

d = 1 'soil pressure = KS*X(3)
For II = 1 To NJ

Cells (13 + II, 21) = a
Cells(13 + II, 22) = X(a, 1)
Ccells (13 + IT, 23) =D
Cells (13 + II, 24) = X(b, 1)
Cells (13 + II, 25) = ¢
Cells(13 + II, 26) = X(c, 1)
cells (13 + II, 27) =d
Cells (13 + II, 28) = Ks(II, 1) * X(c, 1)
a=a+ 3

b=Db+3

c=c+ 3

d=4d+1

Next II

‘Membuat AutoCAD ScriptFile: MatFl.scr
'untuk plot Lendutan

‘Membuat urutan lendutan:
a=3

For II = 1 To GY + 1

For IJ = 1 To GX + 1

Mat (II, IJ) = X(a, 1)
a=a+ 3

Next IJ

Next IT

a=1
For II
For 1IJ

1 To GX + 1
GY + 1 To 1 Step -1

[l
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b
§
H
Xr(a, 1) = Mat(IJ, II) * Sc i Next IL
a=a+ 1 Next IK
Next IJ geitléJ L To 5
Next IT [e] =
o F(IJ, 1, 11) = 0
'Memguat kocrdinat grid: : g?EJIle %I?O=6F(IJ, i, II) + MSAT(1J, 1L, II) * Xi(IL, 1, II)
a = i . ’
For IT = 1 To GY + 1 ; Next IL
For IJ = 1 To GX + 1 3 Next Ig
LX(IJ, 1, II) = a Next I
Next IJ )
a=a+ L(II, 1) ac§t?k {F}i
nexe £t For II = 1 To NM
Cells (13 + II, 30) = a
1IJ -1 To 5 .
For IT = 1 T 1 ??rIJ -~ 3 Then Cells(13 + II, 30 + IJ) = F(1J, 1, II): GoTo 40
aoE 0 ) ° e Cells (13 + II, 30 + IJ) = F(1J, 1, II)
| b= (GX + 1) + (GY - 1) * (GX + GX + 1) 40 Next {J
' For I0 = 1 To GX + 1 a = a +
LY(I1J, 1, II) = a Next IT
If IJ = GX + 1 Then GoTo 30 Else a = a + L{b, 1) b
b=Db- (GX + GX + 1) End Su
Next IJ
30 Next IT
‘j Open "c:\MatFl.scr" For Output As #1
| Print #1, "_3dmesh"
! Write #1, GY + 1

Write #1, GX + 1

|
a=20
) c =1
I For IT = 1 To GX + 1 ;
a=0 |
For IJ0 = 1 To GY + 1 ‘ Sub FDC{()
Print #1, LX(IJ, 1, II) & "," & LY(IJ, 1, II) & "," & -Xr(c, 1) : o eiiise——s—scsz=—======s========s=sSs===s=====

c=c + 1 . '===s=ss=ss=sees
a=a~+ 1

| - FDC ,
geftdlf N : 'dibuat oleh: Guntér Parigaribuan
Ne;t 11 ' ‘perdasarkan materi dalam buku Teknik Sipil
Close #1 i ‘Aplikasi Excel Untuk Rekayasa Teknl p

Range("C12zc24").Se1ect

s adi i i tents
'Penomoran {X} NP x NP menjadi {X}i 6 x 1 gelection.ClearCon

Por IL - 1 To M Range ("C12") .Select
M, 3, ' 1 lapisan

' - h = Cells(3, 2) 'tebal tota D
ééiiJiJll T e T e A t = Cells(5, 5) ‘?Otal waktu
N t m = Cells(4, 2) 'jumlab }aplsan

. n = Cells(6, 2) 'jumlah interval waktu
B Beta - Cells(9, 2)
For II = 1 To NM .
For 1J =1 To > ReDim u(O Tom + 1, 0 Ton + 1) As Double
For IK = 1 To ¢ Dim i, j As Integer
MSAT(IJ, IK, II) = O o o .
For IL = 1 To 5 ul(o0, = .

= hen GoTo 15 Else GoTo
MSAT(IJ, IK, II) = MSAT(IJ, IK, II) + MS(IJ, IL, II) * T™MA(IL, IK, II) Tf Cells(3, 5) 1 T
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5 For j = 0 To n 'half clo
i sed 1
00,5700 ayered
Next j

For i = 1 Tom

'Cetak Hasil

W 20 For i = 0 To m

| Cells (12 + i, 3) = u(i

“ Next i (i, n + 1)
L End Sub
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u(i, 0) = Cells(12 + i, 2)
Next i
For j = 0 To n
For i =1 Tom
If i = m Then u(i j i j
. ;3 + 1) = i
5 -2 a5 Gem 10 ) u(i, j) + Beta * (2 * u(i - 1,
. u(i, j 1) = i j i ]
Wi+ 1, §) -2 % ais! ;); ) u(i, j) + Beta * (u(i - 1, J) +
Next i
10 Next j: GoTo 20
15 For j.: 0 To n 'open layered
u(0, j + 1) =0
u(m, j + 1) =0
Next j
Foy i=1Tom-1
u(i, 0) = Cells(12 + i, 2) ‘
Next i %
For j = 0 To n
For i = 1 Tom - 1
u(i, 3 + 1) = i j i 3
2+ aiil u(i, j) + Beta * (u(i - 1, 3) + u(i + 1, j) -
Next i
Next j
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